Important Notice

Texas Instruments and its subsidiaries (TI) reserve the right to make changes to their products or to discontinue any product or service without notice, and advise customers to obtain the latest version of relevant information to verify, before placing orders, that information being relied on is current and complete. All products are sold subject to the terms and conditions of sale supplied at the time of order acknowledgment, including those pertaining to warranty, patent infringement, and limitation of liability.

TI warrants performance of its semiconductor products to the specifications applicable at the time of sale in accordance with TI’s standard warranty. Testing and other quality control techniques are utilized to the extent TI deems necessary to support this warranty. Specific testing of all parameters of each device is not necessarily performed, except those mandated by government requirements.

Customers are responsible for their applications using TI components.

In order to minimize risks associated with the customer’s applications, adequate design and operating safeguards must be provided by the customer to minimize inherent or procedural hazards.

TI assumes no liability for applications assistance or customer product design. TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right of TI covering or relating to any combination, machine, or process in which such semiconductor products or services might be or are used. TI’s publication of information regarding any third party’s products or services does not constitute TI’s approval, warranty or endorsement thereof.

Copyright © 2012 Texas Instruments Incorporated

Revision History

September 2012 – Revision 1.00 Initial release
October 2012 – Revision 1.01 Added overall TOC, changed some lab3 steps, errata
October 2012 – Revision 1.02 Minor errata
November 2012 – Revision 1.03 Minor errata
December 2012 – Revision 1.04 CCS 5.3 changes, minor errata
January 2013 – Revision 1.05 Minor errata
March 2013 – Revision 1.10 Added SSI, UART and μDMA chapters and labs.

Mailing Address

Texas Instruments
Training Technical Organization
6550 Chase Oaks Blvd
Building 2
Plano, TX 75023
# Table of Contents

- Introduction to the ARM® Cortex™-M4F and Peripherals ................................ 1-1
- Code Composer Studio .............................................................................. 2-1
- Hints and Tips ......................................................................................... 2-18
- Introduction to StellarisWare®, Initialization and GPIO ...................... 3-1
- Interrupts and the Timers ....................................................................... 4-1
- ADC12 ......................................................................................................... 5-1
- Hibernation Module ................................................................................. 6-1
- USB ........................................................................................................... 7-1
- Memory ....................................................................................................... 8-1
- Floating-Point ........................................................................................... 9-1
- BoosterPacks and Graphics Library ....................................................... 10-1
- Synchronous Serial Interface ................................................................. 11-1
- UART ......................................................................................................... 12-1
- μDMA ........................................................................................................ 13-1
- Manual Driver Installation ..................................................................... Appendix
- Stellaris LaunchPad Board Schematics ................................................ Appendix
Introduction

This chapter will introduce you to the basics of the Cortex-M4F and the Stellaris peripherals. The lab will step you through setting up the hardware and software required for the rest of the workshop.

Agenda

Introduction to ARM® Cortex™-M4F and Peripherals

- Code Composer Studio
- Introduction to StellarisWare, Initialization and GPIO
- Interrupts and the Timers
  - ADC12
- Hibernation Module
- USB
- Memory
- Floating-Point
- BoosterPacks and grLib
- Synchronous Serial Interface
  - UART
  - µDMA

The Wiki page for this workshop is located here:

www.ti.com/StellarisLaunchPadWorkshop
# Chapter Topics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1-1</td>
</tr>
<tr>
<td>Chapter Topics</td>
<td>1-2</td>
</tr>
<tr>
<td>TI Processor Portfolio and Stellaris Roadmap</td>
<td>1-3</td>
</tr>
<tr>
<td>Stellaris LM4F120 Series Overview</td>
<td>1-4</td>
</tr>
<tr>
<td>LM4F120H5QR Specifics</td>
<td>1-5</td>
</tr>
<tr>
<td>LaunchPad Board</td>
<td>1-7</td>
</tr>
<tr>
<td>Lab1: Hardware and Software Set Up</td>
<td>1-8</td>
</tr>
<tr>
<td>Objective</td>
<td>1-8</td>
</tr>
<tr>
<td>Procedure</td>
<td>1-9</td>
</tr>
</tbody>
</table>
## TI Embedded Processing Portfolio

<table>
<thead>
<tr>
<th>Embedded Processing Portfolio</th>
<th>MSPA40 **</th>
<th>C2000™ Delfino™</th>
<th>Stellaris® ARM Cortex-M0</th>
<th>Hercules™ ARM Cortex-M3 &amp; Cortex-M0</th>
<th>Sitara™ ARM Cortex-A8 ARM®</th>
<th>C6000™ C6-JetLink™ DaVinci™</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overview</strong></td>
<td><strong>Overview</strong></td>
<td><strong>Overview</strong></td>
<td><strong>Overview</strong></td>
<td><strong>Overview</strong></td>
<td><strong>Overview</strong></td>
<td><strong>Overview</strong></td>
</tr>
<tr>
<td><strong>Software, Tools, Kits &amp; Boards</strong></td>
<td><strong>Software, Tools, Kits &amp; Boards</strong></td>
<td><strong>Software, Tools, Kits &amp; Boards</strong></td>
<td><strong>Software, Tools, Kits &amp; Boards</strong></td>
<td><strong>Software, Tools, Kits &amp; Boards</strong></td>
<td><strong>Software, Tools, Kits &amp; Boards</strong></td>
<td><strong>Software, Tools, Kits &amp; Boards</strong></td>
</tr>
<tr>
<td><strong>SW &amp; Kits</strong></td>
<td><strong>SW &amp; Kits</strong></td>
<td><strong>SW &amp; Kits</strong></td>
<td><strong>SW &amp; Kits</strong></td>
<td><strong>SW &amp; Kits</strong></td>
<td><strong>SW &amp; Kits</strong></td>
<td><strong>SW &amp; Kits</strong></td>
</tr>
<tr>
<td><strong>Device Table</strong></td>
<td><strong>Device Table</strong></td>
<td><strong>Device Table</strong></td>
<td><strong>Device Table</strong></td>
<td><strong>Device Table</strong></td>
<td><strong>Device Table</strong></td>
<td><strong>Device Table</strong></td>
</tr>
</tbody>
</table>

**LM3S5000**
- **Up to 80 MHz**
- **256K Flash / 32K SRAM**
- **Low-power hibernate**
- **2 x 1 Mips 12-bit ADCs**
- **Motion control options**

**RTP Feb '13 (TMX Now)**
- **USB HSD/OTG + CAN**
- **80 MHz**
- **256K Flash / 32K SRAM**
- **Low-power hibernate**
- **2 x 1 Mips 12-bit ADCs**
- **Up to 2 x CAN**
- **Motion control options**

### Stellaris® Roadmap

#### ARM Cortex-M3
- **Fixed Point ENET MAC & PHY USB & CAN options**
- **LM3S5000**
- **LM3S6000**
- **LM3S7000**

#### ARM Cortex-M4F Floating-Point
- **Fixed Point USB HSD/OTG CAN options**
- **LM4F23x**
- **LM4F24x**
- **LM4F25x**

#### Production
- **RTP Feb '13 (TMX Now)**
  - **USB HSD/OTG + CAN**
  - **80 MHz**
  - **256K Flash / 32K SRAM**
  - **Low-power hibernate**
  - **2 x 1 Mips 12-bit ADCs**
  - **Up to 2 x CAN**
  - **Motion control options**

#### Sampling
- **TMS / RTP 2H13 Ethernet + USB + CAN**
  - **120 MHz**
  - **192 Flash, 256KB SRAM**
  - **10/100 ETHERNET MAC & PHY**
  - **USB HSD/OTG w/PHY & HSI ULPI**
  - **Up to 2 x CAN**
  - **Parallel Bus Interface (EBI)**
  - **Crypto**

#### Development
- **Series...**
Stellaris® LM4F120 Series MCUs

Connectivity features:
- CAN, USB Device, SPI/SSI, I2C, UARTs

High-performance analog integration
- Two 1 MSPS 12-bit ADCs
- Analog and digital comparators

Best-in-class power consumption
- As low as 370 µA/MHz
- 500µs wakeup from low-power modes
- RTC currents as low as 1.7µA

Solid roadmap
- Higher speeds
- Larger memory
- Ultra-low power

Core and FPU ...

M4 Core and Floating-Point Unit

- 32-bit ARM® Cortex™-M4 core
- Thumb2 16/32-bit code: 26% less memory & 25% faster than pure 32-bit
- System clock frequency up to 80 MHz
- 100 DMIPS @ 80MHz
- Flexible clocking system
  - Internal precision oscillator
  - External main oscillator with PLL support
  - Internal low frequency oscillator
  - Real-time-clock through Hibernation module
- Saturated math for signal processing
- Atomic bit manipulation. Read-Modify-Write using bit-banding
- Single Cycle multiply and hardware divider
- Unaligned data access for more efficient memory usage
- Privileged and unprivileged modes
  - Limits access to MPU registers, SysTick, NVIC & possibly memory/peripherals
- IEEE754 compliant single-precision floating-point unit
- JTW and Serial Wire Debug debugger access
  - ETM available through Keil and IAR emulators

Memory ...
LM4F120H5QR Specifics

LM4F120H5QR Memory

256KB Flash memory
- Single-cycle to 40MHz
- Pre-fetch buffer and speculative branch improves performance above 40 MHz

32KB single-cycle SRAM with bit-banding
- Internal ROM loaded with StellarisWare software
  - Stellaris Peripheral Driver Library
  - Stellaris Boot Loader
  - Advanced Encryption Standard (AES) cryptography tables
  - Cyclic Redundancy Check (CRC) error detection functionality

2KB EEPROM (fast, saves board space)
- Wear-leveled 500K program/erase cycles
- 10 year data retention
- 4 clock cycle read time

Peripherals ...

LM4F120H5QR Peripherals

Battery-backed Hibernation Module
- Internal and external power control (through external voltage regulator)
- Separate real-time clock (RTC) and power source
- VDD3ON mode retains GPIO states and settings
- Wake on RTC or Wake pin
- 16 32-bit words of battery backed memory
- 5 μA Hibernate current with GPIO retention. 1.7 μA without

Serial Connectivity
- USB 2.0 (Device)
- 8-UART
- 4-I2C
- 4-SSI/SPI
- CAN

More ...
LM4F120H5QR Specifics

**LM4F120H5QR Peripherals**

### Two 1MSPS 12-bit SAR ADCs
- Twelve shared inputs
- Single ended and differential measurement
- Internal temperature sensor
- 4 programmable sample sequencers
- Flexible trigger control: SW, Timers, Analog comparators, GPIO
- VDDA/GNDA voltage reference
- Optional hardware averaging
- 2 analog and 16 digital comparators
- μDMA enabled

### 0 - 43 GPIO
- Any GPIO can be an external edge or level triggered interrupt
- Can initiate an ADC sample sequence or μDMA transfer directly
- Toggle rate up to the CPU clock speed on the Advanced High-Performance Bus
- 5-V-tolerant in input configuration
- Programmable Drive Strength (2, 4, 8 mA or 8 mA with slew rate control)
- Programmable weak pull-up, pull-down, and open drain


---

### Memory Protection Unit (MPU)
- Generates a Memory Management Fault on incorrect access to region

### Timers
- 2 Watchdog timers with separate clocks
- SysTick timer, 24-bit high speed RTOS and other timer
- Six 32-bit and Six 64-bit general purpose timers
- PWM and CCP modes
- Daisy chaining
- User enabled stalling on CPU Halt flag from debugger for all timers

### 32 channel μDMA
- Basic, Ping-pong and scatter-gather modes
- Two priority levels
- 8,16 and 32-bit data sizes
- Interrupt enabled

### Nested-Vectored Interrupt Controller
- 7 exceptions and 65 interrupts with 8 programmable priority levels
- Tail-chaining
- Deterministic: always 12 cycles or 6 with tail-chaining
- Automatic system save and restore

---

[www.ti.com/StellarisPinMuxUtility](http://www.ti.com/StellarisPinMuxUtility)
LaunchPad Board

Stellaris® LaunchPad

- ARM® Cortex™-M4F
- 64-pin 80MHz LM4F120H5QR
- On-board USB ICDI (In-Circuit Debug Interface)
- Micro AB USB Device port
- Device/ICDI power switch
- BoosterPack XL pinout also supports existing BoosterPacks
- 2 user pushbuttons
- Reset button
- 3 user LEDs (1 tri-color device)
- Current measurement test points
- 16MHz Main Oscillator crystal
- 32kHz Real Time Clock crystal
- 3.3V regulator
- Support for multiple IDEs:
Lab1: Hardware and Software Set Up

Objective

The objective of this lab exercise is to download and install Code Composer Studio, as well as download the various other support documents and software to be used with this workshop. Then we’ll review the contents of the evaluation kit and verify its operation with the pre-loaded quickstart demo program. These development tools will be used throughout the remaining lab exercises in this workshop.

Lab 1: Hardware and Software Setup

- Install the software
- Review the kit contents
- Connect the hardware
- Test the QuickStart application
Procedure

Hardware

1. You will need the following hardware:
   - A 32 or 64-bit Windows XP or Windows7 laptop with 2G or more of free hard drive space. 1G of RAM should be considered a minimum … more is better.
   - A laptop with Wi-Fi is highly desirable
   - If you are working the labs from home, a second monitor will make the process much easier. If you are attending a live workshop, you are welcome to bring one.
   - If you are attending a live workshop, please bring a set of earphones or ear-buds.
   - If you are attending a live workshop, you will receive an evaluation board; otherwise you need to purchase one. (http://www.ti.com/tool/EK-LM4F120XL)
   - If you are attending a live workshop, a digital multi-meter will be provided; otherwise you need to purchase one like the inexpensive version here: (http://www.harborfreight.com/catalogsearch/result?q=multimeter)
   - If you are attending a live workshop, you will receive a second A-male to micro-B-male USB cable. Otherwise, you will need to provide your own to complete Lab 7.
   - If you are attending a live workshop, you will receive a Kentec 3.5” TFT LCD Touch Screen BoosterPack (Part# EB-LM4F120-L35). Otherwise, you will need to provide your own to complete Lab 10.

As you complete each of the following steps, check the box in the title, like the below, to assure that you have done everything in order.

Download and Install Code Composer Studio

2. Download and start the latest version of Code Composer Studio (CCS) 5.x web installer from http://processors.wiki.ti.com/index.php/Download_CCS (do not download any beta versions). Bear in mind that the web installer will require Internet access until it completes. If the web installer version is unavailable or you can’t get it to work, download, unzip and run the offline version. The offline download will be much larger than the installed size of CCS since it includes all the possible supported hardware.

This version of the workshop was constructed using build number 5.3.0.00090. Your version will likely be later. For this and the next few steps, you will need a my.TI account (you will be prompted to create one or log into your existing account).

You should note that the 16K limitation on the free, code size limited version of CCS is too small to work with most of the projects in this workshop.

Note that the evaluation license of CCS will operate with full functionality for free while connected to a Stellaris evaluation board. Most Stellaris boards can also operate as an emulator interface for your target system, although this function requires a licensed version of CCS.
3. If you have downloaded the offline file, start the `ccs_setup_5.xxxxx.exe` file in the folder created when you unzipped the download.

4. Accept the Software License Agreement and click Next.

5. Unless you have a specific reason to install CCS in another location, accept the default installation folder and click Next. If you have an another version of CCS and you want to keep it, we recommend that you install this version into a different folder.
6. Select “Custom” for the Setup type and click Next.

7. The next dialog, select the processors that your CCS installation will support. You should select “Stellaris Cortex M MCUs” in order to run the labs in this workshop. If you are also attending the MSP430 workshop you should also select “MSP430 Low Power MCUs”. You can select other architectures, but the installation time and size will increase. Click Next.
8. In the Component dialog, keep the default selections and click Next.

9. In the Emulators dialog, uncheck the Blackhawk and Spectrum Digital emulators, unless you plan on using either of these.
10. When you reach the final installation dialog, click Next. The web installer process should take 15 - 30 minutes, depending on the speed of your connection. The offline installation should take 10 to 15 minutes. When the installation is complete, don’t start CCS.

**Install StellarisWare**

11. Download and install the latest full version of StellarisWare from: [http://www.ti.com/tool/sw-lm3s](http://www.ti.com/tool/sw-lm3s). This workshop was built using release number 9107. Your version will likely be a later one. If at all possible, please install StellarisWare into the default `C:\StellarisWare` folder.

**Install LM Flash Programmer**

12. Download, unzip and install the latest LM Flash Programmer (LMFLASHPROGRAMMER) from [http://www.ti.com/tool/lmflashprogrammer](http://www.ti.com/tool/lmflashprogrammer). This workshop was built using version number 1381. Your version will likely be a later one.

**Download ICDI Drivers**

Download and Install Workshop Lab Files

14. Download the lab installation file from the workshop materials section of the Wiki site below. The file will install your lab files in: C:\StellarisWare\boards\MyLaunchPadBoard. So please be sure that you have installed StellarisWare before installing the labs.

www.ti.com/StellarisLaunchPadWorkshop

Download Workshop Workbook

15. Download a copy of the workbook pdf file from the workshop materials section of the Wiki site below to your desktop. It will be handy for copying and pasting code.

www.ti.com/StellarisLaunchPadWorkshop

Terminal Program

16. If you are running WindowsXP, you can use HyperTerminal as your terminal program. Windows7 does not have a terminal program built-in, but there are many third-party alternatives. The instructions in the labs utilize HyperTerminal and PuTTY. You can download PuTTY from the address below.

http://the.earth.li/~sgtatham/putty/latest/x86/putty.exe

Windows-side USB Examples

17. Download and install the StellarisWare Windows-side USB examples from this site:

www.ti.com/sw-usb-win

Download and Install GIMP

18. We will need a graphics manipulation tool capable of handing PNM formatted images. GIMP can do that. Download and install GIMP from here:

www.gimp.org

LaunchPad Board Schematic

19. For your reference, the schematic is included at the end of this workbook.
Helpful Documents and Sites

20. There are many helpful documents that you should have, but at a minimum you should have the following documents at your fingertips.

Look in C:\StellarisWare\docs and find:

- Peripheral Driver User’s Guide (SW-DRL-UGxxxx.pdf)
- USB Library User’s Guide (SW-USBL-UGxxxx.pdf)

21. Go here: http://www.ti.com/product/lm4f120h5qr and download the LM4F120H5QR Data Sheet. Stellaris data sheets are actually the complete user’s guide for the device. So expect a large document.

22. Download the ARM Optimizing C/C++ Compilers User Guide from http://www.ti.com/lit/pdf/spnu151 (SPNU151). Of particular interest are the sizes for all the different data types in table 6-2. You may see the use of “TMS470” here … that is the TI product number for its ARM devices.

23. You will find a “Hints” section at the end of chapter 2. You will find this information handy when you run into problems during the labs.

24. Search the TI website for these additional documents of interest:

- SPMU287: Stellaris Driver Installation Guide (for ICDI and FTDI drivers)
- SPMU288: BoosterPack Development Guide
- SPMU289: LaunchPad Evaluation Board User’s Manual (includes schematic)

You can find additional information at these websites:

Main page: www.ti.com/launchpad
Stellaris LP: www.ti.com/stellaris-launchpad
BoosterPack webpage: www.ti.com/boosterpack
LaunchPad WiKi: www.ti.com/launchpadwiki
LM4F120H5QR folder: http://www.ti.com/product/lm4f120h5qr
Kit Contents

25. Open up your kit

You should find the following in your box:

- The LM4F120H5QR LaunchPad Board
- USB cable (A-male to micro-B-male)
- README First card
- If you are in a live workshop, you should find a 2nd USB cable

Initial Board Set-Up

26. Connecting the board and installing the drivers

The LM4F120 LaunchPad Board ICDI USB port (marked DEBUG and shown in the picture below) is a composite USB port and consists of three connections:

- Stellaris ICDI JTAG/SWD Interface - debugger connection
- Stellaris ICDI DFU Device - firmware update connection
- Stellaris Virtual Serial Port - a serial data connection

Using the included USB cable, connect the USB emulation connector on your evaluation board (marked DEBUG) to a free USB port on your PC. A PC’s USB port is capable of sourcing up to 500 mA for each attached device, which is sufficient for the evaluation board. If connecting the board through a USB hub, it must be a powered hub.

The drivers should install automatically. Manual driver installation steps are included in the appendix of this workbook.
QuickStart Application

Your LaunchPad Board came preprogrammed with a quickstart application. Once you have powered the board, this application runs automatically. You probably already noticed it running as you installed the drivers.

27. Make sure that the power switch in the upper left hand corner of your board is in the right-hand DEBUG position as shown:

28. The software on the LM4F120H5QR uses the timers as pulse-width modulators (PWMs) to vary the intensity of all three colors on the RGB LED (red, green, and blue) individually. By doing so, your eye will perceive many different colors created by combining those primary colors.

The two pushbuttons at the bottom of your board are marked SW1 (the left one) and SW2 (the right one). Press or press and hold SW1 to move towards the red-end of the color spectrum. Press or press and hold SW2 to move towards the violet-end of the color spectrum.

If no button is pressed for 5 seconds, the software returns to automatically changing the color display.

29. Press and hold both SW1 and SW2 for 3 seconds to enter hibernate mode. In this mode the last color will blink on the LEDs for $\frac{1}{2}$ second every 3 seconds. Between the blinks, the device is in the VDD3ON hibernate mode with the real-time-clock (RTC) running. Pressing SW2 at any time will wake the device and return to automatically changing the color display.

30. We can communicate with the board through the UART. The UART is connected as a virtual serial port through the emulator USB connection.

The following steps will show how to open a connection to the board using HyperTerminal (in WinXP) and PuTTY (in Windows 7 or 8).
31. We need to find the COM port number of the Stellaris Virtual Serial Port in the Device Manager. **Skip to step 32 if you are using Windows 7 or 8.**

**Windows XP:**

A. Click on the Windows Start button. Right-click on My Computer and select Properties from the drop-down menu.

B. In the System Properties window, click the Hardware tab.

C. Click the Device Manager button.

The Device Manager window displays a list of hardware devices installed on your computer and allows you to set the properties for each device.

Expand the Ports heading and write number for the Stellaris Virtual Serial Port here: **COM_____**
32. Windows 7 or 8:

A. Click on the Windows Start button. Right-click on Computer and select Properties from the drop-down menu.

B. Click on Device Manager on the left of the dialog.

The Device Manager window displays a list of hardware devices installed on your computer and allows you to set the properties for each device.

Expand the Ports heading and write number for the Stellaris Virtual Serial Port here: **COM_____**
33. **In WinXP,** open HyperTerminal by clicking Start → Run…, then type `hypertrm` in the Open: box and click OK. Pick any name you like for your connection and click OK. In the next dialog box, change the Connect using: selection to COM##, where ## is the COM port number you noted earlier. Click OK. Make the selections shown below and click OK.

![HyperTerminal Settings](image)

When the terminal window opens, press Enter once and the LaunchPad board will respond with a > indicating that communication is open. Skip to step 31.

34. **In Win7 or 8,** double-click on `putty.exe`. Make the settings shown below and then click Open. Your COM port number will be the one you noted earlier.

![PuTTY Configuration](image)

When the terminal window opens, press Enter once and the LaunchPad board will respond with a > indicating that communication is open.
35. You can communicate by typing the following commands and pressing enter:

**help**: will generate a list of commands and information

**hib**: will place the device into hibernation mode. Pressing SW2 will wake the device.

**rand**: will start a pseudo-random sequence of colors

**intensity**: adjust the LED brightness between 0 to 100 percent. For instance intensity 100 will change the LED to maximum brightness.

**rgb**: follow with a 6 hex character value to set the intensity of all three LEDs. For instance: rgb FF0000 lights the red LED, rgb 00FF00 lights the blue LED and rgb 0000FF lights the green LED.

36. Close your terminal program.

You’re done.
Introduction

This chapter will introduce you to the basics of Code Composer Studio. In the lab, we will explore some Code Composer features.

Agenda

- Introduction to ARM® Cortex™-M4F and Peripherals
  - Code Composer Studio
    - Introduction to StellarisWare, Initialization and GPIO
    - Interrupts and the Timers
      - ADC12
    - Hibernation Module
    - USB
    - Memory
    - Floating-Point
    - BoosterPacks and grLib
    - Synchronous Serial Interface
      - UART
      - μDMA
## Chapter Topics

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter Topics</td>
<td>2-1</td>
</tr>
<tr>
<td>Stellaris Development Tools</td>
<td>2-3</td>
</tr>
<tr>
<td>Code Composer Studio</td>
<td>2-4</td>
</tr>
<tr>
<td>Lab2: Code Composer Studio</td>
<td>2-7</td>
</tr>
<tr>
<td>Objective</td>
<td>2-7</td>
</tr>
<tr>
<td>Load the Lab 2 Project</td>
<td>2-8</td>
</tr>
<tr>
<td>LM Flash Programmer</td>
<td>2-15</td>
</tr>
<tr>
<td>Creating a bin File for the Flash Programmer</td>
<td>2-17</td>
</tr>
<tr>
<td>Hints and Tips</td>
<td>2-18</td>
</tr>
</tbody>
</table>
# Stellaris Development Tools

## Development Tools for Stellaris MCUs

<table>
<thead>
<tr>
<th>Eval Kit License</th>
<th>Compiler</th>
<th>Debugger / IDE</th>
<th>Full Upgrade</th>
<th>JTAG Debugger</th>
</tr>
</thead>
<tbody>
<tr>
<td>30-day full function, Upgradeable</td>
<td>GNU C/C++</td>
<td>gdb / Eclipse</td>
<td>99 USD personal edition / 2900 USD full support</td>
<td>J-Link, 299 USD</td>
</tr>
<tr>
<td>32KB code size limited, Upgradeable</td>
<td>IAR C/C++</td>
<td>C-SPY / Embedded Workbench</td>
<td>2700 USD</td>
<td>U-Link, 199 USD</td>
</tr>
<tr>
<td>32KB code size limited, Upgradeable</td>
<td>RealView C/C++</td>
<td>µVision</td>
<td>MDK-Basic (256 KB) = €2000 (2895 USD)</td>
<td>XDS100, 79 USD</td>
</tr>
<tr>
<td>Full function, Onboard emulation limited</td>
<td>TI C/C++</td>
<td>CCS/Eclipse-based suite</td>
<td>445 USD</td>
<td></td>
</tr>
</tbody>
</table>

What is CCS?...
What is Code Composer Studio?

Integrated development environment for TI embedded processors
- Includes debugger, compiler, editor, simulator, OS...
- The IDE is built on the Eclipse open source software framework
- Extended by TI to support device capabilities

CCSv5 is based on “off the shelf” Eclipse (version 3.7 in CCS 5.2)
- Uses unmodified version of Eclipse
  - Ti contributes changes directly to the open source community
  - Drop in Eclipse plug-ins from other vendors or take Ti tools and drop them into an existing Eclipse environment
- Users can take advantage of all the latest improvements in Eclipse

Integrate additional tools
- OS application development tools (Linux, Android, Sys/BIOS…)
- Code analysis, source control…

Runs under Windows and Linux
$445 single seat. $99/year subscription fee

User Interface Modes...

Simple Mode
- By default CCS will open in simple/basic mode
- Simplified user interface with far fewer menu items, toolbar buttons
- Ti supplied CCS Edit and CCS Debug Perspectives

Advanced Mode
- Uses default Eclipse perspectives (similar to what existed in CCSv4)
- Recommended for users integrating other Eclipse based tools into CCS

Switching Modes
- On the CCS menu bar, select Window → Open Perspective → Other…
  - Check the “Show all” checkbox
  - “C/C++” and “Debug” are the advanced perspectives

Common Tasks...
Common Tasks

Creating New Projects
- Very simple to create a new project for a device using a template

Build options
- Simplified build options dialog from earlier CCS versions
- Updates to options are delivered via compiler releases and not dependent on CCS updates

Sharing projects
- Easy for users to share projects, including working with version control (portable projects)
- Setting up linked resources has been simplified from earlier CCS versions

Workspaces and Projects

A workspace contains your settings and preferences, as well as links to your projects. Deleting projects from the workspace deletes the links, not the files*

A project contains your build and tool settings, as well as links to your input files. Deleting files from the workspace deletes the links, not the files*

* Unless you have located or copied files into the workspace
**Project Wizard**

- Single page wizard for majority of users
  - Next button will show up if a template requires additional settings
- Debugger setup included
  - User chooses location, device and connection
  - A modifiable ccxml file is created
- Simple by default
  - Compiler version, endianness... are under advanced settings

**Adding Files to Projects**

- Add Files to Project allows users to control how the file is added to the project
- Linking Files using built-in macros allows easy creation of portable projects
Lab2: Code Composer Studio

Objective

The objective of this lab exercise is to explore the basics of how to use Code Composer Studio. This lab will not discuss the actual C code. The following chapter will explore the code.

Lab 2: Code Composer Studio

USB Emulation Connection

- Create a new project
- Experiment with some CCS features
- Use the LM Flash Programmer

Agenda ...
Load the Lab 2 Project

Open Code Composer Studio

1. Double click on the Code Composer shortcut on your desktop to start CCS.

When the “Select a workspace” dialog appears, browse to your My Documents folder:

(In WinXP) C:\Documents and Settings\<user>\My Documents
(In Win7) C:\Users\<user>\My Documents

Obviously, replace <user> with your own username. Click OK.

The name of your workspace isn’t critical, but let’s use MyWorkspaceLM4F120.

Do not check the “Use this as the default and do not ask again” checkbox. (If at some point you accidentally check this box, it can be changed in CCS) The location of the workspace folder is not important, but to keep your projects portable, you want to locate it outside of the StellarisWare directory.

Note: The following screen captures show the correct options for WinXP. Few, if any differences exist for Win7 and Vista.

Click OK.

If you haven’t already licensed Code Composer, you’ll be asked to do so in the next few installation steps. When that happens, select “Evaluation”. As long as your PC is connected to the LaunchPad board, Code Composer will have full functionality, free of charge. You can go back and change the license if needed by clicking Help → Code Composer Studio Licensing Information → Upgrade tab → Launch License Setup…

When the “TI Resource Explorer” and/or “Grace” windows appear, close their tabs. At this time these tools only support the MSP430.
Create Lab2 Project

2. Maximize Code Composer. On the CCS menu bar select File → New → CCS Project. Make the selections shown below. Make sure to uncheck the “Use default location” checkbox and select the correct path. **This step is important to making your project portable and in order for the links to work correctly.** Type “120” in the variant box to bring up the four versions of the device. Select “Empty Project (with main.c)” for the project template. Click Finish.
3. The main.c file will be open in the editor tab. Delete the contents and type or copy/paste the following code into the file. Don’t worry about the code now; we’ll go over this in detail in lab 3. Note the question marks that appear to the left of the include statements. These indicate that Code Composer does not know the path to these resources. We’ll fix that in a moment.

```c
#include "inc/hw_types.h"
#include "inc/hw_memmap.h"
#include "driverlib/sysctl.h"
#include "driverlib/gpio.h"

int main(void) {
    int LED = 2;

    SysCtlClockSet(SYSCTL_SYSDIV_4|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);

    while(1) {
        // Turn on the LED
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, LED);

        // Delay for a bit
        SysCtlDelay(2000000);

        // Cycle through Red, Green and Blue LEDs
        if (LED == 8) {LED = 2;} else {LED = LED*2;}
    }
}
```

Click the Save button on the menu bar to save your work. If you are having problems, you can find this code in your Lab2/ccs folder in file main.txt.

If the indentation of your code doesn’t look right, press Ctrl-A (on your keyboard) to select all the code. Then right-click on it and select Source ➔ Correct Indentation.

4. Expand the project in the Project Explorer pane (on the left side of your screen) by clicking the + or ➔ next to Lab2. This list shows all the files that are used to build the project. One of those files is startup_ccs.c that we included in your lab folder (this file is available in every StellarisWare example). Double-click on the file to open it for editing. This file defines the stack and the interrupt vector table structure among other things. These settings are essential for Code Composer to build your project. Close the editor window by clicking on the X in the tab at the top of the editor window. Do not save any changes if you accidentally made any.
Set the Build Options

5. Remember those question marks in the code? The next two steps will tell Code Composer where to find the resources we need to compile the code.

Right-click on Lab2 in the Project Explorer pane and select Properties (the leftmost pane in CCS). Click Include Options under ARM Compiler. In the bottom, include search path pane, click the Add button and add the following include search path. You may want to copy/paste from the workbook pdf for the next two steps.

`${PROJECT_ROOT}/../../..`

This path allows the compiler to correctly find the `driverlib` folder, which is four levels up from your project folder. Note that if you did not place your project in the correct location, this link will not work.
6. Under **ARM Linker** click **File Search Path**. Add the following include library file to the top window:

```
${PROJECT_ROOT}/../../../../driverlib/ccs-cm4f/Debug/driverlib-cm4f.lib
```

This step allows the linker to correctly find the lib file. Note that if you did not place your project in the correct location, this link will not work either.

Click OK to save your changes.
**Run the Code**

7. Make sure that your LaunchPad board is plugged in. Check that Lab2 is the Active Project by clicking on the project in the Project Explorer pane. Click the Debug button on the CCS menu bar to build and download the Lab2 project. When the process completes, CCS will be in the Debug perspective. (Note the two tabs in the upper right of your screen … drag them to the left a little so you can see both of them completely) You can create as many additional perspectives as you like for your specific needs. Only the Debug and Edit perspectives are pre-defined.

8. Click the Run button on the CCS menu bar to run the code. Observe the tri-color LED blinking red, green, and blue on your LaunchPad board.

**Some CCS Features**

9. Click the Suspend button on the CCS menu bar. If the code stops with a “No source available …” indication, click on the main.c tab. Most of the time in the while() loop is spent inside the delay function and that source file is not linked into this project.

10. **Breakpoints**

    In the code window in the middle of your screen, double-click in the gray area to the left of the line number of the GPIOPinWrite() instruction to set a breakpoint (it will look like this: 🟢). Click the Resume button to restart the code. The program will stop at the breakpoint and you will see an arrow on the left of the line number, indicating that the program counter has stopped on this line of code. **Note that the current ICDI driver does not support adding/removing breakpoints while the processor is running.** Click the Resume button a few times or press the F8 key to run the code. Observe the LED on the LaunchPad board as you do this.

11. **Register View**

    Click on View Registers to see the core and peripheral register values. Resize the window if necessary. Click on the plus sign on the left to view the registers. Note that non-system peripherals that have not been enabled cannot be read. In this project you can view Core Registers, GPIO_PORTA (where the UART pins are), GPIO_PORTF (where the LEDs and pushbuttons are located), HIB, FLASH_CTRL, SYSCTL and NVIC.

12. **Memory View**

    Click on View Memory Browser to examine processor memory. Type 0x00 in the entry box and press Enter. You can page through memory and you can click on a location to directly change the value in that memory location.
13. **Expressions View**

Make sure that you can see the Expression pane in the upper right hand corner of your screen. You may have to click on the Expressions tab. Right-click in the pane and select Remove All to make sure there are no existing watch expressions.

In your code window, double-click on the variable **LED** around line 18. Right click on the selected variable and select Add Watch Expression and then click OK. The window on the upper right will switch to the Expression view and you should see the variable listed. Run the code several times. Each time your code execution reaches the breakpoint, the watch will update. Updated values are highlighted with a yellow background.

Remove all the breakpoints you have set at once by clicking Run → Remove All Breakpoints from the menu bar. Again, breakpoints can only be removed when the processor is not running.

14. Click on Terminate to return to the editor perspective. Right-click on Lab2 in the Project Explorer pane and select Close Project to close the project. Minimize CCS.
**LM Flash Programmer**

15. LM Flash Programmer is a standalone programming GUI that allows you to program the flash of a Stellaris device through multiple ports. Creating the files required for this is a separate build step in Code Composer that is shown on the next page.

If you have not done so already, install the LM Flash Programmer onto your PC.

16. Make sure that Code Composer Studio is not actively running code in the CCS Debug perspective … otherwise CCS and the Flash Programmer may conflict for control of the USB port.

There should be a shortcut to the LM Flash Programmer on your desktop, double-click it to open the tool. If the shortcut does not appear, go to Start → All Programs → Texas Instruments → Stellaris → LM Flash Programmer and click on LM Flash Programmer.

17. Your evaluation board should currently be running the Lab2 application. If the User LED isn’t blinking, press the RESET button on the board. We’re going to program the original application back into the LM4F120H5QR.

Click the Configuration tab. Select the LM4F120 LaunchPad from the Quick Set pull-down menu under the Configuration tab. See the user’s guide for information on how to manually configure the tool for targets that are not evaluation boards.

![LM Flash Programmer Screenshot](image-url)
18. Click on the Program tab. Then click the Browse button and navigate to:

C:\StellarisWare\boards\ek-lm4f120XL\qs-rgb\ccs\Debug\qs-rgb.bin

This is the application that was programmed into the flash memory of the LM4F120XL during the evaluation board assembly process.

Note that there are applications here which have been built with each supported IDE. Make sure that the following checkboxes are selected:

19. Click the Program button.

You should see the programming and verification status at the bottom of the window. After these steps are complete, the quickstart application should be running on your evaluation kit.

Optional: Creating a bin File for the Flash Programmer

If you want to create a bin file for use by the stand-alone programmer in any of the labs in this workshop or in your own project, use these steps below. Remember that the project will have to be open before you can change its properties.

In Code Composer 5.2 and Earlier:

In Code Composer, in the Project Explorer, right-click on your project and select Properties. On the left, click Build and then the Steps tab. Paste the following commands into the Post-build steps Command box:

"${CCS_INSTALL_ROOT}/utils/tiobj2bin/tiobj2bin"
"${BuildArtifactFileName}" "${BuildArtifactFileBaseName}.bin"
"${CG_TOOL_ROOT}/bin/ofd470" "${CG_TOOL_ROOT}/bin/hex470"
"${CCS_INSTALL_ROOT}/utils/tiobj2bin/mkhex4bin"

In Code Composer 5.3 and Later:

In Code Composer, in the Project Explorer, right-click on your project and select Properties. On the left, click Build and then the Steps tab. Paste the following commands into the Post-build steps Command box:

"${CCS_INSTALL_ROOT}/utils/tiobj2bin/tiobj2bin"
"${BuildArtifactFileName}" "${BuildArtifactFileBaseName}.bin"
"${CG_TOOL_ROOT}/bin/armofd" "${CG_TOOL_ROOT}/bin/armhex"
"${CCS_INSTALL_ROOT}/utils/tiobj2bin/mkhex4bin"

Each command is enclosed by quotation marks and there is a space between each one. These steps will run after your project builds and the bin file will be in the …Labx/ccs/debug folder. You can access this in the CCS Project Explorer in your project by clicking the Debug folder.

You’re done.
Hints and Tips

There are several issues and errors that users commonly run into during the class. Here are a few and their solutions:

1. **Header files can’t be found**
   
   When you create the main.c file and include the header files, CCS doesn’t know the path to those files and will tell you so by placing a question mark left of those lines. After you change the Compiler and Linker options, these question marks should go away and CCS should find the files during the build. If CCS reports that your header files can’t be found, check the following:
   
   a. Under the Project Properties click Resource on the left. Make sure that your project is located in ...\MyLaunchPadBoard\Labx\ccs. If you located it in the Lab9 folder you can adjust the Include and File Search paths. If you located the project in the workspace, your best bet is to remake the project.
   
   b. Under the Project Properties, click on Include Options. Make sure that you added the correct search paths to the bottom window.
   
   c. Under the Project Properties, click on File Search Path. Make sure that you placed the path to the include library file(s) in the top window.

2. **Unresolved symbols**
   
   This is usually the result of step 1c above or you are using a copy of the startup_ccs.c file that includes the ISR name used in the Interrupts lab. You’ll have to remove the extern declaration and change the timer ISR link back to the default.

3. **Frequency out of range**
   
   This usually means that CCS tried to connect to the evaluation board and couldn’t. This can be the result of the USB drivers or a hardware issue:
   
   a. Unplug and re-plug the board from your USB port to refresh the drivers.
   
   b. Open your Device Manager and verify that the drivers are correctly installed.
   
   c. Assure that your emulator cable is connected to the DEBUG microUSB port, not the DEVICE port, and make sure the PWR SELECT switch is set to the rightmost DEBUG position.
   
   d. Your board should be connected by its orange emulator connector, not the user connector. Also, check your USB cable. It may be faulty.

4. **Error loading dll file**
   
   This can happen in Windows7 when attempting to connect to the evaluation board. This is a Win7 driver installation issue and can be resolved by copying the files: FTCJTAG.dll and ftd2xx.dll to:
   
   C:\CCS5.x\ccsv5\ccs_base\DebugServer\drivers
   
   and
   
   C:\Windows\System32
   
   Download these files from [http://www.ti.com/tool/lm_ftdi_driver](http://www.ti.com/tool/lm_ftdi_driver).
5. **Program run tools disappear in the Debug perspective**
   The tools aren’t part of the perspective, but part of the Debug window. Somehow you closed the window. Click View → Debug from the menu bar.

6. **CCS doesn’t prompt for a workspace on startup**
   You checked the “don’t ask anymore” checkbox. You can switch workspaces by clicking File → Switch workspace … or you can do the following: In CCS, click Window → Preferences. Now click the + next to General, Startup and Shutdown, and then click Workspaces. Check the “Prompt for workspace on startup” checkbox and click OK.

7. **The windows have changed in the CCS Edit or Debug perspective from the default and you want them back**
   On the CCS menu bar, click Window → Reset Perspective … and then Yes.
StellarisWare, Initialization and GPIO

Introduction

This chapter will introduce you to StellarisWare. The lab exercise uses StellarisWare API functions to set up the clock, and to configure and write to the GPIO port.

Agenda

Introduction to ARM® Cortex™-M4F and Peripherals
Code Composer Studio

Introduction to StellarisWare, Initialization and GPIO

Interrupts and the Timers
ADC12
Hibernation Module
USB
Memory
Floating-Point
BoosterPacks and grLib
Synchronous Serial Interface
UART
µDMA
# Chapter Topics

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>StellarisWare, Initialization and GPIO</td>
<td>3-1</td>
</tr>
<tr>
<td>Chapter Topics</td>
<td>3-2</td>
</tr>
<tr>
<td>StellarisWare</td>
<td>3-3</td>
</tr>
<tr>
<td>Clocking</td>
<td>3-5</td>
</tr>
<tr>
<td>GPIO</td>
<td>3-7</td>
</tr>
<tr>
<td>Lab 3: Initialization and GPIO</td>
<td>3-9</td>
</tr>
<tr>
<td>Objective</td>
<td>3-9</td>
</tr>
<tr>
<td>Procedure</td>
<td>3-10</td>
</tr>
</tbody>
</table>
StellarisWare

StellarisWare®

License-free and Royalty-free source code for TI Cortex-M devices:
- Peripheral Driver Library
- Graphics Library
- USB Library
- Ethernet stacks
- In-System Programming

Features...

StellarisWare Features

Peripheral Driver Library
- High-level API interface to complete peripheral set
- License & royalty free use for TI Cortex-M parts
- Available as object library and as source code
- Programmed in the on-chip ROM

Graphics Library
- Graphics primitive and widgets
- 153 fonts plus Asian and Cyrillic
- Graphics utility tools

USB Stacks and Examples
- USB Device and Embedded Host compliant
- Device, Host, OTG and Windows-side examples
- Free VID/PID sharing program

Ethernet
- lwip and uip stacks with 1588 PTP modifications
- Extensive examples

Extras
- SimpliciTI wireless protocol
- IQ math examples
- Bootloaders
- Windows side applications

ISP...
### In System Programming Options

#### Stellaris Serial Flash Loader
- Small piece of code that allows programming of the flash without the need for a debugger interface.
- All Stellaris MCUs ship with this pre-loaded in flash
- UART or SSI interface option
- The LM Flash Programmer interfaces with the serial flash loader
- See application note SPMA029

#### Stellaris Boot Loader
- Preloaded in ROM or can be programmed at the beginning of flash to act as an application loader
- Can also be used as an update mechanism for an application running on a Stellaris microcontroller.
- Interface via UART (default), I2C, SSI, Ethernet, USB (DFU H/D)
- Included in the Stellaris Peripheral Driver Library with full applications examples
Clocking

Fundamental Clock Sources

**Precision Internal Oscillator (PIO SC)**
- 16 MHz ± 3%

**Main Oscillator (MOSC) using...**
- An external single-ended clock source
- An external crystal

**Internal 30 kHz Oscillator**
- 30 kHz ± 50%
- Intended for use during Deep-Sleep power-saving modes

**Hibernation Module Clock Source**
- 32,768Hz crystal
- Intended to provide the system with a real-time clock source

System (CPU) Clock Sources

The CPU can be driven by any of the fundamental clocks...

- Internal 16 MHz
- Main
- Internal 30 kHz
- External Real-Time

- Plus -
- The internal PLL (400 MHz)
- The internal 16MHz oscillator divided by four (4MHz ± 3%)

<table>
<thead>
<tr>
<th>Clock Source</th>
<th>Drive PLL?</th>
<th>Used as SysClk?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal 16MHz</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Internal 16MHz/4</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Main Oscillator</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Internal 30 kHz</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Hibernation Module</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>PLL</td>
<td>-</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Clocking
Stellaris Clock Tree

driverLib API SysCtlClockSet() selects:
- SYSDIV divider setting
- OSC or PLL
- Main or Internal oscillator
- Crystal frequency
GPIO

General Purpose IO

- Any GPIO can be an interrupt:
  - Edge-triggered on rising, falling or both
  - Level-sensitive on high or low values
- Can directly initiate an ADC sample sequence or μDMA transfer
- Toggle rate up to the CPU clock speed on the Advanced High-Performance Bus. ½ CPU clock speed on the Standard.
- 5V tolerant in input configuration
- Programmable Drive Strength (2, 4, 8mA or 8mA with slew rate control)
- Programmable weak pull-up, pull-down, and open drain
- Pin state can be retained during Hibernation mode

New Pin Mux GUI Tool: www.ti.com/StellarisPinMuxUtility

www.ti.com/StellarisPinMuxUtility
### GPIO Address Masking

Each GPIO port has a base address. You can write an 8-bit value directly to this base address and all eight pins are modified. If you want to modify specific bits, you can use a bit-mask to indicate which bits are to be modified. This is done in hardware by mapping each GPIO port to 256 addresses. Bits 9:2 of the address bus are used as the bit mask.

<table>
<thead>
<tr>
<th>GPIO Port D (0x4005.8000)</th>
<th>Write Value (0xEB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>000111101</td>
<td>11101011</td>
</tr>
</tbody>
</table>

Instead of writing to GPIO Port D directly, write to 0x4005.8098. Bits 9:2 (shown here) become a bit-mask for the value you write.

Only the bits marked as “1” in the bit-mask are changed.

```c
GPIOPinWrite(GPIO_PORTD_BASE, GPIO_PIN_5|GPIO_PIN_2|GPIO_PIN_1, 0xEB);
```

Note: you specify base address, bit mask, and value to write. The GPIOPinWrite() function determines the correct address for the mask.

The masking technique used on ARM Cortex-M GPIO is similar to the “bit-banding” technique used in memory. To aid in the efficiency of software, the GPIO ports allow for the modification of individual bits in the GPIO Data (GPIODATA) register by using bits [9:2] of the address bus as a mask. In this manner, software can modify individual GPIO pins in a single, atomic read-modify-write (RMW) instruction without affecting the state of the other pins. This method is more efficient than the conventional method of performing a RMW operation to set or clear an individual GPIO pin. To implement this feature, the GPIODATA register covers 256 locations in the memory map.

...
Lab 3: Initialization and GPIO

Objective

In this lab we’ll learn how to initialize the clock system and the GPIO peripheral. We’ll then use the GPIO output to blink an LED on the evaluation board.

Lab 3: Initialization and GPIO

- Configure the system clock
- Enable and configure GPIO
- Use a software delay to toggle an LED on the evaluation board

USB Emulation Connection

Agenda...
Procedure

Create Lab3 Project

1. Maximize Code Composer. On the CCS menu bar select File → New → CCS Project. Make the selections shown below. Make sure to uncheck the “Use default location” checkbox and select the correct path to the “ccs” folder you created. **This step is important to make your project portable and in order for the include paths to work correctly.** In the variant box, just type “120” to narrow the results in the right-hand box. In the Project templates and examples window, select Empty Project (with main.c). Click Finish.

When the wizard completes, close the Grace tab if it appears, then click the + or next to Lab3 in the Project Explorer pane to expand the project. Note that Code Composer has automatically added main.c file to your project. We placed startup_ccs.c in the folder beforehand, so it was automatically added to the project. We also placed a file called main.txt in the folder which contains the final code for the lab. If you run into trouble, you can refer to this file.
Header Files

2. Delete the current contents of main.c. Type (or cut/paste from the pdf file) the following lines into main.c to include the header files needed to access the StellarisWare APIs as well as a variable definition:

```
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/sysctl.h"
#include "driverlib/gpio.h"

int PinData=2;
```

**hw_memmap.h** : Macros defining the memory map of the Stellaris device. This includes defines such as peripheral base address locations such as GPIO_PORTF_BASE.

**hw_types.h** : Defines common types and macros such as tBoolean and HWREG(x).

**sysctl.h** : Defines and macros for System Control API of DriverLib. This includes API functions such as SysCtlClockSet and SysCtlClockGet.

**gpio.h** : Defines and macros for GPIO API of DriverLib. This includes API functions such as GPIOPinTypePWM and GPIOPinWrite.

```
int PinData=2;
```

Creates an integer variable called PinData and initializes it to 2. This will be used to cycle through the three LEDs, lighting them one at a time.

You will see question marks to the left of the include lines in main.c displayed in Code Composer. We have not yet defined the path to the include folders, so Code Composer can’t find them. We’ll fix this later.

Main() Function

3. Next, we’ll drop in a template for our main function. Leave a line for spacing and add this code after the previous declarations:

```
int main(void)
{
}
```

If you type this in, notice that the editor will add the closing brace when you add the opening one. Why wasn’t this thought of sooner?
Clock Setup

4. Configure the system clock to run using a 16MHz crystal on the main oscillator, driving the 400MHz PLL. The 400MHz PLL oscillates at only that frequency, but can be driven by crystals or oscillators running between 5 and 25MHz. There is a default /2 divider in the clock path and we are specifying another /5, which totals 10. That means the System Clock will be 40MHz. Enter this single line of code inside main():

```c
SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
```

The diagram below is an abbreviated drawing of the clock tree to emphasize the System Clock path and choices.

![Clock Diagram](image)

The diagram below is an excerpt from the LaunchPad board schematic. Note that the crystal attached to the main oscillator inputs is 16MHz, while the crystal attached to the real-time clock (RTC) inputs is 32,768Hz.

![RTC Diagram](image)
GPIO Configuration

5. Before calling any peripheral specific `driverLib` function, we must enable the clock for that peripheral. If you fail to do this, it will result in a Fault ISR (address fault). This is a common mistake for new Stellaris users. The second statement below configures the three GPIO pins connected to the LEDs as outputs. The excerpt below of the LaunchPad board schematic shows GPIO pins PF1, PF2 and PF3 are connected to the LEDs.

 Leave a line for spacing, then enter these two lines of code inside `main()` after the line in the previous step.

```c
SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
```

The base addresses of the GPIO ports listed in the User Guide are shown below. Note that they are all within the memory map’s peripheral section shown in module 1. APB refers to the Advanced Peripheral Bus, while AHB refers to the Advanced High-Performance Bus. The AHB offers better back-to-back performance than the APB bus. GPIO ports accessed through the AHB can toggle every clock cycle vs. once every two cycles for ports on the APB. In power sensitive applications, the APB would be a better choice than the AHB. In our labs, `GPIO_PORTF_BASE` is 0x40025000.

<table>
<thead>
<tr>
<th>Port</th>
<th>(APB) Base Address</th>
<th>(AHB) Base Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0x4000.4000</td>
<td>0x4005.8000</td>
</tr>
<tr>
<td>B</td>
<td>0x4000.5000</td>
<td>0x4005.9000</td>
</tr>
<tr>
<td>C</td>
<td>0x4000.6000</td>
<td>0x4005.A000</td>
</tr>
<tr>
<td>D</td>
<td>0x4000.7000</td>
<td>0x4005.B000</td>
</tr>
<tr>
<td>E</td>
<td>0x4002.4000</td>
<td>0x4005.C000</td>
</tr>
<tr>
<td>F</td>
<td>0x4002.5000</td>
<td>0x4005.D000</td>
</tr>
</tbody>
</table>
While() Loop

6. Finally, create a while (1) loop to send a “1” and “0” to the selected GPIO pin, with an equal delay between the two.

SysCtlDelay() is a loop timer provided in StellarisWare. The count parameter is the loop count, not the actual delay in clock cycles.

To write to the GPIO pin, use the GPIO API function call GPIOPinWrite. Make sure to read and understand how the GPIOPinWrite function is used in the Datasheet. The third data argument is not simply a 1 or 0, but represents the entire 8-bit data port. The second argument is a bit-packed mask of the data being written.

In our example below, we are writing the value in the PinData variable to all three GPIO pins that are connected to the LEDs. Only those three pins will be written to based on the bit mask specified. The final instruction cycles through the LEDs by making PinData equal to 2, 4, 8, 2, 4, 8 and so on. Note that the values sent to the pins match their positions; a “one” in the bit two position can only reach the bit two pin on the port.

Now might be a good time to look at the Datasheet for your Stellaris device. Check out the GPIO chapter to understand the unique way the GPIO data register is designed and the advantages of this approach.

Leave a line for spacing, and then add this code after the code in the previous step.

```c
while(1)
{
    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, PinData);
    SysCtlDelay(2000000);
    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x00);
    SysCtlDelay(2000000);
    if(PinData==8) {PinData=2;} else {PinData=PinData*2;}
}
```

If you find that the indentation of your code doesn’t look quite right, select all of your code by clicking CTRL-A and then right-click on the selected code. Select Source → Correct Indentation. Also notice the other great stuff under the Source and Surround With selections.
7. Click the Save button to save your work. Your code should look something like this:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/sysctl.h"
#include "driverlib/gpio.h"

int PinData=2;

int main(void)
{
    SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
    while(1)
    {
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, PinData);
        SysCtlDelay(2000000);
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x00);
        SysCtlDelay(2000000);
        if(PinData==8) {PinData=2;} else {PinData=PinData*2;}
    }
}
```

Sorry about the small font here, but any larger font made the `SysCtlClockSet()` instruction look strange. If you’re having problems, you can cut/paste this code into `main.c` or you can cut/paste from the main.txt file in your Lab3/ccs folder.

If you were to try building this code now (please don’t), it would fail. Note the question marks next to the include statements… CCS has no idea where those files are located. We still need to add the start up code and set our build options.

**Startup Code**

8. In addition to the main file you have created, you will also need a startup file specific to the tool chain you are using. This file contains the vector table, startup routines to copy initialized data to RAM and clear the bss section, and default fault ISRs. We included this file in your folder.

Double-click on `startup_ccs.c` in your Project Explorer pane and take a look around. Don’t make any changes at this time.
Set the Build Options

9. Right-click on Lab3 in the Project Explorer pane and select Properties. Click **Include Options** under **ARM Compiler**. In the bottom, **include search path** pane, click the Add button and add the following search path:

$\{PROJECT_ROOT\}/../../

If you followed the instructions when you created the Lab3 project, this path, 4 levels above the project folder, will give your project access to the **inc** and **driverlib** folders. Otherwise you will have to adjust the path. You can check it for yourself using Windows Explorer.

Avoid typing errors and copy/paste from the workbook pdf for this and the next step.

Click OK. After a moment, CCS will refresh the project and you should see the question marks disappear from the include lines in **main.c**.
10. Right-click on Lab3 again in the Project Explorer pane and select Properties. Under **ARM Linker**, click **File Search Path**. We need to provide the project with the path to the M4F libraries. Add the following include library file to the top window:

```
${PROJECT_ROOT}/../../../../driverlib/ccs-cm4f/Debug/driverlib-cm4f.lib
```

Of course, if you did not follow the directions when creating the Lab3 project, this path will have to be adjusted like the previous one.

![Properties for Lab3](image)

Click OK to save your changes.
Compile, Download and Run the Code

11. Compile and download your application by clicking the Debug button on the menu bar. If you are prompted to save changes, do so. If you have any issues, correct them, and then click the Debug button again (see the hints page in section 2). After a successful build, the CCS Debug perspective will appear.

Click the Resume button to run the program that was downloaded to the flash memory of your device. You should see the LEDs flashing. If you want to edit the code to change the delay timing or which LEDs that are flashing, go ahead.

If you are playing around with the code and get the message “No source available for …”, close that editor tab. The source code for that function is not present in our project. It is only present as a library file.

Click on the Terminate button to return to the CCS Edit perspective.
Examine the Stellaris Pin Masking Feature

Note that the following steps differ slightly from the workshop video.

12. Let’s change the code so that all three LEDs are on all the time. Make the following changes:

Find the line containing `int PinData=2;` and change it to `int PinData=14;`

Find the line containing `if(PinData ...` and comment it out by adding `//` to the start of the line.

Save your changes.

13. Compile and download your application by clicking the Debug button on the menu bar. Click the Resume button to run the code. With all three LEDs being lit at the same time, you should see them flashing an almost white color.

14. Now let’s use the pin masking feature to light the LEDs one at the time. We don’t have to go back to the CCS Edit perspective to edit the code. We can do it right here. In the code window, look at the first line containing `GPIOPinWrite()`. The pin mask here is `GPIO_PIN_1| GPIO_PIN_2| GPIO_PIN_3`, meaning that all three of these bit positions, corresponding to the positions of the LED will be sent to the GPIO port. Change the bit mask to `GPIO_PIN_1`. The line should look like this:

```
GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1, PinData);
```

15. Compile and download your application by clicking the Debug button on the menu bar. When prompted to save your work, click OK. When you are asked if you want to terminate the debug sessions, click Yes.

Before clicking the Resume button, predict which LED you expect to flash: ________

Click the Resume button. If you predicted red, you were correct.

16. In the code window, change the first `GPIOPinWrite()` line to:

```
GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, PinData);
```

17. Compile and download your application by clicking the Debug button on the menu bar. When prompted to save your work, click OK. When you are asked if you want to terminate the debug sessions, click Yes.

Before clicking the Resume button, predict which LED you expect to flash: ________

Click the Resume button. If you predicted blue, you were correct.

18. In the code window, change the first `GPIOPinWrite()` line to:

```
GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_3, PinData);
```
19. Compile and download your application by clicking the Debug button on the menu bar. When prompted to save your work, click OK. When you are asked if you want to terminate the debug sessions, click Yes.

Before clicking the Resume button, predict which LED you expect to flash: _________

Click the Resume button . If you predicted green, you were correct.

20. Change the code back to the original set up: Make the following changes:

Find the line containing int PinData14; and change it to int PinData=2;

Find the line containing if(PinData ... and uncomment it

Find the line containing the first GPIOPinWrite() and change it back to:

GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1| GPIO_PIN_2| GPIO_PIN_3, PinData);

21. Compile and download your application by clicking the Debug button on the menu bar. When prompted to save your work, click OK. When you are asked if you want to terminate the debug sessions, click Yes. Click the Resume button and verify that the code works like it did before.

22. **Homework idea:** Look at the use of the ButtonsPoll() API call in the qs-rgb.c file in the quickstart application (qs-rgb) folder. Write code to use that API function to turn the LEDs on and off using the pushbuttons.

You’re done.
Interrupts and the Timers

Introduction

This chapter will introduce you to the use of interrupts on the ARM® Cortex-M4® and the general purpose timer module (GPTM). The lab will use the timer to generate interrupts. We will write a timer interrupt service routine (ISR) that will blink the LED.

Agenda

Introduction to ARM® Cortex™-M4F and Peripherals
Code Composer Studio
Introduction to StellarisWare, Initialization and GPIO

Interrupts and the Timers
ADC12
Hibernation Module
USB
Memory
Floating-Point
Booster Packs and grLib
Synchronous Serial Interface
UART
μDMA

NVIC...
## Chapter Topics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interrupts and the Timers</td>
<td>4-1</td>
</tr>
<tr>
<td>Chapter Topics</td>
<td>4-2</td>
</tr>
<tr>
<td>Cortex-M4 NVIC</td>
<td>4-3</td>
</tr>
<tr>
<td>Cortex-M4 Interrupt Handling and Vectors</td>
<td>4-7</td>
</tr>
<tr>
<td>General Purpose Timer Module</td>
<td>4-9</td>
</tr>
<tr>
<td>Lab 4: Interrupts and the Timer</td>
<td>4-10</td>
</tr>
<tr>
<td>Objective</td>
<td>4-10</td>
</tr>
<tr>
<td>Procedure</td>
<td>4-11</td>
</tr>
</tbody>
</table>
Cortex-M4 NVIC

**Nested Vectored Interrupt Controller (NVIC)**

- Handles exceptions and interrupts
- 8 programmable priority levels, priority grouping
- 7 exceptions and 65 Interrupts
- Automatic state saving and restoring
- Automatic reading of the vector table entry
- Pre-emptive/Nested Interrupts
- Tail-chaining
- Deterministic: always 12 cycles or 6 with tail-chaining

...Tail Chaining...
In the above example, two interrupts occur simultaneously.

In most processors, interrupt handling is fairly simple and each interrupt will start a PUSH PROCESSOR STATE – RUN ISR – POP PROCESSOR STATE process. Since IRQ1 was higher priority, the NVIC causes the CPU to run it first. When the interrupt handler (ISR) for the first interrupt is complete, the NVIC sees a second interrupt pending, and runs that ISR. This is quite wasteful since the middle POP and PUSH are moving the exact same processor state back and forth to stack memory. If the interrupt handler could have seen that a second interrupt was pending, it could have “tail-chained” into the next ISR, saving power and cycles.

The Stellaris NVIC does exactly this. It takes only 12 cycles to PUSH and POP the processor state. When the NVIC sees a pending ISR during the execution of the current one, it will “tail-chain” the execution using just 6 cycles to complete the process.

If you are depending on interrupts to be run quickly, the Stellaris devices offer a huge advantage here.
In this example, the processor was in the process of popping the processor status from the stack for the first ISR when a second ISR occurred.

In most processors, the interrupt controller would complete the process before starting the entire PUSH-ISR-POP process over again, wasting precious cycles and power doing so.

The Stellaris NVIC is able to stop the POP process, return the stack pointer to the proper location and “tail-chain” into the next ISR with only 6 cycles.

Again, this is a huge advantage for interrupt handling on Stellaris devices.
In this example, a higher priority interrupt has arrived just after a lower priority one.

In most processors, the interrupt controller is smart enough to recognize the late arrival of a higher priority interrupt and restart the interrupt procedure accordingly.

The Stellaris NVIC takes this one step further. The PUSH is the same process regardless of the ISR, so the Stellaris NVIC simply changes the fetched ISR. In between the ISRs, “tail chaining” is done to save cycles.

Once more, Stellaris devices handle interrupts with lower latency.
Interrupt handling is automatic. No instruction overhead.

**Entry**
- Automatically pushes registers R0–R3, R12, LR, PSR, and PC onto the stack
- In parallel, ISR is pre-fetched on the instruction bus. ISR ready to start executing as soon as stack PUSH complete

**Exit**
- Processor state is automatically restored from the stack
- In parallel, interrupted instruction is pre-fetched ready for execution upon completion of stack POP

### Cortex-M4® Exception Types

<table>
<thead>
<tr>
<th>Vector Number</th>
<th>Exception Type</th>
<th>Priority</th>
<th>Vector address</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Reset</td>
<td>-3</td>
<td>0x04</td>
<td>Reset</td>
</tr>
<tr>
<td>2</td>
<td>NMI</td>
<td>-2</td>
<td>0x08</td>
<td>Non-Maskable Interrupt</td>
</tr>
<tr>
<td>3</td>
<td>Hard Fault</td>
<td>-1</td>
<td>0x0C</td>
<td>Error during exception processing</td>
</tr>
<tr>
<td>4</td>
<td>Memory Management Fault</td>
<td>Programmable</td>
<td>0x10</td>
<td>MPU violation</td>
</tr>
<tr>
<td>5</td>
<td>Bus Fault</td>
<td>Programmable</td>
<td>0x14</td>
<td>Bus error (Prefetch or data abort)</td>
</tr>
<tr>
<td>6</td>
<td>Usage Fault</td>
<td>Programmable</td>
<td>0x18</td>
<td>Exceptions due to program errors</td>
</tr>
<tr>
<td>7-10</td>
<td>Reserved</td>
<td>-</td>
<td>0x1C - 0x28</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>SVCall</td>
<td>Programmable</td>
<td>0x2C</td>
<td>SVC instruction</td>
</tr>
<tr>
<td>12</td>
<td>Debug Monitor</td>
<td>Programmable</td>
<td>0x30</td>
<td>Exception for debug</td>
</tr>
<tr>
<td>13</td>
<td>Reserved</td>
<td>-</td>
<td>0x34</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>PendSV</td>
<td>Programmable</td>
<td>0x38</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>SysTick</td>
<td>Programmable</td>
<td>0x3C</td>
<td>System Tick Timer</td>
</tr>
<tr>
<td>16 and above</td>
<td>Interrupts</td>
<td>Programmable</td>
<td>0x40</td>
<td>External interrupts (Peripherals)</td>
</tr>
</tbody>
</table>
Cortex-M4 Vector Table

- After reset, vector table is located at address 0
- Each entry contains the address of the function to be executed
- The value in address 0x00 is used as starting address of the Main Stack Pointer (MSP)
- Vector table can be relocated by writing to the VTABLE register (must be aligned on a 1KB boundary)
- Open startup_ccs.c to see vector table coding

<table>
<thead>
<tr>
<th>Exception number</th>
<th>IRQ number</th>
<th>Offset</th>
<th>Vector</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0000</td>
<td>IRQ13</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x0001</td>
<td>IRQ12</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x0002</td>
<td>IRQ11</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x0003</td>
<td>IRQ10</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x0004</td>
<td>SysTick</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x0005</td>
<td>PendSV</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x0006</td>
<td>SysRst</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x0007</td>
<td>Reserved</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x0008</td>
<td>Reserved</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x0009</td>
<td>Reserved</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x000A</td>
<td>Usage fault</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x000B</td>
<td>Bus fault</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x000C</td>
<td>Memory management fault</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x000D</td>
<td>Hard fault</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x000E</td>
<td>NMI</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x000F</td>
<td>Reset</td>
<td></td>
<td>SVC</td>
</tr>
<tr>
<td>0x0010</td>
<td>Initial SP value</td>
<td></td>
<td>SVC</td>
</tr>
</tbody>
</table>
General Purpose Timer Module

- Six 16/32-bit and Six 32/64-bit general purpose timers
- Twelve 16/32-bit and Twelve 32/64-bit capture/compare/PWM pins
- Timer modes:
  - One-shot
  - Periodic
  - Input edge count or time capture with 16-bit prescaler
  - PWM generation (separated only)
  - Real-Time Clock (concatenated only)
- Count up or down
- Simple PWM (no deadband generation)
- Support for timer synchronization, daisy-chains, and stalling during debugging
- May trigger ADC samples or DMA transfers
Lab 4: Interrupts and the Timer

Objective

In this lab we’ll set up the timer to generate interrupts, and then write the code that responds to the interrupt … flashing the LED. We’ll also experiment with generating an exception, by attempting to configure a peripheral before it’s been enabled.
Procedure

**Import Lab4 Project**

1. We have already created the Lab4 project for you with an empty `main.c`, a startup file and all necessary project and build options set. Maximize Code Composer and click Project → Import Existing CCS Eclipse Project. Make the settings show below and click Finish. **Make sure that the “Copy projects into workspace” checkbox is unchecked.**
Header Files

2. Expand the lab by clicking the + or ▷ to the left of Lab4 in the Project Explorer pane. Open main.c for editing by double-clicking on it. Type (or copy/paste) the following seven lines into main.c to include the header files needed to access the StellarisWare APIs:

```c
#include "inc/hw_ints.h"
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/sysctl.h"
#include "driverlib/interrupt.h"
#include "driverlib/gpio.h"
#include "driverlib/timer.h"
```

- `hw_ints.h` : Macros that define the interrupt assignment on Stellaris devices (NVIC)
- `hw_memmap.h` : Macros defining the memory map of the Stellaris device. This includes defines such as peripheral base address locations, e.g., GPIO_PORTF_BASE
- `hw_types.h` : Defines common types and macros such as tBoolean and HWREG(x)
- `sysctl.h` : Defines and macros for System Control API of driverLib. This includes API functions such as SysCtlClockSet and SysCtlClockGet.
- `interrupt.h` : Defines and macros for NVIC Controller (Interrupt) API of DriverLib. This includes API functions such as IntEnable and IntPrioritySet.
- `gpio.h` : Defines and macros for GPIO API of driverLib. This includes API functions such as GPIOPinTypePWM and GPIOPinWrite.
- `timer.h` : Defines and macros for Timer API of driverLib. This includes API functions such as TimerConfigure and TimerLoadSet.
Main() Function

3. We’re going to compute our timer delays using the variable Period. Create main() along with an unsigned-long variable (that’s why the variable is called ulPeriod) for this computation. Leave a line for spacing and type (or cut/paste) the following after the previous lines:

```c
int main(void)
{
    unsigned long ulPeriod;
}
```

Clock Setup

4. Configure the system clock to run at 40MHz (like in Lab3) with the following call.

Leave a blank line for spacing and enter this line of code inside main():

```c
SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
```

GPIO Configuration

5. Like the previous lab, we need to enable the GPIO peripheral and set the pins connected to the LEDs as outputs. Leave a line for spacing and add these lines after the last ones:

```c
SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
```

Timer Configuration

6. Again, before calling any peripheral specific driverLib function we must enable the clock to that peripheral (RCGCn register). If you fail to do this, it will result in a Fault ISR (address fault). The second statement configures Timer 0 as a 32-bit timer in periodic mode. Note that when Timer 0 is configured as a 32-bit timer, it combines the two 16-bit timers Timer 0A and Timer 0B. See the General Purpose Timer chapter of the device datasheet for more information. TIMER0_BASE is the start of the timer registers for Timer0 in, you guessed it, the peripheral section of the memory map. Add a line for spacing and type the following lines of code after the previous ones:

```c
SysCtlPeripheralEnable(SYSCTL_PERIPH_TIMER0);
TimerConfigure(TIMER0_BASE, TIMER_CFG_32_BIT_PER);
```
Lab 4: Interrupts and the Timer

**Calculate Delay**

7. To toggle a GPIO at 10Hz and a 50% duty cycle, you need to generate an interrupt at ½ of the desired period. First, calculate the number of clock cycles required for a 10Hz period by calling SysCtlClockGet() and dividing it by your desired frequency. Then divide that by two, since we want a count that is ½ of that for the interrupt.

   This calculated period is then loaded into the Timer’s Interval Load register using the TimerLoadSet function of the driverLib Timer API. Note that you have to subtract one from the timer period since the interrupt fires at the zero count.

   Add a line for spacing and add the following lines of code after the previous ones:

   ```c
   ulPeriod = (SysCtlClockGet() / 10) / 2;
   TimerLoadSet(TIMER0_BASE, TIMER_A, ulPeriod -1);
   ```

**Interrupt Enable**

8. Next, we have to enable the interrupt … not only in the timer module, but also in the NVIC (the Nested Vector Interrupt Controller, the Cortex M4’s interrupt controller). IntMasterEnable is the master interrupt enable for all interrupts. IntEnable enables the specific vector associated with the Timer. TimerIntEnable, enables a specific event within the timer to generate an interrupt. In this case we are enabling an interrupt to be generated on a timeout of Timer 0A. Add a line for spacing and type the following three lines of code after the previous ones:

   ```c
   IntEnable(INT_TIMER0A);
   TimerIntEnable(TIMER0_BASE, TIMER_TIMA_TIMEOUT);
   IntMasterEnable();
   ```

**Timer Enable**

9. Finally we can enable the timer. This will start the timer and interrupts will begin triggering on the timeouts. Add a line for spacing and type the following line of code after the previous ones:

   ```c
   TimerEnable(TIMER0_BASE, TIMER_A);
   ```

**Main Loop**

10. The main loop of the code is simply an empty while(1) since the toggling of the GPIO will happen in the interrupt routine. Add a line for spacing and add the following lines of code after the previous ones:

   ```c
   while(1)
   {
   }
   ```
**Timer Interrupt Handler**

11. Since this application is interrupt driven, we must add an interrupt handler for the Timer. In the interrupt handler, we must first clear the interrupt source and then toggle the GPIO pin based on the current state. Just in case your last program left any of the LEDs on, the first `GPIOPinWrite()` call turns off all three LEDs. Writing a 4 to pin 2 lights the blue LED. Add a line for spacing and add the following lines of code after the final closing brace of `main()`.

```c
void Timer0IntHandler(void)
{
    // Clear the timer interrupt
    TimerIntClear(TIMER0_BASE, TIMER_TIMA_TIMEOUT);

    // Read the current state of the GPIO pin and
    // write back the opposite state
    if(GPIOPinRead(GPIO_PORTF_BASE, GPIO_PIN_2))
    {
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0);
    }
    else
    {
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, 4);
    }
}
```

If your indentation looks wrong, remember how we corrected it in the previous lab.
12. Click the Save button to save your work. Your code should look something like this:

```c
#include "inc/hw_ints.h"
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/sysctl.h"
#include "driverlib/interrupt.h"
#include "driverlib/gpio.h"
#include "driverlib/timer.h"

int main(void)
{
    unsigned long ulPeriod;
    SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_TIMER0);
    TimerConfigure(TIMER0_BASE, TIMER_CFG_32_BIT_PER);
    ulPeriod = (SysCtlClockGet() / 10) / 2;
    TimerLoadSet(TIMER0_BASE, TIMER_A, ulPeriod -1);
    IntEnable(INT_TIMER0A);
    TimerIntEnable(TIMER0_BASE, TIMER_TIMA_TIMEOUT);
    IntMasterEnable();

    TimerEnable(TIMER0_BASE, TIMER_A);
    while(1)
    {
    }
}

void Timer0IntHandler(void)
{
    // Clear the timer interrupt
    TimerIntClear(TIMER0_BASE, TIMER_TIMA_TIMEOUT);

    // Read the current state of the GPIO pin and
    // write back the opposite state
    if(GPIOPinRead(GPIO_PORTF_BASE, GPIO_PIN_2))
    {
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0);
    }
    else
    {
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, 4);
    }
```
**Startup Code**

13. Open `startup_ccs.c` for editing. This file contains the vector table that we discussed during the presentation. Browse the file and look for the Timer 0 subtimer A vector.

When that timer interrupt occurs, the NVIC will look in this vector location for the address of the ISR (interrupt service routine). That address is where the next code fetch will happen.

You need to **carefully** find the appropriate vector position and replace `IntDefaultHandler` with the name of your Interrupt handler (We suggest that you copy/paste this). In this case you will add `Timer0IntHandler` to the position with the comment “Timer 0 subtimer A” as shown below:

```
IntDefaultHandler, // ADC Sequence 2
IntDefaultHandler, // ADC Sequence 3
IntDefaultHandler, // Watchdog timer
Timer0IntHandler,  // Timer 0 subtimer A
IntDefaultHandler, // Timer 0 subtimer B
IntDefaultHandler, // Timer 1 subtimer A
```

You will also need to declare this function at the top of this file as external. This is necessary for the compiler to resolve this symbol. Find the line containing:

```
extern void _c_int00(void);
```

and add:

```
extern void Timer0IntHandler(void);
```

right below it as shown below:

```
37 // External declaration for the reset handler that is to be called when the
38 // processor is started
39 //
40 //**************************************************************************
41 extern void _c_int00(void);
42 extern void Timer0IntHandler(void);
43 //**************************************************************************
44 //
```

Click the Save button.
Compile, Download and Run The Code

14. Compile and download your application by clicking the Debug button on the menu bar. If you have any issues, correct them, and then click the Debug button again. (You were careful about that interrupt vector placement, weren’t you?) After a successful build, the CCS Debug perspective will appear.

Click the Resume button to run the program that was downloaded to the flash memory of your device. The blue LED should be flashing on your LaunchPad board.

When you’re done, click the Terminate button to return to the Editing perspective.
**Exceptions**

15. Find the line of code that enables the GPIO peripheral and comment it out as shown below:

```c
13 SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
15 // SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIO);
16 GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
```

Now our code will be accessing the peripheral without the peripheral clock being enabled. This should generate an exception.

16. Compile and download your application by clicking the Debug button on the menu bar, then click the Resume button to run the program. What?! The program seems to run just fine doesn’t it? The blue LED is flashing. The problem is that we enabled the peripheral in our earlier run of the code … we never disabled it or power cycled the part.

17. Click the Terminate button to return to the editing perspective. Remove/reinstall the micro-USB cable on the LaunchPad board to cycle the power. This will return the peripheral registers to their default power-up states.

The code that you just downloaded is running, but note that the blue LED isn’t flashing now.

18. Compile and download your application by clicking the Debug button on the menu bar, then click the Resume button to run the program. Nothing much should appear to be happening. Click the Suspend button to stop execution. You should see that execution has trapped inside the FaultISR() interrupt routine. All of the exception ISRs trap in while(1) loops in the provided code. That probably isn’t the behavior you want in your production code.

19. Remove the comment and compile, download and run your code again to make sure everything works properly. When you’re done, click the Terminate button to return to the Editing perspective and close the Lab4 project. Minimize CCS.

20. **Homework Idea:** Investigate the Pulse-Width Modulation capabilities of the general purpose timer. Program the timer to blink the LED faster than your eye can see, usually above 30Hz and use the pulse width to vary the apparent intensity. Write a loop to make the intensity vary periodically.

You’re done.
Introduction

This chapter will introduce you to the use of the analog to digital conversion (ADC) peripheral on the Stellaris M4F. The lab will use the ADC and sequencer to sample the on-chip temperature sensor.

Agenda

Introduction to ARM® Cortex™-M4F and Peripherals
Code Composer Studio
Introduction to StellarisWare, Initialization and GPIO
Interrupts and the Timers
ADC12
Hibernation Module
USB
Memory
Floating-Point
BoosterPacks and grLib
Synchronous Serial Interface
UART
μDMA
Chapter Topics

ADC12.........................................................................................................................................................5-1

Chapter Topics...........................................................................................................................................5-2
ADC12 .....................................................................................................................................................5-3

Sample Sequencers..............................................................................................................................5-4

Lab 5: ADC12 ..........................................................................................................................................5-5
Objective...............................................................................................................................................5-5
Procedure..............................................................................................................................................5-6

Hardware averaging....................................................................................................................................5-17

Calling APIs from ROM.................................................................................................................................5-18
ADC12

Analog-to-Digital Converter

- Stellaris LM4F MCUs feature two ADC modules (ADC0 and ADC1) that can be used to convert continuous analog voltages to discrete digital values
- Each ADC module has 12-bit resolution
- Each ADC module operates independently and can:
  - Execute different sample sequences
  - Sample any of the shared analog input channels
  - Generate interrupts & triggers

LM4F120H5QR ADC Features

- Two 12-bit 1MSPS ADCs
- 12 shared analog input channels
- Single ended & differential input configurations
- On-chip temperature sensor
- Maximum sample rate of one million samples/second (1MSPS).
- Fixed references (VDDA/GNDA) due to pin-count limitations
- 4 programmable sample conversion sequencers per ADC
- Separate analog power & ground pins
- Flexible trigger control
  - Controller/software
  - Timers
  - Analog comparators
  - GPIO
- 2x to 64x hardware averaging
- 8 Digital comparators / per ADC
- 2 Analog comparators
- Optional phase shift in sample time, between ADC modules...programmable from 22.5° to 337.5°
Sample Sequencers

ADC Sample Sequencers

- Stellaris LM4F ADC’s collect and sample data using programmable sequencers.
- Each sample sequence is a fully programmable series of consecutive (back-to-back) samples that allows the ADC module to collect data from multiple input sources without having to be re-configured.
- Each ADC module has 4 sample sequencers that control sampling and data capture.
- All sample sequencers are identical except for the number of samples they can capture and the depth of their FIFO.
- To configure a sample sequencer, the following information is required:
  - Input source for each sample
  - Mode (single-ended, or differential) for each sample
  - Interrupt generation on sample completion for each sample
  - Indicator for the last sample in the sequence
- Each sample sequencer can transfer data independently through a dedicated μDMA channel.

<table>
<thead>
<tr>
<th>Sequencer</th>
<th>Number of Samples</th>
<th>Depth of FIFO</th>
</tr>
</thead>
<tbody>
<tr>
<td>SS 3</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>SS 2</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>SS 1</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>SS 0</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>
Lab 5: ADC12

Objective

In this lab we’ll use the ADC12 and sample sequencers to measure the data from the on-chip temperature sensor. We’ll use Code Composer to display the changing values.
Procedure

Import Lab5 Project

1. We have already created the Lab5 project for you with an empty main.c, a startup file and all necessary project and build options set. Maximize Code Composer and click Project → Import Existing CCS Eclipse Project. Make the settings shown below and click Finish. Make sure that the “Copy projects into workspace” checkbox is unchecked.

![Import CCS Eclipse Projects dialog]

Header Files

2. Delete the current contents of main.c. Add the following lines into main.c to include the header files needed to access the StellarisWare APIs:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/debug.h"
#include "driverlib/sysctl.h"
#include "driverlib/adc.h"
```

`adc.h`: definitions for using the ADC driver
Driver Library Error Routine

3. Run-time parameter checking by the Peripheral Driver Library is fairly cursory since excessive checking would have a negative effect on cycle count. But, during the debug process, you may find that you have called a driver library API with incorrect parameters or a library function generates an error for some other reason. The following code will be called if the driver library encounters such an error. In order for the code to run, DEBUG needs to be added to the pre-defined symbols for the project … we’ll do that later.

Leave a blank line for spacing and add these lines of code after the lines above:

```c
#ifdef DEBUG
void__error__(char *pcFilename, unsigned long ulLine)
{
}
#endif
```

Main()

4. Set up the main() routine by adding the three lines below:

```c
int main(void)
{
}
```

5. The following definition will create an array that will be used for storing the data read from the ADC FIFO. It must be as large as the FIFO for the sequencer in use. We will be using sequencer 1 which has a FIFO depth of 4. If another sequencer was used with a smaller or deeper FIFO, then the array size would have to be changed. For instance, sequencer 0 has a depth of 8.

Add the following line of code as your first line of code inside `main()`:

```c
unsigned long ulADC0Value[4];
```

6. We’ll need some variables for calculating the temperature from the sensor data. The first variable is for storing the average of the temperature. The remaining variables are used to store the temperature values for Celsius and Fahrenheit. All are declared as 'volatile' so that each variable will not be optimized out by the compiler and will be available to the 'Expression' or 'Local' window(s) at run-time. Add these lines after that last line:

```c
volatile unsigned long ulTempAvg;
volatile unsigned long ulTempValueC;
volatile unsigned long ulTempValueF;
```

7. Set up the system clock again to run at 40MHz. Add a line for spacing and add this line after the last ones:

```c
SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_OSC_MAIN|SYSCTL_XTAL_16MHZ);
```
8. Let’s enable the ADC0 module next. Add a line for spacing and add this line after the last one:

```c
SysCtlPeripheralEnable(SYSCTL_PERIPH_ADC0);
```

9. As an example, let’s set the ADC sample rate to 250 kilo-samples per second (since we’re measuring temperature, a slower speed would be fine, but let’s go with this). The `SysCtlADCSpeedSet()` API can also set the sample rate to additional device specific speeds (125KSPS, 500KSPS and 1MSPS).

Add the following line directly after the last one:

```c
SysCtlADCSpeedSet(SYSCTL_ADCSPEED_250KSPS);
```

10. Before we configure the ADC sequencer settings, we should disable ADC sequencer 1. Add this line after the last one:

```c
ADCSequenceDisable(ADC0_BASE, 1);
```

11. Now we can configure the ADC sequencer. We want to use ADC0, sample sequencer 1, we want the processor to trigger the sequence and we want to use the highest priority. Add a line for spacing and add this line of code:

```c
ADCSequenceConfigure(ADC0_BASE, 1, ADC_TRIGGER_PROCESSOR, 0);
```

12. Next we need to configure all four steps in the ADC sequencer. Configure steps 0 - 2 on sequencer 1 to sample the temperature sensor (ADC_CTL_TS). In this example, our code will average all four samples of temperature sensor data on sequencer 1 to calculate the temperature, so all four sequencer steps will measure the temperature sensor. For more information on the ADC sequencers and steps, reference the device specific datasheet. Add the following three lines after the last:

```c
ADCSequenceStepConfigure(ADC0_BASE, 1, 0, ADC_CTL_TS);
ADCSequenceStepConfigure(ADC0_BASE, 1, 1, ADC_CTL_TS);
ADCSequenceStepConfigure(ADC0_BASE, 1, 2, ADC_CTL_TS);
```

13. The final sequencer step requires a couple of extra settings. Sample the temperature sensor (ADC_CTL_TS) and configure the interrupt flag (ADC_CTL_IE) to be set when the sample is done. Tell the ADC logic that this is the last conversion on sequencer 1 (ADC_CTL_END). Add this line directly after the last ones:

```c
ADCSequenceStepConfigure(ADC0_BASE, 1, 3, ADC_CTL_TS | ADC_CTL_IE | ADC_CTL_END);
```

14. Now we can enable the ADC sequencer 1. Add this line directly after the last one:

```c
ADCSequenceEnable(ADC0_BASE, 1);
```
15. Still within `main()`, add a while loop to your code. Add a line for spacing and enter these three lines of code:
```c
while(1)
{

}
```

16. Save your work. As a sanity-check, right-click on `main.c` in the Project pane and select Build Selected File(s). If you are having issues, check the code below:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/debug.h"
#include "driverlib/sysctl.h"
#include "driverlib/adc.h"

#endif

int main(void)
{

    unsigned long ulADC0Value[4];
    volatile unsigned long ulTempAvg;
    volatile unsigned long ulTempValueC;
    volatile unsigned long ulTempValueF;

    SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_OSC_MAIN|SYSCTL_XTAL_16MHZ);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_ADC0);
    SysCtlADCSpeedSet(SYSCTL_ADCSPEED_250KSPS);
    ADCSequenceDisable(ADC0_BASE, 1);
    ADCSequenceConfigure(ADC0_BASE, 1, ADC_TRIGGER_PROCESSOR, 0);
    ADCSequenceStepConfigure(ADC0_BASE, 1, 0, ADC_CTL_TS);
    ADCSequenceStepConfigure(ADC0_BASE, 1, 1, ADC_CTL_TS);
    ADCSequenceStepConfigure(ADC0_BASE, 1, 2, ADC_CTL_TS);
    ADCSequenceStepConfigure(ADC0_BASE, 1, 3, ADC_CTL_TS | ADC_CTL_IE | ADC_CTL_END);
    ADCSequenceEnable(ADC0_BASE, 1);

    while(1)
    {
    
    }
}
```

When you build this code, you may get a warning “`ulADC0Value` was declared but never referenced”. Ignore this warning for now, we’ll add code to use this array later.
Inside the while(1) Loop

Inside the while(1) we’re going to read the value of the temperature sensor and calculate the temperature endlessly.

17. The indication that the ADC conversion is complete will be the ADC interrupt status flag. It’s always good programming practice to make sure that the flag is cleared before writing code that depends on it. Add the following line as your first line of code inside the while(1) loop:

```c
ADCIntClear(ADC0_BASE, 1);
```

18. Then we can trigger the ADC conversion with software. ADC conversions can also be triggered by many other sources. Add the following line after the last:

```c
ADCProcessorTrigger(ADC0_BASE, 1);
```

19. Then we need to wait for the conversion to complete. Obviously, a better way to do this would be to use an interrupt, rather than burn CPU cycles waiting, but that exercise is left for the student. Add a line for spacing and add the following three lines of code:

```c
while(!ADCIntStatus(ADC0_BASE, 1, false))
{
}
```

20. When code execution exits the loop in the previous step, we know that conversion is complete and we can read the ADC value from the ADC Sample Sequencer 1 FIFO. The function we’ll be using copies data from the specified sample sequencer output FIFO to a buffer in memory. The number of samples available in the hardware FIFO are copied into the buffer, which must be large enough to hold that many samples. This will only return the samples that are presently available, which might not be the entire sample sequence if you attempt to access the FIFO before the conversion is complete. Add a line for spacing and add the following line after the last:

```c
ADCSequenceDataGet(ADC0_BASE, 1, ulADC0Value);
```

21. Calculate the average of the temperature sensor data. We’re going to cover floating point operations later, so this math will be fixed-point.

The addition of 2 is for rounding. Since 2/4 = 1/2 = 0.5, 1.5 will be rounded to 2.0 with the addition of 0.5. In the case of 1.0, when 0.5 is added to yield 1.5, this will be rounded back down to 1.0 due to the rules of integer math.

Add this line after the last on a single line:

```c
```
22. Now that we have the averaged reading from the temperature sensor, we can calculate the Celsius value of the temperature. The equation below is shown in section 13.3.6 of the LM4F120H5QR datasheet. Division is performed last to avoid truncation due to integer math rules. A later lab will cover floating point operations.

\[
\text{TEMP} = 147.5 - \left( \frac{75 \times (\text{VREFP} - \text{VREFN}) \times \text{ADCVALUE}}{4096} \right)
\]

We need to multiply everything by 10 to stay within the precision needed. The divide by 10 at the end is needed to get the right answer. VREFP – VREFN is Vdd or 3.3 volts. We’ll multiply it by 10, and then 75 to get 2475.

Enter the following line of code directly after the last:

```
ulTempValueC = (1475 - ((2475 * ulTempAvg)) / 4096)/10;
```

23. Once you have the Celsius temperature, calculating the Fahrenheit temperature is easy. Hold the division until the end to avoid truncation.

The conversion from Celsius to Fahrenheit is \( F = \frac{C \times 9}{5} + 32 \). Adjusting that a little gives: \( F = \frac{(C \times 9) + 160}{5} \)

Enter the following line of code directly after the last:

```
ulTempValueF = ((ulTempValueC * 9) + 160) / 5;
```
24. Save your work and compare it with our code below:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/debug.h"
#include "driverlib/sysctl.h"
#include "driverlib/adc.h"

#ifdef DEBUG
void__error__(char *pcFilename, unsigned long ulLine)
{
}
#endif

int main(void)
{
    unsigned long ulADC0Value[4];
    volatile unsigned long ulTempAvg;
    volatile unsigned long ulTempValueC;
    volatile unsigned long ulTempValueF;

    SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_OSC_MAIN|SYSCTL_XTAL_16MHZ);

    SysCtlPeripheralEnable(SYSCTL_PERIPH_ADC0);
    SysCtlADCSpeedSet(SYSCTL_ADCSPEED_250KSPS);
    ADCSequenceDisable(ADC0_BASE, 1);

    ADCSequenceConfigure(ADC0_BASE, 1, ADC_TRIGGER_PROCESSOR, 0);
    ADCSequenceStepConfigure(ADC0_BASE, 1, 0, ADC_CTL_TS);
    ADCSequenceStepConfigure(ADC0_BASE, 1, 1, ADC_CTL_TS);
    ADCSequenceStepConfigure(ADC0_BASE, 1, 2, ADC_CTL_TS);
    ADCSequenceStepConfigure(ADC0_BASE, 1, 3, ADC_CTL_TS | ADC_CTL_IE | ADC_CTL_END);
    ADCSequenceEnable(ADC0_BASE, 1);

    while(1)
    {
        ADCIntClear(ADC0_BASE, 1);
        ADCProcessorTrigger(ADC0_BASE, 1);

        while(!ADCIntStatus(ADC0_BASE, 1, false))
        {
        }

        ADCSequenceDataGet(ADC0_BASE, 1, ulADC0Value);
        ulTempValueC = (1475 - ((2475 * ulTempAvg)) / 4096)/10;
        ulTempValueF = ((ulTempValueC * 9) + 160) / 5;
    }
}
```

You can also find this code in main1.txt in your project folder.
Add Pre-defined Symbol

25. Right-click on Lab5 in the Project Explorer pane and select Properties. Under Build → ARM Compiler, click the + next to Advanced Options. Then click on Predefined Symbols. In the top Pre-define NAME window, add the symbol DEBUG as shown below and click OK. In future labs, the project will already have this symbol defined.
**Build and Run the Code**

26. Compile and download your application by clicking the Debug button on the menu bar. If you have any issues, correct them, and then click the Debug button again. After a successful build, the CCS Debug perspective will appear.

27. Click on the Expressions tab (upper right). Remove all expressions (if there are any) from the Expressions pane by right-clicking inside the pane and selecting Remove All.

Find the `ulADC0Value`, `ulTempAvg`, `ulTempValueC` and `ulTempValueF` variables in the last four lines of code. Double-click on a variable to highlight it, then right-click on it, select Add Watch Expression and then click OK. Do this for all four variables.
28. We’d like to set the debugger up so that it will update the windows each time the code runs. Since there is no line of code after the calculations, we’ll choose one right before them and display the result of the last calculation.

Click on the first line of code in the while(1) loop;

```c
ADCIntClear(ADC0_BASE, 1);
```

and then right-click on it. Select Breakpoint (Code Composer Studio) then Breakpoint to set a breakpoint on this line.

Right-click on the breakpoint symbol ⬤ and select Breakpoint Properties … Find the line that contains Action and click on the Remain Halted value. That’s the normal way a breakpoint should act, but let’s change it to Update View (look up and down in the list). In the dialog below, note that only the Expressions window will be updated. Now the variables in the Expression window will be updated and the code will continue to execute. Click OK.
29. Click the Resume button ![Resume button icon] to run the program.

You should see the measured value of `u1TempAvg` changing up and down slightly. Changed values from the previous measurement are highlighted in yellow. Use your finger (rub it briskly on your pants), then touch the LM4F120 device on the LaunchPad board to warm it. Press your fingers against a cold drink, then touch the device to cool it. You should quickly see the results on the display.

Bear in mind that the temperature sensor is not calibrated, so the values displayed are not exact. That’s okay in this experiment, since we’re only looking for changes in the measurements.

Note how much `u1TempAvg` is changing (not the rate, the amount). We can reduce the amount by using hardware averaging in the ADC.
Hardware averaging

30. Click the Terminate button to return to the CCS Edit perspective.

Find the ADC initialization section of your code as shown below:

```
23    SysCtlPeripheralEnable(SYSCTL_PERIPH_ADC0);
24    SysCtlADCSpeedSet(SYSCTL_ADCSPEED_250KSPS);
25    ADCSequenceDisable(ADC0_BASE, 1);
```

Right after the SysCtlADCSpeedSet() call, add the following line:

```
ADCHardwareOversampleConfigure(ADC0_BASE, 64);
```

Your code will look like this:

```
23    SysCtlPeripheralEnable(SYSCTL_PERIPH_ADC0);
24    SysCtlADCSpeedSet(SYSCTL_ADCSPEED_250KSPS);
25    ADCHardwareOversampleConfigure(ADC0_BASE, 64);
26    ADCSequenceDisable(ADC0_BASE, 1);
```

The last parameter in the API call is the number of samples to be averaged. This number can be 2, 4, 8, 16, 32 or 64. Our selection means that each sample in the ADC FIFO will be the result of 64 measurements averaged together.

31. Build, download and run the code on your LaunchPad board. Observe the `ulTempAvg` variable in the Expressions window. You should notice that it is changing at a much slower rate than before.
Calling APIs from ROM

32. Before we make any changes, let’s see how large the code section is for our existing project. Click the Terminate button to return to the CCS Edit perspective. In the Project Explorer, expand the Debug folder under the Lab5 project. Double-click on Lab5.map.

33. Code Composer keeps a list of files that have changed since the last build. When you click the build button, CCS compiles and assembles those files into relocatable object files. (You can force CCS to completely rebuild the project by either cleaning the project or rebuilding all). Then, in a multi-pass process, the linker creates the output file (.out) using the device’s memory map as defined in the linker command (.cmd) file. The build process also creates a map file (.map) that explains how large the sections of the program are (.text = code) and where they were placed in the memory map.

In the Lab5.map file, find the SECTION ALLOCATION MAP and look for .text like shown below:

<table>
<thead>
<tr>
<th>output</th>
<th>section</th>
<th>page</th>
<th>origin</th>
<th>length</th>
</tr>
</thead>
<tbody>
<tr>
<td>.intvec</td>
<td>0</td>
<td>00000000</td>
<td>00000026c</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>00000000</td>
<td>00000026c</td>
</tr>
<tr>
<td>.text</td>
<td>0</td>
<td>0000026c</td>
<td>00000690</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0000026c</td>
<td>0000013c</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>000003a8</td>
<td>000000ec</td>
</tr>
</tbody>
</table>

The length of our .text section is 690h. Check yours and write it here: ___________

34. Remember that the M4F on-board ROM contains the Peripheral Driver Library. Rather than adding those library calls to our flash memory, we can call them from ROM. This will reduce the code size of our program in flash memory. In order to do so, we need to add support for the ROM in our code.

In main.c, add the following include statement as the last one in your list of includes at the top of your code:

```c
#include "driverlib/rom.h"
```

35. Open your properties for Lab5 by right-clicking on Lab5 in the Project Explorer pane and clicking Properties. Under Build ➔ ARM Compiler ➔ Advanced Options, click on Predefined Symbols. Add the following symbol to the top window:

**TARGET_IS_BLIZZARD_RA1**

Blizzard is the internal TI product name for the LM4F series. This symbol will give the libraries access to the API’s in ROM. Click OK.
36. Back in main.c, add ROM_ to the beginning of every DriverLib call as shown below:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/debug.h"
#include "driverlib/sysctl.h"
#include "driverlib/adc.h"
#include "driverlib/rom.h"

#ifdef DEBUG
void __error__(char *pcFilename, unsigned long ulLine)
{
}
#endif

int main(void)
{
    unsigned long ulADC0Value[4];
    volatile unsigned long ulTempAvg;
    volatile unsigned long ulTempValueC;
    volatile unsigned long ulTempValueF;
    ROM_SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_OSC_MAIN|SYSCTL_XTAL_16MHZ);
    ROM_SysCtlPeripheralEnable(SYSCTL_PERIPH_ADC0);
    ROM_SysCtlADCSpeedSet(SYSCTL_ADCSPEED_250KSPS);
    ROM_ADCHardwareOversampleConfigure(ADC0_BASE, 64);
    ROM_ADCSequenceDisable(ADC0_BASE, 1);
    ROM_ADCSequenceConfigure(ADC0_BASE, 1, ADC_TRIGGER_PROCESSOR, 0);
    ROM_ADCSequenceStepConfigure(ADC0_BASE, 1, 0, ADC_CTL_TS);
    ROM_ADCSequenceStepConfigure(ADC0_BASE, 1, 1, ADC_CTL_TS);
    ROM_ADCSequenceStepConfigure(ADC0_BASE, 1, 2, ADC_CTL_TS);
    ROM_ADCSequenceStepConfigure(ADC0_BASE, 1, 3, ADC_CTL_TS | ADC_CTL_IE | ADC_CTL_END);
    ROM_ADCSequenceEnable(ADC0_BASE, 1);
    while(1)
    {
        ROM_ADCIntClear(ADC0_BASE, 1);
        ROM_ADCProcessorTrigger(ADC0_BASE, 1);
        while(!ROM_ADCIntStatus(ADC0_BASE, 1, false))
        {
        }
        ROM_ADCSequenceDataGet(ADC0_BASE, 1, ulADC0Value);
        ulTempValueC = (1475 - ((2475 * ulTempAvg)) / 4096)/10;
        ulTempValueF = ((ulTempValueC * 9) + 160) / 5;
    }
}
```

If you’re having issues, this code is saved in your lab folder as main2.txt.
**Build, Download and Run Your Code**

37. Click the Debug button to build and download your code to the LM4F120H5QR flash memory. When the process is complete, click the Resume button to run your code. When you’re sure that everything is working correctly, click the Terminate button to return to the CCS Edit perspective.

38. Check the SECTION ALLOCATION MAP in Lab5.map. Our results are shown below:

```
SECTION ALLOCATION MAP

<table>
<thead>
<tr>
<th>output</th>
<th>section</th>
<th>page</th>
<th>origin</th>
<th>length</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>.intvecs</td>
<td>0</td>
<td>00000000</td>
<td>0000026c</td>
</tr>
<tr>
<td></td>
<td>.text</td>
<td>0</td>
<td>0000026c</td>
<td>00000838</td>
</tr>
</tbody>
</table>
```

The new size for our .text section is 3e8h. That’s 40% smaller than before. Write your results here: ________

39. The method shown in these steps is called “direct ROM calls”. It is also possible to make mapped ROM calls when you are using devices (like the TI ARM Cortex-M3) that may or may not have a ROM. Check out section 32.3 in the Peripheral Driver Library User’s Guide for more information on this technique.

40. When you’re finished, close the Lab5 project and minimize Code Composer Studio.

STOP

You’re done.
Introduction

In this chapter we’ll take a look at the hibernation module and the low power modes of the M4F. The lab will show you how to place the device in sleep mode and you’ll measure the current draw as well.

Agenda

Introduction to ARM® Cortex™-M4F and Peripherals
  Code Composer Studio
  Introduction to StellarisWare, Initialization and GPIO
  Interrupts and the Timers
    ADC12
  **Hibernation Module**
    USB
    Memory
    Floating-Point
    Booster Packs and grLib
    Synchronous Serial Interface
      UART
      μDMA
Chapter Topics

Hibernation Module

Chapter Topics

Low Power Modes

Lab 6: Low Power Modes

Objective

Procedure
Low Power Modes

Key Features

- Real Time Clock is a 32-bit seconds counter with a 15-bit sub seconds counter & add-in trim capability
- Dedicated pin for waking using an external signal
- RTC operational and hibernation memory valid as long as VBAT is valid
- GPIO pins state retention provided during VDD3ON mode
- Two mechanisms for power control
  - System Power Control for CPU and other on-board hardware
  - On-chip Power Control for CPU only
- Low-battery detection, signaling, and interrupt generation, with optional wake on low battery
- 32,768 Hz external crystal or an external oscillator clock source
- 16 32-bit words of battery-backed memory are provided for you to save the processor state to during hibernation
- Programmable interrupts for RTC match, external wake, and low battery events.

Power Modes

- Run mode
- Sleep mode stops the processor clock
  - 2 SysClk wakeup time
- Deep Sleep mode stops the system clock and switches off the PLL and Flash
  - 1.25 – 350 µS wakeup time
- Hibernate mode with only hibernate module powered (VDD3ON, RTC and no RTC)
  - ~500µS wakeup time
## Power Mode Comparison

<table>
<thead>
<tr>
<th>Mode</th>
<th>Run Mode</th>
<th>Sleep Mode</th>
<th>Deep Sleep Mode</th>
<th>Hibernation (VDD3ON)</th>
<th>Hibernation (RTC)</th>
<th>Hibernation (no RTC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter ↓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>( I_{DD} )</td>
<td>32 mA</td>
<td>10 mA</td>
<td>1.05 mA</td>
<td>5 ( \mu )A</td>
<td>1.7 ( \mu )A</td>
<td>1.6 ( \mu )A</td>
</tr>
<tr>
<td>( V_{DD} )</td>
<td>3.3 V</td>
<td>3.3 V</td>
<td>3.3 V</td>
<td>3.3 V</td>
<td>0 V</td>
<td>0 V</td>
</tr>
<tr>
<td>( V_{BAT} )</td>
<td>N.A.</td>
<td>N.A.</td>
<td>N.A.</td>
<td>3 V</td>
<td>3 V</td>
<td>3 V</td>
</tr>
<tr>
<td>System Clock</td>
<td>40 MHz with PLL</td>
<td>30 kHz</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Core</td>
<td>Powered On</td>
<td>Powered On</td>
<td>Powered On</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Peripherals</td>
<td>All On</td>
<td>All Off</td>
<td>All Off</td>
<td>All Off</td>
<td>All Off</td>
<td>All Off</td>
</tr>
<tr>
<td>Code</td>
<td>while(1)</td>
<td>N.A.</td>
<td>N.A.</td>
<td>N.A.</td>
<td>N.A.</td>
<td>N.A.</td>
</tr>
</tbody>
</table>

Box denotes power modes available on LaunchPad board

### LaunchPad Considerations

- The low-cost LaunchPad board does not have a battery holder
- \( V_{DD} \) and \( V_{BAT} \) are wired together on the board (this disables battery-only powered low-power modes)
- Device current is measured between test points H24 and H25
Lab 6: Low Power Modes

Objective

In this lab we’ll use the hibernation module to place the device in a low power state. Then we’ll wake up from both the wake-up pin and the Real-Time Clock (RTC). We’ll also measure the current draw to see the effects of the different power modes.
Procedure

Import Lab6

1. We have already created the Lab6 project for you with an empty `main.c`, a startup file and all necessary project and build options set. Maximize Code Composer and click Project → Import Existing CCS Eclipse Project. Make the settings shown below and click Finish. **Make sure that the “Copy projects into workspace” checkbox is unchecked.**

![Import CCS Eclipse Projects]

Limitations

2. In order to keep the cost of the LaunchPad board ultra-low, the battery holder was omitted. We will be evaluating the following power modes and wake events:

- Run
- Hibernate (VDD3ON)
- Wake from pin (no RTC)
- Wake from RTC


**Header Files**

3. Open main.c for editing and delete the current contents. Type (or copy/paste) the following lines into main.c to include the header files needed to access the StellarisWare APIs:

   ```c
   #include "utils/ustdlib.h"
   #include "inc/hw_types.h"
   #include "inc/hw_memmap.h"
   #include "driverlib/sysctl.h"
   #include "driverlib/pin_map.h"
   #include "driverlib/debug.h"
   #include "driverlib/hibernate.h"
   #include "driverlib/gpio.h"
   #include "driverlib/systick.h"
   ```

**Error Function**

4. Performing error checking on function calls is good programming practice. Skip a line after the previous includes, and add the following code. DEBUG has already been added to the project’s pre-defined symbols.

   ```c
   #ifdef DEBUG
   void__error__(char *pcFilename, unsigned long ulLine)
   {
   }
   #endif
   ```

**Main Function**

5. Skip a line and add this main() template after the error function:

   ```c
   int main(void)
   {
   }
   ```

**Clock Setup**

6. Configure the system clock to 40MHz again. Add this line as the first line of code in main():

   ```c
   SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
   ```
**GPIO Configuration**

7. We’re going to use the green LED (2=red=pin1, 4=blue=pin2 and 8=green=pin3) as an indicator that the device is in hibernation (off for hibernate and on for wake). Add a line for spacing and add these lines of code after the last:

```c
SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
GPIOPinWrite(GPIO_PORTF_BASE,GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x08);
```

**Hibernate Configuration**

8. We want to set the wake condition to the wake pin. Take a look at the board schematics and see how the WAKE pin is connected to user pushbutton 2 (SW2) on the LaunchPad board.

The code below has the following functions:

- Line 1: enable the hibernation module
- Line 2: defines the clock supplied to the hibernation module
- Line 3: Calling this function enables the GPIO pin state to be maintained during hibernation and remain active even when waking from hibernation.
- Line 4: delay 4 seconds for you to observe the LED
- Line 5: set the wake condition to the wake pin
- Line 6: turn off the green LED before the device goes to sleep

Add a line for spacing and add these lines after the last ones in `main()`:

```c
SysCtlPeripheralEnable(SYSCTL_PERIPH_HIBERNATE);
HibernateEnableExpClk(SysCtlClockGet());
HibernateGPIORetentionEnable();
SysCtlDelay(64000000);
HibernateWakeSet(HIBERNATE_WAKE_PIN);
GPIOPinWrite(GPIO_PORTF_BASE,GPIO_PIN_3, 0x00);
```
Finally we need to go into hibernation mode. The HibernateRequest() function requests the Hibernation module to disable the external regulator, removing power from the processor and all peripherals. The Hibernation module remains powered from the battery or auxiliary power supply. If the battery voltage is low (or off) or if interrupts are currently being serviced, the switch to hibernation mode may be delayed. If the battery voltage is not present, the switch will never occur.

The while() loop acts as a trap while any pending peripheral activities shut down (or other conditions exist). Add a line for spacing and add these lines after the last ones in main():

HibernateRequest();
while(1)
{
}

Click the Save button to save your work. Your code should look something like this:

```c
#include "utils/ustdlib.h"
#include "inc/hw_types.h"
#include "inc/hw_memmap.h"
#include "driverlib/sysctl.h"
#include "driverlib/pin_map.h"
#include "driverlib/debug.h"
#include "driverlib/hibernate.h"
#include "driverlib/gpio.h"
#include "driverlib/sysystick.h"

#ifdef DEBUG
void __error__(char *pcFilename, unsigned long ulLine)
{
}
#endif

int main(void)
{
    SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
    GPIOPinWrite(GPIO_PORTF_BASE,GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x08);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_HIBERNATE);
    HibernateEnableExpClk(SysCtlClockGet());
    HibernateGPIORetentionEnable();
    SysCtlDelay(64000000);
    HibernateWakeSet(HIBERNATE_WAKE_PIN);
    GPIOPinWrite(GPIO_PORTF_BASE,GPIO_PIN_3, 0x00);
    HibernateRequest();
    while(1)
    {
    }
}
```

This code is saved in the Lab6/ccs folder as main1.txt. Don’t forget that you can auto-correct the indentations.
Build, Download and Run the VDD3ON (no RTC) Code

10. Compile and download your application by clicking the Debug button on the menu bar. If you have any issues, correct them, and then click the Debug button again. After a successful build, the CCS Debug perspective will appear.

11. Delete the watch expressions by right-clicking in the Expressions pane and clicking Remove All, then click Yes.

Note: Code Composer Studio has some issues connecting to hibernating devices (and reconnecting) since they essentially power off in the middle of the debugging process. We’ll try to step around those issues, but you may see CCS terminate abruptly. If this happens, you can restart CCS and try again, or you can use the LM Flash Programmer to reprogram the device with the qs-rgb (non-hibernation) program. In either case, you need to hold SW2 down to keep the LM4F device awake in order for either tool to connect.

12. We’re going to step around those hibernate/CCS issues now. Press the Terminate button in CCS to return to the editing mode. When you do this the LaunchPad will be issued a reset. Observe the LED on the board and cycle power on the LaunchPad by removing/replacing the USB emulator cable. The green LED should light.

After about 4 seconds the green LED will go out. Press the SW2 button located at the lower right corner of the LaunchPad board. The processor will wake up and start the code again, lighting the green LED.

Note that this wakeup process is the same as powering up. We will not be using the battery-backed memory in this lab, but that feature is essential to applications that need to know how they “woke up”. Your code can save/restore the processor state to that memory. When your code starts, you can determine that the processor woke from sleep and restore the processor state from the battery-backed memory.

13. Now that we know the code is running properly, we can take some current measurements. Before we do, let’s comment out the line of code that lights the green LED so that the LED current won’t be part of our measurement. In main.c, comment out the line of code shown below:

```
22    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
23    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
24    // GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x05);
```

Save your work.

14. Press and hold SW2 on the LaunchPad board (to make sure it is awake), then compile and download your application by clicking the Debug button on the menu bar. Press the Terminate button in CCS to return to the editing mode. Remove the USB emulator cable from the LaunchPad board.
measure the current

15. Remove the jumper located on the LaunchPad board near the DEVICE USB port and put it somewhere for safekeeping.

Connect your Digital Multi-Meter (DMM) test leads to the pins with the positive lead nearest the DEVICE USB port. Double check the lead connections on the meter. Switch the meter to measure DC current around 20mA.

16. Watch the meter display and plug the USB emulator cable into the LaunchPad. During the first four seconds the LM4F device is in Run mode (in the software delay loop). Record this reading in the first row of the chart below.

17. After four seconds the device goes into the VDD3ON hibernate mode. Switch your meter to measure 10μA and record your reading in the second row of the chart below.

18. Remove the USB emulator cable from the LaunchPad board, disconnect your DMM and replace the jumper on the power measurement pins.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Workbook Step</th>
<th>Your Reading</th>
<th>Our Reading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>15</td>
<td>mA</td>
<td>21.4 mA</td>
</tr>
<tr>
<td>VDD3ON (no RTC)</td>
<td>17</td>
<td>μA</td>
<td>6.0 μA</td>
</tr>
<tr>
<td>VDD3ON (RTC)</td>
<td>27</td>
<td>μA</td>
<td>6.3 μA</td>
</tr>
</tbody>
</table>
Wake Up on RTC

19. Plug the USB emulator cable into the LaunchPad board.

20. In main.c, find this line of code: HibernateWakeSet(HIBERNATE_WAKE_PIN);

Right above that line of code, enter the three lines below. These lines configure the RTC
wake-up parameters; reset the RTC to 0, turn the RTC on and set the wake up time for 5
seconds in the future.

HibernateRTCSet(0);
HibernateRTCEnable();
HibernateRTCMatch0Set(5);

21. We also need to change the wake-up parameter from just the wake-up pin to add the
RTC. Find:

HibernateWakeSet(HIBERNATE_WAKE_PIN);

and change it to:

HibernateWakeSet(HIBERNATE_WAKE_PIN | HIBERNATE_WAKE_RTC);

22. Uncomment the line of code that turns on the green LED, as shown below:

```
22    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
23    GPIOPinTypeGPIO0outPut(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
24    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x08);
```

Save your changes.
Your code should look like this:

```c
#include "utils/ustdlib.h"
#include "inc/hw_types.h"
#include "inc/hw_memmap.h"
#include "driverlib/sysctl.h"
#include "driverlib/pin_map.h"
#include "driverlib/debug.h"
#include "driverlib/hibernate.h"
#include "driverlib/gpio.h"
#include "driverlib/systick.h"

#ifdef DEBUG
void __error__(char *pcFilename, unsigned long ulLine)
{
}
#endif

int main(void)
{
    SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
    
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
    GPIOPinWrite(GPIO_PORTF_BASE,GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x08);
    
    SysCtlPeripheralEnable(SYSCTL_PERIPH_HIBERNATE);
    HibernateEnableExpClk(SysCtlClockGet());
    HibernateGPIORetentionEnable();
    SysCtlDelay(64000000);
    HibernateRTCSet(0);
    HibernateRTCEnable();
    HibernateRTCMatch0Set(5);
    HibernateWakeSet(HIBERNATE_WAKE_PIN | HIBERNATE_WAKE_RTC);
    GPIOPinWrite(GPIO_PORTF_BASE,GPIO_PIN_3, 0x00);
    
    HibernateRequest();
    while(1)
    {
    }
}
```

If you’re having problems, this code is saved as main2.txt in your Lab6/ccs folder.
23. Press and hold the SW2 button on your evaluation board to assure the LM4F120 is awake. Compile and download your application by clicking the Debug button on the menu bar.

CCS can’t talk to the device while it’s asleep. If you accidentally do this, you’ll see the following when CCS attempts to communicate:

![Error connecting to the target](image)

If this happens, press and hold the SW2 button and click Retry. Release the SW2 button when the debug controls appear in CCS.

24. Press the Terminate button in CCS to return to the editing mode. When the Debugger terminated, it reset the LM4F120. You should see the green LED turning on for 4 seconds, then off for about 5 seconds. The real-time-clock (RTC) is waking the device up from hibernate mode after 5 seconds. Also note that you can wake the device with SW2 at any time.

25. Disconnect your LaunchPad board from the USB emulator cable.

26. Remove the jumper located on the LaunchPad board near the DEVICE USB port and put it somewhere for safekeeping.

   Connect your DMM test leads to the pins with the positive lead nearest the DEVICE USB port. Double check the lead connections on the DMM itself. Switch the DMM to measure DC current around 20mA.

27. Plug the USB emulator cable into your LaunchPad board. When the green LED goes off, quickly switch the DMM to measure 10uA and record your reading in the last row of the chart in step 18. The equivalent series resistance on most DMMs will be too high in the low current mode to allow the device to go back to run mode.

28. Remove the USB emulator cable from the LaunchPad board, disconnect and turn off your DMM, then replace the jumper on the power measurement pins.
29. To make things easier for the next lab, use the LM Flash Programmer to program the `qs-rgb` bin file into the device (as shown in lab 2). Don’t forget to hold SW2 down while this process completes.

30. Close the Lab6 project and minimize Code Composer Studio.

31. **Homework Idea:** Experiment with the RTC to create a time-of-day clock at the lowest possible power.

![STOP]

You’re done.
Introduction

This chapter will introduce you to the basics of USB and the implementation of a USB port on Stellaris devices. In the lab you will experiment with sending data back and forth across a bulk transfer-mode USB connection.

Agenda

Introduction to ARM® Cortex™-M4F and Peripherals
Code Composer Studio
Introduction to StellarisWare, Initialization and GPIO
Interrupts and the Timers
ADC12
Hibernation Module
USB
Memory
Floating-Point
Booster Packs and grLib
Synchronous Serial Interface
UART
μDMA
USB Basics

Multiple connector sizes
4 pins – power, ground and 2 data lines
(5th pin ID for USB 2.0 connectors)

Configuration connects power 1st, then data

Standards:

- **USB 1.1**
  - Defines Host (master) and Device (slave)
  - Speeds to 12Mbits/sec
  - Devices can consume 500mA (100mA for startup)
- **USB 2.0**
  - Speeds to 480Mbits/sec
  - OTG addendum
- **USB 3.0**
  - Speeds to 4.8Gbits/sec
  - New connector(s)
  - Separate transmit/receive data lines

USB Device … most USB products are slaves
USB Host … usually a PC, but can be embedded
USB OTG … On-The-Go
  - Dynamic switching between host and device roles
  - Two connected OTG ports undergo host negotiation

Host polls each Device at power up. Information from Device includes:

- Device Descriptor (Manufacturer & Product ID so Host can find driver)
- Configuration Descriptor (Power consumption and Interface descriptors)
- Endpoint Descriptors (Transfer type, speed, etc)
- Process is called Enumeration … allows Plug-and-Play
**LM4F120H5QR USB**

- USB 2.0 Device mode full speed (12 Mbps) and low speed (1.5 Mbps) operation
- Integrated PHY
- Transfer types: Control, Interrupt, Bulk and Isochronous
- Device Firmware Update (DFU) device in ROM

**Stellaris collaterals**
- Texas Instruments is a member of the USB Implementers Forum.
- Stellaris is approved to use the USB logo
- Vendor/Product ID sharing

FREE Vendor ID/ Product ID sharing program

USB Hardware and Library

USB Peripheral Block Diagram

- Integrated USB Controller and PHY with up to 16 Endpoints
  - 1 dedicated control IN endpoint and 1 dedicated control OUT endpoint
  - Up to 7 configurable IN endpoints and 7 configurable OUT endpoints
  - 4 KB dedicated endpoint memory (not part of device SRAM)
  - Separate DMA channels (up to three IN Endpoints and three OUT Endpoints)
  - 1 endpoint may be defined for double-buffered 1023-bytes isochronous packet size

StellarisWare USBLib

- License-free & royalty-free drivers, stack and example applications for Stellaris MCUs
- USBLib supports Host/Device and OTG, but the LM4F120H5QR USB port is Device only
- Builds on DriverLib API
  - Adds framework for generic Host and Device functionality
  - Includes implementations of common USB classes
- Layered structure
- Drivers and .inf files included where appropriate
- Stellaris MCUs have passed USB Device and Embedded Host compliance testing

Device Examples
- HID Keyboard
- HID Mouse
- CDC Serial
- Mass Storage
- Audio
- Generic Bulk
- Device Firmware Upgrade
- Oscilloscope

Windows INF for supported devices
- Points to base Windows drivers
- Sets config string
- Sets PID/VID
- Precompiled DLL saves development time

Device framework integrated into USBLib

Certified USB

Abstraction Levels...
USB API Abstraction Levels

<table>
<thead>
<tr>
<th>Application 1</th>
<th>Application 2</th>
<th>Application 3</th>
<th>Application 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passes simplified data to a higher level API. (Custom HID mouse)</td>
<td>Passes key info to the Driver API. Driver API handles all lower level functions for the chosen class. (Custom HID device)</td>
<td>Uses existing API for generic host/device operation. Uses DriverLib for features not covered by these APIs. (Custom Classes)</td>
<td>Implements its own USB protocol using DriverLib. (Third party USB stack)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Level of customization</th>
<th>Level of abstraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOW</td>
<td>LOW</td>
</tr>
<tr>
<td>HIGH</td>
<td>HIGH</td>
</tr>
</tbody>
</table>

USB Host Controller API/USB Device API

Host Class/Device Class APIs

Host Class Driver/Device Class Driver APIs

USB DriverLib API
Lab 7: USB

Objective

In this lab you will experiment with sending data back and forth across a bulk transfer-mode USB connection.

- Run usb_bulk_example code and windows side app
- Inspect stack setup
- Observe data on device
Procedure

Example Code

1. There are four types of transfer/endpoint types in the USB specification: Control transfers (for command and status operations), Interrupt transfers (to quickly get the attention of the host), Isochronous transfers (continuous and periodic transfers of data) and Bulk transfers (to transfer large, bursty data).

Before we start poking around in the code, let’s take the usb_bulk_example for a test drive. We’ll be using a Windows host command line application to transfer strings over the USB connection to the LaunchPad board. The program there will change upper-case to lower-case and vice-versa, then transfer the data back to the host.

Import The Project

2. The usb_bulk_example project is one of the StellarisWare examples. When you import the project, note that it will be automatically copied into your workspace, preserving the original files. If you want to access your project files through Windows Explorer, the files you are working on are in your workspace, not StellarisWare. If you delete the project in CCS, the imported project will still be in your workspace unless you tell the dialog to delete the files from the disk.

Click Project → Import Existing CCS Eclipse Project. Make the settings shown below and click Finish.
Lab 7: USB

Build, Download and Run The Code

3. Make sure your evaluation board’s USB DEBUG port is connected to your PC. Build and download your application by clicking the Debug button on the menu bar (make sure your device is awake if you still have hibernate code programmed in the flash).

4. Click the Terminate button, and when CCS returns to the CCS Edit perspective, unplug the USB cable from the LaunchPad’s DEBUG port. Move the PWR SELECT switch on the board to the DEVICE position (nearest the outside of the board). Plug your USB cable into the USB DEVICE connector on the side of the LaunchPad board. The green LED in the emulator section of the LaunchPad should be lit, verifying that the board is powered.

5. In a few moments, your computer will detect that a generic bulk device has been plugged into the USB port. Similar to the driver installation process in module 1, install the driver for this device from C:\StellarisWare\windows_drivers. In your Windows Device Manager, you should verify that the Stellaris Bulk Device is correctly installed.

6. Make sure that you installed the StellarisWare Windows-side USB examples from www.ti.com/sw-usb-win as shown in module one. In Windows, click Start → All Programs → Texas Instruments → Stellaris → USB Examples → USB Bulk Example. The window below should appear:
7. Type something in the window and press Enter. For instance “TI” as shown below:

![USB Bulk Example](image)

The host application will send the two bytes representing TI over the USB port to the LaunchPad board. The code there will change uppercase to lowercase and echo the transmission. Then the host application will display the returned string. Feel free to experiment. Now that we’re assured that our data is traveling across the DEVICE USB port, we can look into the code more.

**Digging a Little Deeper**

8. Type EXIT to terminate the USB Bulk Example program on your laptop.

Connect your other USB cable from your PC to the DEBUG USB port the on the LaunchPad and move the PWR SELECT switch on the board to the DEBUG position. The green LED in the emulator section of the LaunchPad should be lit, verifying that the board is powered. You should now have both ports connected to your PC.

9. In CCS, if `usb_dev_bulk.c` is not open, expand the `usb_dev_bulk` project in the Project Explorer pane and double-click on `usb_dev_bulk.c`.

10. The program is made up of five sections:

    - **SysTickIntHandler** – an ISR that handles interrupts from the SysTick timer to keep track of “time”.

    - **EchoNewDataToHost** – a routine that takes the received data from a buffer, flips the case and sends it to the USB port for transmission.

    - **TxHandler** – an ISR that will report when the USB transmit process is complete.

    - **RxHandler** – an ISR that handles the interaction with the incoming data, then calls the **EchoNewDataHost** routine.

    - **main()** – primarily initialization, but a while loop keeps an eye on the number of bytes transferred

11. Note the **UARTprintf()** APIs sprinkled throughout the code. This technique “instruments” the code, allowing us to monitor its status.
Watching the Instrumentation

12. As shown earlier in module 1, start your terminal program and connect it to the Stellaris Virtual Serial Port. Arrange the terminal window so that it takes up no more than a quarter of your screen. Position it in the upper left of your screen.

13. Resize CCS so that it takes up the lower half of your screen. Click the Debug button to build and download the code and reconnect to your LaunchPad. Run the code by clicking the Resume button.

14. Start the USB Bulk Example Windows application as shown in step 6. Place the window in the upper right corner of your screen. This would all be so much easier with multiple screens, wouldn’t it?

15. Note the status on your terminal display and type something, like TEXAS INSTRUMENTS into the USB Bulk Example Windows application and press Enter. Note that the terminal program will display

![Terminal Display](image1)

![USB Bulk Example](image2)
Lab 7: USB

16. Click the Suspend button in CCS to halt the program.

As a summary, we’re sending bulk data across the DEVICE USB connection. At the same time we are performing emulation control and sending UART serial data across the DEBUG USB connection.

If you get things out of sync here and find that the USB Bulk Example won’t run, remember that it must be started after the code on the LaunchPad is running.

Watch the Buffers

17. Remove all expressions (if there are any) from the Expressions pane by right-clicking inside the pane and selecting Remove All.

18. At about line 503 in the code, find the following:

```c
503  USBBufferInit((tUSBBuffer *)&g_sTxBuffer);
504  USBBufferInit((tUSBBuffer *)&g_sRxBuffer);
```

One at the time, highlight `g_sTxBuffer` and `g_sRxBuffer` and add them as watch expressions by right-clicking on them, selecting Add Watch Expression … and then OK (by the way, we could have watched the buffers in the Memory Browser, but this method is more elegant).
19. Expand both buffers as shown below:

![Memory Addresses and Buffers](image)

The arrows above point out the memory addresses of the buffers as well as the contents. Note that the Expressions window only shows the first 10 bytes in the buffer.

The LM4F120H5QR code uses both buffers as “circular” buffers … rather than clearing out the buffer each time data is received, the code appends the new data after the previous data in the buffer. When the end of the buffer is reached, the code starts again from the beginning. You can use the Memory Browser to view the rest of the buffers, if you like.

20. Resize the code window in the Debug Perspective so you can see a few lines of code. Around line 331 in `usb_dev_bulk.c`, find the line containing `if(ulEvent`. This is the first line in the `TxHandler` ISR. At this point the buffers hold the last received and transmitted values. Double-click in the gray area to the left on the line number to set a breakpoint. Resize the windows again so you can see the entire Expressions pane.

```
331 if(ulEvent == USB_EVENT_TX_COMPLETE)
```

Right-click on the breakpoint and select Breakpoint Properties … Click on the Action property value Remain Halted and change it to Update View. Click OK.

21. Click the Core Reset button to reset the LM4F120H5QR. Make sure your buffers are expanded in the Expressions pane and click the Resume button to run the code. The previous contents of the buffers shown in the Expressions pane will be erased when the code runs for the first time.
22. Restart your USB Bulk example Windows application so that it can reconnect with our device.

23. Since the Expressions view will only display 10 characters, type something short into the USB Bulk Example window like “TI”.

24. When the code reaches the breakpoint, the Expressions pane will update with the contents of the buffer. Try typing “IS” and “AWESOME”. Notice that the “E” is the 11th character and will not be displayed in the Expressions pane.

25. When you are done, close the USB Bulk Example and Terminal program windows. Click the Terminate button in CCS to return to the CCS Edit perspective. Close the *usb_dev_bulk* project in the Project Explorer pane. Minimize Code Composer Studio.

26. Disconnect and store the USB cable connected to the DEVICE USB port.

You’re done.
Introduction

In this chapter we will take a look at some memory issues:

- How to write to FLASH in-system.
- How to read/write from EEPROM.
- How to use bit-banding.
- How to configure the Memory Protection Unit (MPU) and deal with faults.

Agenda

Introduction to ARM® Cortex™-M4F and Peripherals
  Code Composer Studio
  Introduction to StellarisWare, Initialization and GPIO
  Interrupts and the Timers
  ADC12
  Hibernation Module
  USB
  Memory
  Floating-Point
  Booster Packs and grLib
  Synchronous Serial Interface
  UART
  μDMA
Chapter Topics

Memory .......................................................................................................................................................8-1

Chapter Topics........................................................................................................................................8-2
Internal Memory.....................................................................................................................................8-3
Flash .......................................................................................................................................................8-4
EEPROM ..................................................................................................................................................8-5
SRAM .....................................................................................................................................................8-6
Bit-Banding ............................................................................................................................................8-7
Memory Protection Unit ..........................................................................................................................8-8
Priority Levels.......................................................................................................................................8-9

Lab 8: Memory and the MPU ................................................................................................................8-10
Objective.................................................................................................................................................8-10
Procedure...............................................................................................................................................8-11
Internal Memory

Flash, SRAM and ROM Control

EEPROM Control

Memory Blocks and Control Logic for:

- SRAM
- ROM
- Flash

EEPROM Block and Control Logic

EEPROM block is connected to the AHB (Advanced High Performance Bus)
Flash

- 256KB / 40MHz starting at 0x00000000
- Organized in 1KB independently erasable blocks
- Code fetches and data access occur over separate buses
- Below 40MHz, Flash access is single cycle
- Above 40MHz, the prefetch buffer fetches two 32-bit words/cycle. No wait states for sequential code.
- Branch speculation avoids wait state on some branches
- Programmable write and execution protection available
- Simple programming interface

0x00000000 Flash
0x01000000 ROM
0x20000000 SRAM
0x22000000 Bit-banded SRAM
0x40000000 Peripherals & EEPROM
0x42000000 Bit-banded Peripherals
0xE0000000 Instrumentation, ETM, etc.
EEPROM

- 2KB of memory starting at 0x400AF000 in Peripheral space
- Accessible as 512 32-bit words
- 32 blocks of 16 words (64 bytes) with access protection per block
- Built-in wear leveling with endurance of 500K writes
- Lock protection option for the whole peripheral as well as per block using 32-bit to 96-bit codes
- Interrupt support for write completion to avoid polling
- Random and sequential read/write access (4 cycles max/word)
SRAM

- 32KB / 80MHz starting at 0x20000000
- Bit banded to 0x22000000
- Can hold code or data

<table>
<thead>
<tr>
<th>Address</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00000000</td>
<td>Flash</td>
</tr>
<tr>
<td>0x01000000</td>
<td>ROM</td>
</tr>
<tr>
<td>0x20000000</td>
<td>SRAM</td>
</tr>
<tr>
<td>0x22000000</td>
<td>Bit-banded SRAM</td>
</tr>
<tr>
<td>0x40000000</td>
<td>Peripherals &amp; EEPROM</td>
</tr>
<tr>
<td>0x42000000</td>
<td>Bit-banded Peripherals</td>
</tr>
<tr>
<td>0xE0000000</td>
<td>Instrumentation, ETM, etc.</td>
</tr>
</tbody>
</table>

Bit-Banding...
Bit-Banding

- Reduces the number of read-modify-write operations
- SRAM and Peripheral space use address aliases to access individual bits in a single, atomic operation
- SRAM starts at base address 0x20000000
  Bit-banded SRAM starts at base address 0x22000000
- Peripheral space starts at base address 0x40000000
  Bit-banded peripheral space starts at base address 0x42000000

The bit-band alias is calculated by using the formula:

\[
\text{bit-band alias} = \text{bit-band base} + (\text{byte offset} \times 0x20) + (\text{bit number} \times 4)
\]

For example, bit-7 at address 0x20002000 is:

\[
0x20002000 + (0x2000 \times 0x20) + (7 \times 4) = 0x2204001C
\]
**Memory Protection Unit**

<table>
<thead>
<tr>
<th>Memory Protection Unit (MPU)</th>
</tr>
</thead>
<tbody>
<tr>
<td>◆ Defines 8 separate memory regions plus a background region accessible only from privileged mode</td>
</tr>
<tr>
<td>◆ Regions of 256 bytes or more are divided into 8 equal-sized sub-regions</td>
</tr>
<tr>
<td>◆ MPU definitions for all regions include:</td>
</tr>
<tr>
<td>• Location</td>
</tr>
<tr>
<td>• Size</td>
</tr>
<tr>
<td>• Access permissions</td>
</tr>
<tr>
<td>• Memory attributes</td>
</tr>
<tr>
<td>◆ Accessing a prohibited region causes a memory management fault</td>
</tr>
</tbody>
</table>

Privilege Levels...
Priority Levels

Cortex M4 Privilege Levels

- Privilege levels offer additional protection for software, particularly operating systems

- **Unprivileged**: software has …
  - Limited access to the Priority Mask register
  - No access to the system timer, NVIC, or system control block
  - Possibly restricted access to memory or peripherals (FPU, MPU, etc)

- **Privileged**: software has …
  - Use of all the instructions and has access to all resources

- ISRs operate in privileged mode
- Thread code operates in unprivileged mode unless the level is changed via the Thread Mode Privilege Level (TMPL) bit in the CONTROL register
Lab 8: Memory and the MPU

Objective

In this lab you will

- write to FLASH in-system.
- read/write EEPROM.
- Experiment with using the MPU
- Experiment with bit-banding
Procedure

**Import Lab8**

1. We have already created the Lab8 project for you with an empty `main.c`, a startup file and all necessary project and build options set. Maximize Code Composer and click Project → Import Existing CCS Eclipse Project. Make the settings shown below and click Finish. Make sure that the “Copy projects into workspace” checkbox is unchecked.

![Import CCS Eclipse Projects](image)

2. Expand the project by clicking the + or ▼ next to Lab8 in the Project Explorer pane. Double-click on `main.c` to open it for editing.
3. Let’s start out with a straightforward set of starter code. Copy the code below and paste it into your empty main.c file.

```c
#include "inc/hw_types.h"
#include "inc/hw_memmap.h"
#include "driverlib/sysctl.h"
#include "driverlib/pin_map.h"
#include "driverlib/debug.h"
#include "driverlib/gpio.h"

int main(void)
{
    SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x00);
    SysCtlDelay(20000000);
    while(1)
    {
    }
}
```

You should already know what this code does, but a quick review won’t hurt. The included header files support all the usual stuff including GPIO. Inside main(), we set the clock for 40MHz, set the pins connected to the LEDs as outputs and then make sure all three LEDs are off. Next is a two second (approximately) delay followed by a while(1) trap.

Save your work.

If you’re having problems, this code is in your Lab8/ccs folder as main1.txt.

**Writing to Flash**

4. We need to find a writable block of flash memory. Right now, that would be flash memory that doesn’t currently hold the program we want to execute. Under Project on the menu bar, click Build All. This will build the project without attempting to download it to the LM4F120H5QR memory.

5. As we’ve seen before, CCS creates a map file of the program during the build process. Look in the Debug folder of Lab8 in the Project Explorer pane and double-click on Lab8.map to open it.
6. Find the MEMORY CONFIGURATION and SEGMENT ALLOCATION MAP sections as shown below:

<table>
<thead>
<tr>
<th>MEMORY CONFIGURATION</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>origin</td>
<td>length</td>
<td>used</td>
<td>unused</td>
<td>attr</td>
<td>fill</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>----------</td>
<td>--------</td>
<td>------</td>
</tr>
<tr>
<td>FLASH</td>
<td>00000000</td>
<td>00004000</td>
<td>0000086a</td>
<td>00003f796</td>
<td>R X</td>
<td></td>
</tr>
<tr>
<td>SRAM</td>
<td>20000000</td>
<td>00005000</td>
<td>00000114</td>
<td>00007eac</td>
<td>R W X</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SEGMENT ALLOCATION MAP</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>run origin</td>
<td>load origin</td>
<td>length</td>
<td>init length</td>
<td>attr</td>
<td>members</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>---------</td>
<td>--------------</td>
<td>------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>00000000</td>
<td>00000000</td>
<td>00000870</td>
<td>00000000</td>
<td>r-x</td>
<td>.text</td>
<td></td>
</tr>
<tr>
<td>0000026c</td>
<td>00000000</td>
<td>0000026c</td>
<td>0000026c</td>
<td>r-x</td>
<td>.text</td>
<td></td>
</tr>
<tr>
<td>0000080c</td>
<td>0000080c</td>
<td>00000040</td>
<td>00000040</td>
<td>r-x</td>
<td>.const</td>
<td></td>
</tr>
<tr>
<td>00000850</td>
<td>00000850</td>
<td>00000020</td>
<td>00000020</td>
<td>r-x</td>
<td>.data</td>
<td></td>
</tr>
<tr>
<td>20000000</td>
<td>20000000</td>
<td>00000100</td>
<td>00000000</td>
<td>r-x</td>
<td>.data</td>
<td></td>
</tr>
<tr>
<td>20000000</td>
<td>20000000</td>
<td>00000100</td>
<td>00000000</td>
<td>r-x</td>
<td>.data</td>
<td></td>
</tr>
<tr>
<td>20000100</td>
<td>20000100</td>
<td>00000014</td>
<td>00000014</td>
<td>r-x</td>
<td>.data</td>
<td></td>
</tr>
<tr>
<td>20000100</td>
<td>20000100</td>
<td>00000014</td>
<td>00000014</td>
<td>r-x</td>
<td>.data</td>
<td></td>
</tr>
</tbody>
</table>

From the map file we can see that the amount of flash memory used is 0x086A in length that starts at 0x0. That means that pretty much anywhere in flash located at an address greater than 0x1000 (for this program) is writable. Let’s play it safe and pick the block starting at 0x10000. Remember that flash memory is erasable in 1K blocks. Close Lab8.map.

7. Back in main.c, add the following include to the end of the include statement to add support for flash APIs:

```
#include "driverlib/flash.h"
```

8. At the top of main(), enter the following four lines to add buffers for read and write data and to initialize the write data:

```c
unsigned long pulData[2];
unsigned long pulRead[2];
pulData[0] = 0x12345678;
pulData[1] = 0x56789abc;
```
9. Just above the while(1) loop at the end of main(), add these four lines of code:

```c
FlashErase(0x10000);
FlashProgram(pulData, 0x10000, sizeof(pulData));
GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x02);
SysCtlDelay(20000000);
```

Line:
1: Erases the block of flash we identified earlier.
2: Programs the data array we created, to the start of the block, of the length of the array.
3: Lights the red LED to indicate success.
4: Delays about two seconds before the program traps in the while(1) loop.

10. Your code should look like the code below. If you’re having issues, this code is located in the Lab8/ccs folder as main2.txt.

```c
#include "inc/hw_types.h"
#include "inc/hw_memmap.h"
#include "driverlib/sysctl.h"
#include "driverlib/pin_map.h"
#include "driverlib/debug.h"
#include "driverlib/gpio.h"
#include "driverlib/flash.h"

int main(void)
{
    unsigned long pulData[2];
    unsigned long pulRead[2];
    pulData[0] = 0x12345678;
    pulData[1] = 0x56789abc;
    SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x00);
    SysCtlDelay(20000000);
    FlashErase(0x10000);
    FlashProgram(pulData, 0x10000, sizeof(pulData));
    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x02);
    SysCtlDelay(20000000);
    while(1)
    {
    }
}
```
Build, Download and Run the Flash Programming Code

11. Click the Debug button to build and download your program to the LM4F120H5QR memory. Ignore the warning about variable `pulRead` not being referenced. When the process is complete, set a breakpoint on the line containing the `FlashProgram()` API function call.

12. Click the Resume button to run the code. Execution will quickly stop at the breakpoint. On the CCS menu bar, click View → Memory Browser. In the provided entry window, enter `0x10000` as shown below and click Go:

![Memory Browser Image]

Erased flash should read as all ones. Programming flash only programs zeros. Because of this, writing to un-erased flash memory will produce unpredictable results.

13. Click the Resume button to run the code. The last line of code before the `while(1)` loop will light the red LED. Click the Suspend button. Your Memory Browser will update, displaying your successful write to flash memory.
14. Remove your breakpoint.

15. Make sure you have clicked the Terminate button to stop debugging and return to the CCS Edit perspective. Bear in mind that if you repeat this exercise, the values you just programmed in flash will remain there until that flash block is erased.

**Reading and Writing EEPROM**

16. Back in `main.c`, add the following line to the end of the include statements to add support for EEPROM APIs:

   ```c
   #include "driverlib/eeprom.h"
   ```

17. Just above the while(1) loop, enter the following seven lines of code:

   ```c
   SysCtlPeripheralEnable(SYSCTL_PERIPH_EEPROM0);
   EEPROMInit();
   EEPROMMassErase();
   EEPROMRead(pulRead, 0x0, sizeof(pulRead));
   EEPROMProgram(pulData, 0x0, sizeof(pulData));
   EEPROMRead(pulRead, 0x0, sizeof(pulRead));
   GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x04);
   ```

   Line:
   1: Turns on the EEPROM peripheral.
   2: Performs a recovery if power failed during a previous write operation.
   3: Erases the entire EEPROM. This isn’t strictly necessary because, unlike flash, EEPROM does not need to be erased before it is programmed. But this will allow us to see the result of our programming more easily in the lab.
   4: Reads the erased values into pulRead (offset address)
   5: Programs the data array, to the beginning of EEPROM, of the length of the array.
   6: Reads that data into array pulRead.
   7: Turns off the red LED and turns on the blue LED.
18. Your code should look like the code below. If you’re having issues, this code is located in the Lab8/ccs folder as main3.txt.

```c
#include "inc/hw_types.h"
#include "inc/hw_memmap.h"
#include "driverlib/sysctl.h"
#include "driverlib/pin_map.h"
#include "driverlib/debug.h"
#include "driverlib/gpio.h"
#include "driverlib/flash.h"
#include "driverlib/eeprom.h"

int main(void)
{
    unsigned long pulData[2];
    unsigned long pulRead[2];
    pulData[0] = 0x12345678;
    pulData[1] = 0x56789abc;
    SysCtlClockSet(SYSCTL_SYSDIV_5|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
    GPIOPinWrite(GPIO_PORTF_BASE,GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x00);
    SysCtlDelay(20000000);
    FlashErase(0x10000);
    FlashProgram(pulData, 0x10000, sizeof(pulData));
    GPIOPinWrite(GPIO_PORTF_BASE,GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x02);
    SysCtlDelay(20000000);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_EEPROM0);
    EEPROMInit();
    EEPROMMassErase();
    EEPROMRead(pulRead, 0x0, sizeof(pulRead));
    EEPROMProgram(pulData, 0x0, sizeof(pulData));
    EEPROMRead(pulRead, 0x0, sizeof(pulRead));
    GPIOPinWrite(GPIO_PORTF_BASE,GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x04);
    while(1)
    {
    }
}
```
**Build, Download and Run the Flash Programming Code**

19. Click the Debug button to build and download your program to the LM4F120H5QR memory. Code Composer does not currently have a browser for viewing EEPROM memory located in the peripheral area. The code we’ve written will let us read the values and display them as array values.

20. Click on the Variables tab and expand both of the arrays by clicking the + next to them. Right-click on the first variable’s row and select Number Format ➔ Hex. Do this for all four variables.

21. Set a breakpoint on the line containing `EEPROMProgram()`. We want to verify the previous contents of the EEPROM. Click the Resume button to run to the breakpoint.

22. Since we included the `EEPROMMassErase()` in the code, the values read from memory should be all Fs as shown below:

23. Click the Resume button to run the code from the breakpoint. When the blue LED on the board lights, click the Suspend button. The values read from memory should now be the same as those in the write array:
Further EEPROM Information

24. EEPROM is unlocked at power-up. Your locking scheme, if you choose to use one, can be simple or complex. You can lock the entire EEPROM or individual blocks. You can enable reading without a password and writing with one if you desire. You can also hide blocks of EEPROM, making them invisible to further accesses.

25. EEPROM reads and writes are multi-cycle instructions. The ones used in the lab code are “blocking calls”, meaning that program execution will stall until the operation is complete. There are also “non-blocking” calls that do not stall program execution. When using those calls you should either poll the EEPROM or enable an interrupt scheme to assure the operation completes properly.

26. Remove your breakpoint, click Terminate to return to the CCS Edit perspective and close the Lab8 project.
Bit-Banding

27. The LaunchPad board Stellaris examples include a bit-banding project. Click Project → Import Existing CCS Eclipse Project. Make the settings shown below and click Finish.

28. Expand the project in the Project Explorer pane and double-click on bitband.c to open it for viewing. Page down until you reach main(). You should recognize most of the setup code, but note that the UART is also set up. We’ll be able to watch the code run via UARTprintf() statements that will send data to a terminal program running on your laptop. Also note that this example uses ROM API function calls.
29. Continue paging down until you find the `#for(ulIdx=0;ulIdx<32;ulIdx++)` loop. This 32-step loop will write 0xdecafbad into memory bit by bit using bit-banding. This will be done using the `HWREGBITW()` macro.

Right-click on `HWREGBITW()` and select Open Declaration.

The `HWREGBITW(x, b)` macro is an alias from:

```
HWREG(((unsigned long)(x) & 0xF0000000) | 0x02000000 |
((unsigned long)(x) & 0x000FFFFF) << 5) | ((b) << 2))
```

which is C code for:

```
bit-band alias = bit-band base + (byte offset * 0x20) + (bit number * 4)
```

This is the calculation for the bit-banded address of bit b of location x. HWREG is a macro that programs a hardware register (or memory location) with a value.

The loop in `bitband.c` reads the bits from 0xdecafbad and programs them into the calculated bit-band addresses of g_ulValue. Throughout the loop the program transfers the value in g_ulValue to the UART for viewing on the host. Once all bits have been written to g_ulValue, the variable is read directly (all 32 bits) to make sure the value is 0xdecafbad. There is another loop that reads the bits individually to make sure that they can be read back using bit-banding.

30. Click the Debug button to build and download the program to the LM4F120H5QR.

31. If you are using **Windows 7**, skip to step 32. In **WinXP**, open HyperTerminal by clicking Start → Run..., then type `hypertrm` in the Open: box and click OK. Pick any name you like for your connection and click OK. In the next dialog box, change the Connect using: selection to COM##, where ## is the COM port number you noted in Lab1. Click OK. Make the selections shown below and click OK.

Skip to step 33.
32. In **Win7**, double-click on `putty.exe`. Make the settings shown below and then click Open. Your COM port number will be the one you noted in Lab1.

![PuTTY Configuration](image)

33. Click the Resume button in CCS and watch the bits drop into place in your terminal window. The `Delay()` in the loop causes this to take about 30 seconds.

34. Close your terminal window. Click Terminate in CCS to return to the CCS Edit perspective and close the `bitband` project.
Memory Protection Unit (MPU)

35. The LaunchPad board Stellaris examples include an mpu_fault project. Click Project → Import Existing CCS Eclipse Project. Make the settings shown below and click Finish. Note that this project is automatically copied into your workspace.

36. Expand the project and double-click on mpu_fault.c for viewing.

Again, things should look pretty normal in the setup, so let’s look at where things are different.

Find the function called MPUFaultHandler. This exception handler looks just like an ISR. The main purpose of this code is to preserve the address of the problem that caused the fault, as well as the status register.

Open startup_ccs.c and find where MPUFaultHandler has been placed in the vector table. Close startup_ccs.c.
37. In `mpu_fault.c`, find `main()`. Using the memory map shown, the
`MPURegionSet()` calls will configure 6 different regions and parameters for the MPU.
The code following the final `MPURegionSet()` call triggers (or doesn’t trigger) the
fault conditions. Status messages are sent to the UART for display on the host.

`MPURegionSet()` uses the following parameters:

- Region number to set up
- Address of the region (as aligned by the flags)
- Flags

Flags are a set of parameters (OR’d together) that determine the attributes of the region
(size | execute permission | read/write permission | sub-region disable | enable/disable)

The size flag determines the size of a region and must be one of the following:

<table>
<thead>
<tr>
<th>Size</th>
<th>Size</th>
<th>Size</th>
<th>Size</th>
<th>Size</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPU_RGN_SIZE_32B</td>
<td>MPU_RGN_SIZE_512K</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_64B</td>
<td>MPU_RGN_SIZE_1M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_128B</td>
<td>MPU_RGN_SIZE_2M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_256B</td>
<td>MPU_RGN_SIZE_4M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_512B</td>
<td>MPU_RGN_SIZE_8M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_1K</td>
<td>MPU_RGN_SIZE_16M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_2K</td>
<td>MPU_RGN_SIZE_32M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_4K</td>
<td>MPU_RGN_SIZE_64M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_8K</td>
<td>MPU_RGN_SIZE_128M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_16K</td>
<td>MPU_RGN_SIZE_256M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_32K</td>
<td>MPU_RGN_SIZE_512M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_64K</td>
<td>MPU_RGN_SIZE_1G</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_128K</td>
<td>MPU_RGN_SIZE_2G</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPU_RGN_SIZE_256K</td>
<td>MPU_RGN_SIZE_4G</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The execute permission flag must be one of the following:

- `MPU_RGN_PERM_EXEC` enables the region for execution of code
- `MPU_RGN_PERM_NOEXEC` disables the region for execution of code

The read/write access permissions are applied separately for the privileged and user
modes. The read/write access flags must be one of the following:

- `MPU_RGN_PERM_PRV_NO_USR_NO` - no access in privileged or user mode
- `MPU_RGN_PERM_PRV_RW_USR_NO` - privileged read/write, no user access
- `MPU_RGN_PERM_PRV_RW_USR_RO` - privileged read/write, user read-only
- `MPU_RGN_PERM_PRV_RW_USR_RW` - privileged read/write, user read/write
- `MPU_RGN_PERM_PRV_RO_USR_NO` - privileged read-only, no user access
- `MPU_RGN_PERM_PRV_RO_USR_RO` - privileged read-only, user read-only
Each region is automatically divided into 8 equally-sized sub-regions by the MPU. Sub-regions can only be used in regions of size 256 bytes or larger. Any of these 8 sub-regions can be disabled, allowing for creation of “holes” in a region which can be left open, or overlaid by another region with different attributes. Any of the 8 sub-regions can be disabled with a logical OR of any of the following flags:

- MPU_SUB_RGN_DISABLE_0
- MPU_SUB_RGN_DISABLE_1
- MPU_SUB_RGN_DISABLE_2
- MPU_SUB_RGN_DISABLE_3
- MPU_SUB_RGN_DISABLE_4
- MPU_SUB_RGN_DISABLE_5
- MPU_SUB_RGN_DISABLE_6
- MPU_SUB_RGN_DISABLE_7

Finally, the region can be initially enabled or disabled with one of the following flags:

- MPU_RGN_ENABLE
- MPU_RGN_DISABLE

38. Start your terminal program as shown earlier. Click the Debug button to build and download the program to the LM4F120H5QR. Click the Resume button to run the program.
39. The tests are as follows:

- Attempt to write to the flash. This should cause a protection fault due to the fact that this region is read-only. If this fault occurs, the terminal program will show OK.

- Attempt to read from the disabled section of flash. If this fault occurs, the terminal program will show OK.

- Attempt to read from the read-only area of RAM. If a fault does not occur, the terminal program will show OK.

- Attempt to write to the read-only area of RAM. If this fault occurs, the terminal program will show OK.

![COM48 - PuTTY](image)

40. When you are done, close your terminal program. Click the Terminate button in CCS to return to the CCS Edit perspective. Close the `mpu_fault` project and minimize Code Composer Studio.

![STOP](image)

You’re done.
Introduction

This chapter will introduce you to the Floating-Point Unit (FPU) on the LM4F series devices. In the lab we will implement a floating-point sine wave calculator and profile the code to see how many CPU cycles it takes to execute.

Agenda

- Introduction to ARM® Cortex™-M4F and Peripherals
- Code Composer Studio
- Introduction to StellarisWare, Initialization and GPIO
- Interrupts and the Timers
  - ADC12
  - Hibernation Module
  - USB
- Memory
  - Floating-Point
  - Booster Packs and grLib
  - Synchronous Serial Interface
  - UART
  - µDMA
What is Floating-Point and IEEE-754?

**What is Floating-Point?**

- Floating-point is a way to represent real numbers on computers

**IEEE floating-point formats:**

- Half (16-bit) ➔
- Single (32-bit) ➔
- Double (64-bit) ➔
- Quadruple (128-bit) ➔

**What is IEEE-754?**

Decimal Value = \((-1)^s\) \((1+f)\) \(2^{e-bias}\)

where:

\[ f = \sum_{i=1}^{23} \left( \frac{1}{2^i} \right) \]

bias = 127 for single precision floating-point

<table>
<thead>
<tr>
<th>Symbol</th>
<th>s</th>
<th>e</th>
<th>f</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

\[ sign = (-1)^s \quad \text{exponent} = [10000110]_{\text{in}} = [134]_{\text{in}} \]

\[ fraction = [0.110100001000000000000000]_{\text{in}} = [0.814453]_{\text{in}} \]

**Decimal Value** = \((-1)^s\) \((1+f)\) \(2^{e-bias}\)

\[ = [1]_{10} \times [(1)]_{10} + [0.814453]_{10} \times [2^{134-127}]_{10} \]
\[ = [1.814453]_{10} \times 128 \]
\[ = [232.249]_{10} \]
Floating-Point Unit

Floating-Point Unit (FPU)

- The FPU provides floating-point computation functionality that is compliant with the IEEE 754 standard
- Enables conversions between fixed-point and floating-point data formats, and floating-point constant instructions
- The Cortex-M4F FPU fully supports single-precision:
  - Add
  - Subtract
  - Multiply
  - Divide
  - Single cycle multiply and accumulate (MAC)
  - Square root

Modes of Operation

- There are three different modes of operation for the FPU:
  - **Full-Compliance mode** – In Full-Compliance mode, the FPU processes all operations according to the IEEE 754 standard in hardware. No support code is required.
  - **Flush-to-Zero mode** – A result that is very small, as described in the IEEE 754 standard, where the destination precision is smaller in magnitude than the minimum normal value before rounding, is replaced with a zero.
  - **Default NaN (not a number) mode** – In this mode, the result of any arithmetic data processing operation that involves an input NaN, or that generates a NaN result, returns the default NaN. (0 / 0 = NaN)
FPU Registers

- Sixteen 64-bit double-word registers, D0-D15
- Thirty-two 32-bit single-word registers, S0-S31

FPU Usage

- The FPU is disabled from reset. You must enable it* before you can use any floating-point instructions. The processor must be in privileged mode to read from and write to the Coprocessor Access Control (CPAC) register.
- Exceptions: The FPU sets the cumulative exception status flag in the FPSCR register as required for each instruction. The FPU does not support user-mode traps.
- The processor can reduce the exception latency by using lazy stacking*. This means that the processor reserves space on the stack for the FPU state, but does not save that state information to the stack.

* with a StellarisWare API function call
CMSIS DSP Library Performance

CMSIS DSP Library Performance

* - ARM® Cortex™ Microcontroller Software Interface Standard

- DSP Library Benchmark: Cortex M3 vs. Cortex M4 (SIMD + FPU)
  - Fixed-point ~ 2x faster
  - Floating-point ~ 10x faster

Source: ARM CMSIS Partner Meeting Embedded World, Reinhard Keil
Lab 9: FPU

Objective

In this lab you will enable the FPU to run and profile floating-point code.

Lab 9: FPU

USB Emulation Connection

- Experiment with the FPU
- Profile floating-point code
### Procedure

**Import Lab9**

1. We have already created the Lab9 project for you with `main.c`, a startup file and all necessary project and build options set. Maximize Code Composer and click **Project → Import Existing CCS Eclipse Project**. Make the settings shown below and click Finish. Make sure that the “Copy projects into workspace” checkbox is **unchecked**.

![Import CCS Eclipse Projects](image)

The code is fairly simple. We'll use the FPU to calculate a full cycle of a sine wave inside a 100 datapoint long array.
Browse the Code

2. In order to save some time, we’re going to browse existing code rather than enter it line by line. Open main.c in the editor pane and copy/paste the code below into it.

```c
#include <math.h>
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/fpu.h"
#include "driverlib/sysctl.h"
#include "driverlib/rom.h"

#ifndef M_PI
#define M_PI 3.14159265358979323846
#endif

#define SERIES_LENGTH 100
float gSeriesData[SERIES_LENGTH];
int dataCount = 0;

int main(void)
{
    float fRadians;

    ROM_FPULazyStackingEnable();
    ROM_FPUEnable();

    ROM_SysCtlClockSet(SYSCTL_SYSDIV_4|SYSCTL_USE_PLL|SYSCTL_XTAL_16MHZ|SYSCTL_OSC_MAIN);

    fRadians = (2 * M_PI) / SERIES_LENGTH;

    while(dataCount < SERIES_LENGTH)
    {
        gSeriesData[dataCount] = sinf(fRadians * dataCount);
        dataCount++;
    }

    while(1)
    {
    }
}
```

3. At the top of main.c, look first at the includes, because there are a couple of new ones:
   - `math.h` – the code uses the `sinf()` function prototyped by this header file
   - `fpu.h` – support for Floating Point Unit

4. Next is an `ifndef` construct. Just in case `M_PI` is not already defined, this code will do that for us.

5. Types and defines are next:
   - `SERIES_LENGTH` – this is the depth of our data buffer
   - `float gSeriesData[SERIES_LENGTH]` – an array of floats
   - `SERIES_LENGTH` long
   - `dataCount` – a counter for our computation loop
6. Now we’ve reached main():
   - We’ll need a variable of type float called fRadians to calculate sine
   - Turn on Lazy Stacking (as covered in the presentation)
   - Turn on the FPU (remember that from reset it is off)
   - Set up the system clock for 50MHz
   - A full sine wave cycle is $2\pi$ radians. Divide $2\pi$ by the depth of the array.
   - The while() loop will calculate the sine value for each of the 100 values of the angle and place them in our data array
   - An endless loop at the end

**Build, Download and Run the Code**

7. Click the Debug button to build and download the code to the LM4F120H5QR flash memory. When the process completes, click the Resume button to run the code.

8. Click the Suspend button to halt code execution. Note that execution was trapped in the while(1) loop.

9. If your Memory Browser isn’t currently visible, Click View → Memory Browser on the CCS menu bar. Enter gSeriesData in the address box and click Go. In the box that says Hex 32 Bit – TI Style, click the down arrow and select 32 Bit Float. You will see the sine wave data in memory like the screen capture below:
10. Is that a sine wave? It’s hard to see from numbers alone. We can fix that. On the CCS menu bar, click Tools → Graph → Single Time. When the Graph Properties dialog appears, make the selections show below and click OK.

![Graph Properties](image)

You will see the graph below at the bottom of your screen:

![Graph](image)

**Profiling the Code**

11. An interesting thing to know would be the amount of time it takes to calculate those 100 sine values.

On the CCS menu bar, click View → Breakpoints. Look in the upper right area of the CCS display for the Breakpoints tab.
12. Remove any existing breakpoints by clicking Run → Remove All Breakpoints. In the `main.c`, set a breakpoint by double-clicking in the gray area to the left of the line containing:

```
fRadians = ((2 * M_PI) / SERIES_LENGTH);
```

13. Click the Restart button to restart the code from `main()`, and then click the Resume button to run to the breakpoint.

14. Right-click in the Breakpoints pane and Select Breakpoint (Code Composer Studio) → Count event. Leave the Event to Count as Clock Cycles in the next dialog and click OK.

15. Set another breakpoint on the line containing `while(1)` at the end of the code. This will allow us to measure the number of clock cycles that occur between the two breakpoints.

16. Note that the count is now 0 in the Breakpoints pane. Click the Resume button to run to the second breakpoint. When code execution reaches the breakpoint, execution will stop and the cycle count will be updated. Our result is show below:
17. A cycle count of 34996 means that it took about 350 clock cycles to run each calculation and update the dataCount variable (plus some looping overhead). Since the System Clock is running at 50Mhz, each loop took about 7µS, and the entire 100 sample loop required about 700 µS.

18. Right-click in the Breakpoints pane and select Remove All, and then click Yes to remove all of your breakpoints.

19. Click the Terminate button to return to the CCS Edit perspective.

20. Right-click on Lab9 in the Project Explorer pane and close the project.


You’re done.
BoosterPacks and grLib

Introduction

This chapter will take a look at the currently available BoosterPacks for the LaunchPad board. We’ll take a closer look at the Kentec Display LCD TouchScreen BoosterPack and then dive into the StellarisWare graphics library.

Agenda

Introduction to ARM® Cortex™-M4F and Peripherals
Code Composer Studio
Introduction to StellarisWare, Initialization and GPIO
Interrupts and the Timers
ADC12
Hibernation Module
USB
Memory
Floating-Point

BoosterPacks and grLib
Synchronous Serial Interface
UART
µDMA
Chapter Topics

BoosterPacks and grLib ........................................................................................................................... 10-1

Chapter Topics ....................................................................................................................................... 10-2

LaunchPad Boards and BoosterPacks ................................................................................................... 10-3

KenTec TouchScreen TFT LCD .............................................................................................................. 10-7

Graphics Library ................................................................................................................................... 10-8

Lab 10: Graphics Library .................................................................................................................... 10-11

Objective .......................................................................................................................................... 10-11

Procedure ......................................................................................................................................... 10-12
LaunchPad Boards and BoosterPacks

<table>
<thead>
<tr>
<th>TI LaunchPad Boards</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSP430</td>
</tr>
<tr>
<td>$9.99US</td>
</tr>
<tr>
<td>Stellaris</td>
</tr>
<tr>
<td>$12.99US</td>
</tr>
<tr>
<td>C2000 Piccolo</td>
</tr>
<tr>
<td>$17.00US</td>
</tr>
</tbody>
</table>

BoosterPack Connectors

- **Original Format (MSP430)**
  - VCC and Ground
  - 14 GPIO
  - Emulator Reset and Test
  - Crystal inputs or 2 more GPIO

- **XL Format (Stellaris/C2000)** is a superset of the original, adding two rows of pins with:
  - USB $V_{BUS}$ and Ground
  - 18 additional GPIO
Some of the Available Booster Packs

Solar Energy Harvesting
RF Module w/ LCD
Olimex 8x8 LED Matrix
TMP006 IR Temperature Sensor
Universal Energy Harvesting
Inductive Charging
Sub-1GHz RF Wireless
C5000 Audio Capacitive Touch
Capacitive Touch
Proto Board
TPL0401 SPI Digital Pot.
TPL0501 SPI Digital Pot.
Available Booster Packs...

Some of the Available Booster Packs

Proto board
ZigBee Networking
OLED Display
LCD Controller Development Package
MOD Board Adapter
Click Board Adapter
Kentec LCD Display...

See http://e2e.ti.com/group/msp430launchpad/b/boosterpacks/default.aspx for a list of TI booster packs.
Solar Energy

Universal Energy Harvesting:

Capacitive Touch:
http://e2e.ti.com/group/msp430launchpad/b/boosterpacks/archive/2011/04/17/430boost_2d00_sense1.aspx

RF Module w/ LCD:

Inductive Charging:

Proto Board:

Olimex 8x8 LED Matrix:

Sub-1GHz Wireless:
http://e2e.ti.com/group/msp430launchpad/b/boosterpacks/archive/2011/12/01/texas-instruments-sub-1ghz-rf-wireless-boosterpack-430boost-cc110l.aspx

TPL0401 SPI Digital Potentiometer:

TMP006 IR Temperature Sensor:
http://www.ti.com/tool/430boost-tmp006

C5000 Audio Capacitive Touch:
http://e2e.ti.com/group/msp430launchpad/b/boosterpacks/archive/2012/03/27/texas-instruments-c5000-audio-capacitive-touch-boosterpack-430boost-c55audio1.aspx

TPL0501 SPI Digital Potentiometer:

Proto Board:

LCD Controller Development Package:
http://www.epson.jp/device/semicon_e/product/lcd_controllers/index.htm
ZigBee Networking:
http://www.anaren.com/

MOD Board adapter:
https://www.olimex.com/dev/index.html

OLED Display:

Click Board Adapter:
http://www.mikroe.com/eng/categories/view/102/click-boards/
KenTec TouchScreen TFT LCD

KenTec TouchScreen TFT LCD Display

- Part# EB-LM4F120-L35
- Designed for XL BoosterPack pinout
- 3.5” QVGA TFT 320x240x16 color LCD with LED backlight
- Driver circuit and connector are compatible with 4.3”, 5”, 7” & 9” displays
- Resistive Touch Overlay

For more information go to: http://www.kentecdisplay.com/
Graphics Library

Graphics Library Overview

The Stellaris Graphics Library provides graphics primitives and widgets sets for creating graphical user interfaces on Stellaris controlled displays. Note that Stellaris devices do not have an LCD interface. The interface to smart displays is done through serial or EPI ports. The graphics library consists of three layers to interface your application to the display:

- **Display Driver Layer**
- **Graphics Primitives Layer**
- **Widget Layer**

Your Application Code*

* = user written or modified

Graphics Library Overview

The design of the graphics library is governed by the following goals:

- Components are written entirely in C except where absolutely not possible.
- Your application can call any of the layers.
- The graphics library is easy to understand.
- The components are reasonably efficient in terms of memory and processor usage.
- Components are as self-contained as possible.
- Where possible, computations that can be performed at compile time are done there instead of at run time.
Display Driver

Low level interface to the display hardware

Routines for display-dependent operations like:
- Initialization
- Backlight control
- Contrast
- Translation of 24-bit RGB values to screen dependent color map

Drawing routines for the graphics library like:
- Flush
- Line drawing
- Pixel drawing
- Rectangle drawing

User-modified Hardware Dependent Code
- Connectivity of the smart display to the LM4F
- Changes to the existing code to match your display (like color depth and size)

This document: http://www.ti.com/lit/an/spma039/spma039.pdf has suggestions for modifying the display driver to connect to your display.

Graphics Primitives

Low level drawing support for:
- Lines, circles, text and bitmap images
- Support for off-screen buffering
- Foreground and background drawing contexts
- Color is represented as a 24-bit RGB value (8-bits per color)
  - ~150 pre-defined colors are provided
- 153 pre-defined fonts based on the Computer Modern typeface
- Support for Asian and Cyrillic languages
Widget Framework

- Widgets are graphic elements that provide user control elements
- Widgets combine the graphical and touch screen elements on-screen with a parent/child hierarchy so that objects appear in front or behind each other correctly

Canvas – a simple drawing surface with no user interaction
Checkbox – select/unselect
Container – a visual element to group on-screen widgets
Push Button – an on-screen button that can be pressed to perform an action
Radio Button – selections that form a group; like low, medium and high
Slider – vertical or horizontal to select a value from a predefined range
ListBox – selection from a list of options

Special Utilities

Utilities to produce graphics library compatible data structures

frasterize
- Uses the FreeType font rendering package to convert your font into a graphic library format.
- Supported fonts include: TrueType®, OpenType®, PostScript® Type 1 and Windows® FNT.

lmi-button
- Creates custom shaped buttons using a script plug-in for GIMP. Produces images for use by the pushbutton widget.

pnmtoc
- Converts a NetPBM image file into a graphics library compatible file.
- NetPBM image formats can be produced by: GIMP, NetPBM, ImageMajik and others.

mkstringtable
- Converts a comma separated file (.csv) into a table of strings usable by graphics library for pull down menus.
Lab 10: Graphics Library

Objective

In this lab you will connect the KenTec display to your LaunchPad board. You will experiment with the example code and then write a program using the graphics library.

Lab 10: Graphics Library

USB Emulation Connection

- Connect KenTec Display
- Experiment with demo project
- Write graphics library code
Procedure

**Connect the KenTec Display to your LaunchPad Board**

1. Carefully connect the KenTec display to your LaunchPad board. Note the part numbers on the front of the LCD display. Those part numbers should be at the end of the LaunchPad board that has the two pushbuttons when oriented correctly. Make sure that all the BoosterPack pins are correctly engaged into the connectors on the bottom of the display.

![Connect the KenTec Display to your LaunchPad Board](image1.jpg)

**Import Project**

2. We’re going to use the Kentec example project provided by the manufacturer. Maximize Code Composer and click Project ➔ Import Existing CCS Eclipse Project. Make the settings shown below and click Finish. Note that this project will be automatically copied into your workspace.

![Import Project](image2.jpg)
3. Expand the project in the Project Explorer pane, and then expand the **drivers** folder. The two files in this folder; `Kentec320x240x16_ssd2119_8bit.c` and `touch.c` are the driver files for the display and the touch overlay. Open the files and take a look around. Some of these files were derived from earlier StellarisWare examples, so you may see references to the DK-LM3S9B96 board.

`Kentec320x240x16_ssd2119_8bit.c` contains the low level Display Driver interface to the LCD hardware, including the pin mapping, contrast controls and simple graphics primitives.

**Build, Download and Run the Demo**

4. Make sure your board is connected to your computer, and then click the Debug button to build and download the program to the LM4F120H5QR device. The project should build and link without any warnings or errors.

5. Watch your LCD display and click the Resume button to run the demo program. Using the + and – buttons on-screen, navigate through the eight screens. Make sure to try out the checkboxes, push buttons, radio buttons and sliders. When you’re done experimenting, click Terminate on the CCS menu bar to return to the CCS Editing perspective.

**Writing Our Own Code**

6. The first task that our lab software will do is to display an image. So we need to create an image in a format that the graphics library can understand. If you have not done so already, download GIMP from [www.gimp.org](http://www.gimp.org) and install it on your PC. The steps below will go through the process of clipping the photo below and displaying it on the LCD display. If you prefer to use an existing image or photograph, or one taken from your smartphone camera now, simply adapt the steps below.

7. Make sure that this page of the workbook pdf is open for viewing and press PrtScn on your keyboard. This will copy the screen to your clipboard. The dimensions of the photo below approximate that of the 320x240 KenTec LCD.
8. Open GIMP (make sure it is version 2.8 or later) and click Edit → Paste. In the toolbox window, click the Rectangle Select tool, and select tightly around the border of the photo. Zoom in if that is easier for you. Click Image → Crop to selection. Click Image → Scale Image and make sure that the image size width/height is 320x240 and click Scale. You may need to click the “chain” symbol to the right of the pixel boxes to stop GIMP from preserving the wrong dimensions.

9. Convert the image to indexed mode by clicking Image → Mode → Indexed. Select Generate optimum palette and change the Maximum number of colors box to 16 (the color depth of the LCD). Click Convert.

10. Save the file by clicking File → Export… Name the image pic, change the save folder to C:\StellarisWare\tools\bin and select PNM image as the file type using the + Select File Type just above the Help button. Click Export. When prompted, select Raw as the data formatting and click Export. Close GIMP.

11. Now that we have a source image file in PNM format, we can convert it to something that the graphics library can handle. We’ll use the pnmtoc (PNM to C array) conversion utility to do the translation.

Open a command prompt by clicking Start → Run. Type cmd in the window and click Open. The pnmtoc utility is in C:\StellarisWare\tools\bin. Type (Ctrl-V will not work) cd C:\StellarisWare\tools\bin in the command window, then press Enter to change the folder to that location.

Finally, perform the conversion by typing pnmtoc –c pic.pnm > pic.c in the command window and hit Enter. When the process completes correctly, the cursor will simply drop to a new line. Close the DOS window.

12. Using Windows Explorer, find the CCS workspace in your My Documents folder. Open the folder and find the grlib_demo folder that was copied here when you imported this project. Copy pic.c from C:\StellarisWare\tools\bin to the grlib_demo folder.

Look back in the expanded grlib_demo project in the CCS Project Explorer. If the pic.c file does not appear there, right-click on the project and select Refresh.
Lab 10: Graphics Library

Modify pic.c
13. Open pic.c and add the following include to the very top of the file:
#include "grlib/grlib.h"
Your pic.c file should look something like this (your data will vary greatly):
#include "grlib/grlib.h"
const unsigned char g_pucImage[] =
{
IMAGE_FMT_4BPP_COMP,
96, 0,
64, 0,
15,
0x00,
0x18,
0x28,
0x38,
0x44,
0x54,
0x62,
0x72,
0x81,
0x93,
0xa2,
0xb3,
0xc4,
0xd7,
0xe8,
0xf4,

0x02,
0x1a,
0x2a,
0x3a,
0x46,
0x57,
0x65,
0x75,
0x84,
0x96,
0xa5,
0xb6,
0xc7,
0xda,
0xeb,
0xf8,

0x00,
0x19,
0x28,
0x38,
0x44,
0x55,
0x63,
0x73,
0x82,
0x94,
0xa3,
0xb4,
0xc5,
0xd8,
0xe9,
0xf5,

0xff,
0x07,
0x07,
0x23,
0x04,
0x2c,
0xf0,
0xee,
0xe9,
0x4f,

0x07,
0x07,
0x07,
0x77,
0xde,
0x03,
0x07,
0xa0,
0xee,
0xee,

0x07,
0x07,
0x07,
0x77,
0xee,
0xcf,
0x07,
0x07,
0x90,
0xe9,

0x07,
0x07,
0xfc,
0xe9,
0xee,
0x00,
0x77,
0x07,
0xf0,
0xee,

0x07,
0x07,
0x07,
0x77,
0xee,
0xee,
0x2c,
0x77,
0x07,
0x90,

0x07,
0x07,
0x07,
0x78,
0xe9,
0xee,
0x03,
0x2c,
0x07,
0x07,

0x07,
0xff,
0x07,
0x70,
0x3c,
0xee,
0xcf,
0x04,
0x77,
0x07,

0x07,
0x07,
0x07,
0x07,
0xee,
0xef,
0xee,
0x03,
0x2c,
0x77,

0x07,
0x07,
0x07,
0x07,
0xa1,
0xee,
0xee,
0xcf,
0x03,
0x2c,

0xff,
0x07,
0x07,
0xc1,
0x07,
0xef,
0x4f,
0xee,
0xcf,
0x04,

0x07,
0x07,
0x03,
0x77,
0x07,
0xfe,
0xee,
0xee,
0xee,
0x03,

0x07,
0x07,
0x77,
0x2c,
0x77,
0xa0,
0xe9,
0xee,
0xee,
0xcf,

0xee,
0xdf,
0x8d,
0x39,
0x2e,
0x77,
0x07,
0x07,
0x07,
0x20,
0x40,
0x30,
0x07,

0xee,
0xee,
0xee,
0xef,
0x06,
0x2f,
0x77,
0x77,
0x07,
0x07,
0x07,
0x07,
0x07,

0xee,
0xee,
0x2f,
0xee,
0xdf,
0x01,
0x2f,
0x2f,
0xc0,
0x07,
0x07,
0xff,

0xee,
0xee,
0xee,
0xee,
0xee,
0x7d,
0x17,
0x01,
0x77,
0x77,
0x77,
0x07,

0xfb,
0xe9,
0xee,
0xee,
0xee,
0xfe,
0xdf,
0x7d,
0x2f,
0x2f,
0x2f,
0x77,

many, many more lines of this data …

};

0x77,
0x20,
0x78,
0xe9,
0xee,
0x0f,
0xee,
0xee,
0x03,
0x05,
0x00,
0x01,
0x2f,

0x2c,
0x07,
0xf9,
0xf7,
0xee,
0xee,
0xee,
0xee,
0xee,
0xad,
0x27,
0x00,
0x07,

0x19,
0x07,
0x07,
0x07,
0xf7,
0xee,
0xee,
0xee,
0xee,
0xee,
0x9d,
0x00,
0x07,

0xfe,
0xc1,
0x07,
0x07,
0xf0,
0xee,
0xee,
0x3c,
0xee,
0xfe,
0x0f,
0x28,
0x07,

0xee,
0x77,
0x77,
0x77,
0x07,
0xf6,
0xf7,
0xee,
0xee,
0xee,
0xed,
0x9a,
0x07,

0xef,
0x2c,
0x2d,
0x2e,
0x07,
0x07,
0x07,
0xf7,
0xf9,
0xfc,
0xee,
0xcc,
0x07,

0x03,
0x05,
0x01,
0x00,
0x77,
0x07,
0xe0,
0x07,
0x10,
0x78,
0xec,
0xa9,
0xc0,

Save your changes and close the pic.c editor pane. If you’re having issues with this, you can
find a pic.c file in the Lab10 folder.

Getting Started With the Stellaris EK-LM4F120XL LaunchPad Workshop- BoosterPacks and grLib 10 - 15


Main.c

14. To speed things up, we’re going to use the entire demo project as a template for our own main() code. But we can’t have grlib_demo.c in the project since it already has a main(). In the Project Explorer, right-click on grlib_demo.c and select Resource Configurations  Exclude from Build… Click the Select All button to select both the Debug and Release configurations, and then click OK. In this manner we can keep the old file in the project, but it will not be used during the build process. This is a valuable technique when you are building multiple versions of a system that shares much of the code between them.

15. On the CCS menu bar, click File  New  Source File. Make the selections shown below and click Finish:

16. Open main.c for editing. Add (or copy/paste) the following lines to the top:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/debug.h"
#include "driverlib/sysctl.h"
#include "grlib/grlib.h"
#include "drivers/Kentec320x240x16_ssd2119_8bit.h"
```

Pointer to the Image Array

17. The declaration of the image array needs to be made, as well as the declaration of two variables. The variables defined below are used for initializing the Context and Rect structures. Context is a definition of the screen such as the clipping region, default color and font. Rect is a simple structure for drawing rectangles. Look up these APIs in the Graphics Library users guide.

Add a line for spacing and add the following lines after the includes:

```c
extern const unsigned char g_pucImage[];
tContext sContext;
tRectangle sRect;
```
Driver Library Error Routine

18. The following code will be called if the driver library encounters an error.

Leave a line for spacing and enter these line of codes after the lines above:

```
#ifdef DEBUG
void__error__(char *pcFilename, unsigned long ulLine)
{
}
#endif
```

Main()

19. The main() routine will be next. Leave a blank line for spacing and enter these lines of code after the lines above:

```
int main(void)
{
}
```

Initialization

20. Set the clocking to run at 50 MHz using the PLL (400MHz ÷ 2 ÷ 4). Leave a line for spacing, then insert this line as the first inside main():

```
SysCtlClockSet(SYSCTL_SYSDIV_4 | SYSCTL_USE_PLL | SYSCTL_OSC_MAIN | SYSCTL_XTAL_16MHZ);
```

Initialize the display driver. Skip a line and insert this line after the last:

```
Kentec320x240x16_SSD2119Init();
```

This next function initializes a drawing context, preparing it for use. The provided display driver will be used for all subsequent graphics operations, and the default clipping region will be set to the extent of the LCD screen. Insert this line after the last:

```
GrContextInit(&sContext, &g_sKentec320x240x16_SSD2119);
```

21. Let’s add a call to a function that will clear the screen. We’ll create that function in a moment. Add the following line after the last one:

```
ClrScreen();
```
22. The following function will create a rectangle that covers the entire screen, set the foreground color to black, and fill the rectangle by passing the structure `sRect` by reference. The top left corner of the LCD display is the point (0,0) and the bottom right corner is (319,239). Add the following code after the final closing brace of the program in main.c.

```c
void ClrScreen()
{
    sRect.sXMin = 0;
    sRect.sYMin = 0;
    sRect.sXMax = 319;
    sRect.sYMax = 239;
    GrContextForegroundSet(&sContext, ClrBlack);
    GrRectFill(&sContext, &sRect);
    GrFlush(&sContext);
}
```

23. Declare the function at the top of your code right below your variable definitions:

```c
void ClrScreen(void);
```

### Displaying the Image

24. Display the image by passing the global image variable `g_pucImage` into `GrImageDraw(...)` and place the image on the screen by locating the top-left corner at (0,0) ...we’ll adjust this later if needed. Leave a line for spacing, then insert this line after the `ClrScreen()` call in main.c:

```c
GrImageDraw(&sContext, g_pucImage, 0, 0);
```

25. The function call below flushes any cached drawing operations. For display drivers that draw into a local frame buffer before writing to the actual display, calling this function will cause the display to be updated to match the contents of the local frame buffer. Insert this line after the last:

```c
GrFlush(&sContext);
```

26. We will be stepping through a series of displays in this lab, so we want to leave each display on the screen long enough to see it before it is erased. The delay below will give you a chance to appreciate your work. Leave a line for spacing, then insert this line after the last:

```c
SysCtlDelay(SysCtlClockGet());
```

In previous labs we’ve simply passed a number to the `SysCtlDelay()` API call, but if you were to change the CPU clock speed, your delay time would change. `SysCtlClockGet()` will return the system clock speed and we can use that as our delay basis. Obviously, you could have your delay be twice, half, 1/5th or some other multiple of this.
27. Before we go any further, we’d like to take the code for a test run. With that in mind we’re going to add the final code pieces now, and insert later lab code in front of this.

LCD displays are not especially prone to burn in, but clearing the screen will mark a clear break between one step in the code and the next. This performs the same function as step 24 and also flushes the cache. Leave several lines for spacing and add this line below the last:

```c
ClrScreen();
```

28. Add a while loop to the end of the code to stop execution. Leave a line for spacing, then insert these line after the last:

```c
while(1)
{
}
```

Don’t forget that you can auto-correct the indentation if needed.
If you’re having issues, you can find this code in main1.txt in the Lab10 folder.
Your code should look like this:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/debug.h"
#include "driverlib/sysctl.h"
#include "gplib/gplib.h"
#include "drivers/Kentec320x240x16_ssd2119_8bit.h"

extern const unsigned char g_pucImage[];
tContext sContext;
tRectangle sRect;

void ClrScreen(void);

#ifdef DEBUG
void__error__(char *pcFilename, unsigned long ulLine)
{
}
#endif

int main(void)
{
    SysCtlClockSet(SYSCTL_SYSDIV_4|SYSCTL_USE_PLL|SYSCTL_OSC_MAIN|SYSCTL_XTAL_16MHZ);
    Kentec320x240x16_SSD2119Init();
    GrContextInit(&sContext, &g_sKentec320x240x16_SSD2119);
    ClrScreen();
    GrImageDraw(&sContext, g_pucImage, 0, 0);
    GrFlush(&sContext);
    SysCtlDelay(SysCtlClockGet());
    // Later lab steps go between here
    // and here
    ClrScreen();
    while(1)
    {
        
    }
}

void ClrScreen()
{
    sRect.sXMin = 0;
    sRect.sYMin = 0;
    sRect.sXMax = 319;
    sRect.sYMax = 239;
    GrContextForegroundSet(&sContext, ClrBlack);
    GrRectFill(&sContext, &sRect);
    GrFlush(&sContext);
} 
```
**Check the Build Options**

29. Now would be a good time to check the build options that have been set in this demo code. You should know how to do this without explicit steps by now. Take a look in the Linker’s File Search Path and note that the `.lib` file for the graphics library has been included.

You might notice the use of two “new” path variables:

- `CG_TOOL_ROOT`
- `SW_ROOT`

Take a look in the project properties under Resource → Linked Resources to see where these paths are defined.

**Run the Code**

30. Make sure `grlib_demo` is the active project. Compile and download your application by clicking the Debug button. Click the Resume button to run the program that was downloaded to the flash memory of your LM4F120H5QR. If your coding efforts were successful, you should see your image appear on the LCD display for a few seconds, then disappear.

When you’re finished, click the Terminate button to return to the CCS Edit perspective.

When you are including images in your projects, remember that they can be quite large in terms of memory space. This might possibly require a larger flash device, and increase your system cost.
Display Text On-Screen

31. Refer back to the code on page 10-20. In main.c in the area marked:

   // Later lab steps go between here
   // and here

insert the following function call to clear the screen and flush the buffer:

ClrScreen();

32. Next we’ll display the text. Display text starting at (x,y) with the no background color. The third parameter (-1) simply tells the API function to send the entire string, rather than having to count the characters.

GrContextForegroundSet(...): Set the foreground for the text to be red.

GrContextFontSet(...): Set the font to be a max height of 30 pixels.

GrRectDraw(...): Put a white border around the screen.

GrFlush(...): And refresh the screen by matching the contents of the local frame buffer.

Note the colors that are being used. If you’d like to try other colors, fonts or sizes, look in the back of the Graphics Library User’s Guide. Add the following lines after the previous ones:

    sRect.sXMin = 1;
    sRect.sYMin = 1;
    sRect.sXMax = 318;
    sRect.sYMax = 238;
    GrContextForegroundSet(&sContext, ClrRed);
    GrContextFontSet(&sContext, &g_sFontCmss30b);
    GrStringDraw(&sContext, "Texas", -1, 110, 2, 0);
    GrStringDraw(&sContext, "Instruments", -1, 80, 32, 0);
    GrStringDraw(&sContext, "Graphics", -1, 100, 62, 0);
    GrStringDraw(&sContext, "Lab", -1, 135, 92, 0);
    GrContextForegroundSet(&sContext, ClrWhite);
    GrRectDraw(&sContext, &sRect);
    GrFlush(&sContext);

33. Add a delay so you can view your work.

    SysCtlDelay(SysCtlClockGet());

Save your file.
If you’re having issues, you can find this code in main2.txt in the Lab10 folder.

Your added code should look like this:

```c
// Later lab steps go between here

ClrScreen();

sRect.sXMin = 1;
sRect.sYMin = 1;
sRect.sXMax = 318;
sRect.sYMax = 238;
GrContextForegroundSet(&sContext, ClrRed);
GrContextFontSet(&sContext, &g_sFontCmss30b);
GrStringDraw(&sContext, "Texas", -1, 110, 2, 0);
GrStringDraw(&sContext, "Instruments", -1, 80, 32, 0);
GrStringDraw(&sContext, "Graphics", -1, 100, 62, 0);
GrStringDraw(&sContext, "Lab", -1, 135, 92, 0);
GrContextForegroundSet(&sContext, ClrWhite);
GrRectDraw(&sContext, &sRect);
GrFlush(&sContext);

SysCtlDelay(SysCtlClockGet());

// and here
```

**Build, Load and Test**

34. Build, load and run your code. If your changes are correct, you should see the image again for a few seconds, followed by the on-screen text in a box for a few seconds. Then the display will blank out. Return to the CCS Edit perspective when you’re done.
**Drawing Shapes**

35. Let’s add a filled-in yellow circle. Make the foreground yellow and center the circle at (80,182) with a radius of 50. Add a line for spacing and then add these lines after the `SysCtlDelay()` added in step 33:

   ```c
   GrContextForegroundSet(&sContext, ClrYellow);
   GrCircleFill(&sContext, 80, 182, 50);
   ```

36. Draw an empty green rectangle starting with the top left corner at (160,132) and finishing at the bottom right corner at (312,232). Add a line for spacing and add the following lines after the last ones:

   ```c
   sRect.sXMin = 160;
   sRect.sYMin = 132;
   sRect.sXMax = 312;
   sRect.sYMax = 232;
   GrContextForegroundSet(&sContext, ClrGreen);
   GrRectDraw(&sContext, &sRect);
   ```

37. Add a short delay to appreciate your work. Add a line for spacing and add the following line after the last ones:

   ```c
   SysCtlDelay(SysCtlClockGet());
   ```

Save your work.
If you're having issues, you can find this code in `main3.txt` in the Lab10 folder.

Your added code should look like this:

```c
// Later lab steps go between here

ClrScreen();

sRect.sXMin = 1;
sRect.sYMin = 1;
sRect.sXMax = 318;
sRect.sYMax = 238;
GrContextForegroundSet(&sContext, ClrRed);
GrContextFontSet(&sContext, &g_sFontCmss30b);
GrStringDraw(&sContext, "Texas", -1, 110, 2, 0);
GrStringDraw(&sContext, "Instruments", -1, 80, 32, 0);
GrStringDraw(&sContext, "Graphics", -1, 100, 62, 0);
GrStringDraw(&sContext, "Lab", -1, 135, 92, 0);
GrContextForegroundSet(&sContext, ClrWhite);
GrRectDraw(&sContext, &sRect);
GrFlush(&sContext);

SysCtlDelay(SysCtlClockGet());

GrContextForegroundSet(&sContext, ClrYellow);
GrCircleFill(&sContext, 80, 182, 50);

sRect.sXMin = 160;
sRect.sYMin = 132;
sRect.sXMax = 312;
sRect.sYMax = 232;
GrContextForegroundSet(&sContext, ClrGreen);
GrRectDraw(&sContext, &sRect);

SysCtlDelay(SysCtlClockGet());

// and here
```
For reference, the final code should look like this:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/debug.h"
#include "driverlib/sysctl.h"
#include "grlib/grlib.h"
#include "drivers/Kentec320x240x16_ssd2119_8bit.h"

extern const unsigned char g_pucImage[];

tContext sContext;
tRectangle sRect;

void ClrScreen(void);

#ifdef DEBUG
void__error__(char *pcFilename, unsigned long ulLine)
{
}
#endif

int main(void)
{
    SysCtlClockSet(SYSCTL_SYSDIV_4|SYSCTL_USE_PLL|SYSCTL_OSC_MAIN|SYSCTL_XTAL_16MHZ);
    Kentec320x240x16_SSD2119Init();
    GrContextInit(&sContext, &g_sKentec320x240x16_SSD2119);
    ClrScreen();
    GrImageDraw(&sContext, g_pucImage, 0, 0);
    GrFlush(&sContext);
    SysCtlDelay(SysCtlClockGet());
    // Later lab steps go between here
    ClrScreen();
    sRect.sXMin = 1;
    sRect.sYMin = 1;
    sRect.sXMax = 318;
    sRect.sYMax = 238;
    GrContextForegroundSet(&sContext, ClrRed);
    GrContextFontSet(&sContext, &g_sFontCmss30b);
    GrStringDraw(&sContext, "Texas", -1, 110, 2, 0);
    GrStringDraw(&sContext, "Instruments", -1, 80, 32, 0);
    GrStringDraw(&sContext, "Graphics", -1, 100, 62, 0);
    GrStringDraw(&sContext, "Lab", -1, 135, 92, 0);
    GrContextForegroundSet(&sContext, ClrWhite);
    GrRectDraw(&sContext, &sRect);
    GrFlush(&sContext);
    SysCtlDelay(SysCtlClockGet());
    GrContextForegroundSet(&sContext, ClrYellow);
    GrCircleFill(&sContext, 80, 182, 50);
    aRect.sXMin = 160;
    aRect.sYMin = 132;
    aRect.sXMax = 312;
    aRect.sYMax = 232;
    GrContextForegroundSet(&sContext, ClrGreen);
    GrRectDraw(&sContext, &aRect);
    SysCtlDelay(SysCtlClockGet());
    // and here
    ClrScreen();
    while(1)
    {
        
    }

    void ClrScreen()
    {
        sRect.sXMin = 0;
        sRect.sYMin = 0;
        sRect.sXMax = 319;
        sRect.sYMax = 239;
        GrContextForegroundSet(&sContext, ClrBlack);
        GrRectFill(&sContext, &sRect);
        GrFlush(&sContext);
    }

    This is the code in main3.txt.
```
**Build, Load and Test**

38. Build, load and run your code to make sure that your changes work. Return to the CCS Edit perspective when you are done.
Widgets

39. Let’s play with some widgets. In this case, we’ll create a screen with a nice header and a large rectangular button that will toggle the red LED on and off. Modifying the existing code would be a little tedious, so we’ll create a new file.

40. In the Project Explorer, right-click on main.c and select Resource Configurations → Exclude from Build… Click the Select All button to select both the Debug and Release configurations, and then click OK.

41. On the CCS menu bar, click File → New → Source File. Make the selections shown below and click Finish:

![New Source File Image]

42. Add the following support files to the top of MyWidget.c:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/interrupt.h"
#include "driverlib/sysctl.h"
#include "driverlib/gpio.h"
#include "grlib/grlib.h"
#include "grlib/widget.h"
#include "grlib/canvas.h"
#include "grlib/pushbutton.h"
#include "drivers/Kentec320x240x16_ssd2119_8bit.h"
#include "drivers/touch.h"
```

43. The next two lines provide names for structures needed to create the background canvas and the button widget. Add a line for spacing, then add these lines below the last:

```c
extern tCanvasWidget g_sBackground;
extern tPushButtonWidget g_sPushBtn;
```

44. When the button widget is pressed, a handler called OnButtonPress() will toggle the LED. Add a line for spacing, then add this prototype below the last:

```c
void OnButtonPress(tWidget *pWidget);
```
45. Widgets are arranged on the screen in order of a parent-child relationship, where the
parent is in the back. This relationship can extend multiple levels. In our example, we’re
going to have the background be the parent or root and the heading will be a child of the
background. The button will be a child of the heading. Add a line for spacing and then
add the following two global variables (one for the background and one for the button)
below the last:

```
Canvas(g_sHeading, &g_sBackground, 0, &g_sPushBtn,
    &g_sKentec320x240x16_SSD2119, 0, 0, 320, 23,
    (CANVAS_STYLE_FILL | CANVAS_STYLE_OUTLINE | CANVAS_STYLE_TEXT),
    ClrBlack, ClrWhite, ClrRed, g_pFontCm20, "LED Control", 0, 0);
Canvas(g_sBackground, WIDGET_ROOT, 0, &g_sHeading,
    &g_sKentec320x240x16_SSD2119, 0, 23, 320, (240 - 23),
    CANVAS_STYLE_FILL, ClrBlack, 0, 0, 0, 0, 0, 0);
```

Rather than re-print the parameter list for these declarations, refer to section 5.2.3.1 in the
is that there will be a black background. In front of that is a white rectangle at the top of
the screen with “LED Control” inside it.

46. Next up is the definition for the rectangular button we’re going to use. The button is
functionally in front of the heading, but physically located below it (refer to the picture in
step 50). It will be a red rectangle with a gray background and “Toggle red LED” inside
it. When pressed it will fill with white and the handler named `OnButtonPress` will be
called. Add a line for spacing and then add the following code below the last:

```
RectangularButton(g_sPushBtn, &g_sHeading, 0, 0,
    &g_sKentec320x240x16_SSD2119, 60, 60, 200, 40,
    (PB_STYLE_OUTLINE | PB_STYLE_TEXT_OPAQUE | PB_STYLE_TEXT |
        PB_STYLE_FILL), ClrGray, ClrWhite, ClrRed, ClrRed,
    g_pFontCmss22b, "Toggle red LED", 0, 0, 0, 0, OnButtonPress);
```

Refer to section 10.2.3.33 in the Stellaris Graphics Library User’s Guide (spmu018n.pdf)
for more detail.

47. The last detail before the actual code is a flag variable to indicate whether the LED is on
or off. Add a line for spacing and then add the following code below the last:

```
tBoolean g_RedLedOn = false;
```
48. When the button is pressed, a handler called OnButton Press() will be called. This handler uses the flag to switch between turning the red LED on or off. Add a line for spacing and then add the following code below the last:

```c
void OnButtonPress(tWidget *pWidget)
{
    g_RedLedOn = !g_RedLedOn;
    if(g_RedLedOn)
    {
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1, 0x02);
    }
    else
    {
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1, 0x00);
    }
}
```

49. Lastly is the main() routine. The steps are: initialize the clock, initialize the GPIO, initialize the display, initialize the touchscreen, enable the touchscreen callback so that the routine indicated in the button structure will be called when it is pressed, add the background and paint it to the screen (parents first, followed by the children) and finally, loop while the widget polls for a button press. Add a line for spacing and then add the following code below the last:

```c
int main(void)
{
    SysCtlClockSet(SYSCTL_SYSDIV_4|SYSCTL_USE_PLL|SYSCTL_OSC_MAIN|SYSCTL_XTAL_16MHZ);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x00);
    Kentec320x240x16_SSD2119Init();
    TouchScreenInit();
    TouchScreenCallbackSet(WidgetPointerMessage);
    WidgetAdd(WIDGET_ROOT, (tWidget *)&g_sBackground);
    WidgetPaint(WIDGET_ROOT);
    while(1)
    {
        WidgetMessageQueueProcess();
    }
}
```

Save your file.

If you’re having issues, you can find this code in MyWidget.txt in the Lab10 folder.

Your added code should look like the next page:
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/interrupt.h"
#include "driverlib/sysctl.h"
#include "driverlib/gpio.h"
#include "grlib/grlib.h"
#include "grlib/widget.h"
#include "grlib/canvas.h"
#include "grlib/pushbutton.h"
#include "drivers/Kentec320x240x16_ssd2119_8bit.h"
#include "drivers/touch.h"

extern tCanvasWidget g_sBackground;
extern tPushButtonWidget g_sPushBtn;

void OnButtonPress(tWidget *pWidget);

Canvas(g_sHeading, &g_sBackground, 0, &g_sPushBtn,
&g_sKentec320x240x16_SSD2119, 0, 0, 320, 23,
(CANVAS_STYLE_FILL | CANVAS_STYLE_OUTLINE | CANVAS_STYLE_TEXT),
ClrBlack, ClrWhite, ClrRed, g_pFontCm20, "LED Control", 0, 0);
Canvas(g_sBackground, WIDGET_ROOT, 0, &g_sHeading,
&g_sKentec320x240x16_SSD2119, 0, 23, 320, (240 - 23),
CANVAS_STYLE_FILL, ClrBlack, 0, 0, 0, 0, 0, 0);

RectangularButton(g_sPushBtn, &g_sHeading, 0, 0,
&g_sKentec320x240x16_SSD2119, 60, 60, 200, 40,
(PB_STYLE_OUTLINE | PB_STYLE_TEXT_OPAQUE | PB_STYLE_TEXT |
PB_STYLE_FILL), ClrGray, ClrWhite, ClrRed, ClrRed,
g_pFontCmss22b, "Toggle red LED", 0, 0, 0, 0, OnButtonPress);

tBoolean g_RedLedOn = false;

void OnButtonPress(tWidget *pWidget)
{
  g_RedLedOn = !g_RedLedOn;
  if(g_RedLedOn)
  {
    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1, 0x02);
  }
  else
  {
    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1, 0x00);
  }
}

int main(void)
{
  SysCtlClockSet(SYSCON_SYSDIV_4|SYSCON_USE_PLL|SYSCON_OSC_MAIN|SYSCON_XTAL_16MHZ);
  SysCtlPeripheralEnable(SYSCON_PERIPH_GPIOF);
  GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
  GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3);
  GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_1|GPIO_PIN_2|GPIO_PIN_3, 0x00);
  Kentec320x240x16_SSD2119Init();
  TouchScreenInit();
  TouchScreenCallbackSet(WidgetPointerMessage);
  WidgetAdd(WIDGET_ROOT, (tWidget *)&g_sBackground);
  WidgetPaint(WIDGET_ROOT);
  while(1)
  {
    WidgetMessageQueueProcess();
  }
**Build, Load and Test**

50. Build, load and run your code to make sure that everything works. Press the rectangular button and the red LED on the LaunchPad will light, press it again and it will turn off.

![LED Control](image)

51. Click the Terminate button to return to the CCS Edit perspective when you are done. Close all open lab projects and minimize Code Composer Studio.

52. If you want to reprogram the qs-rgb application that was originally on the LaunchPad board, the steps are in section two of this workshop.

53. **Homework Ideas:**

   - Change the red background of the button so that it stays on when the LED is lit
   - Add more buttons to control the green and blue LEDs.
   - Use the Lab5 ADC code to display the measured temperature on the LCD in real time.
   - Use the RTC to display the time of day on screen.
   - Use the Lab6 Hibernation code to make the device sleep, and the backlight go off, after no screen touch for 10 seconds
   - Use the Lab7 USB code to send data to the LCD and touch screen presses back to the PC.
   - Use the Lab9 sine wave code to create a program that displays the sine wave data on the LCD screen.

![STOP](image)

You’re done.
Synchronous Serial Interface

Introduction

This chapter will introduce you to the capabilities of the Synchronous Serial Interface (SSI). The lab uses an Olimex 8x8 LED BoosterPack to explore programming the SPI portion of the SSI. In order to do the lab you will need to purchase the BoosterPack and make some modification to it.

Agenda

- Introduction to ARM® Cortex™-M4F and Peripherals
- Code Composer Studio
- Introduction to StellarisWare, Initialization and GPIO
- Interrupts and the Timers
- ADC12
- Hibernation Module
- USB
- Memory
- Floating-Point
- BoosterPacks and grLib

Synchronous Serial Interface

- UART
- µDMA
Chapter Topics

Synchronous Serial Interface ..................................................................................................................11-1

Chapter Topics .................................................................................................................................11-2

Features and Block Diagram ..............................................................................................................11-3

Interrupts and μDMA Operation ........................................................................................................11-4

Signal Formats ....................................................................................................................................11-5

Lab 11: SPI Bus and the Olimex LED BoosterPack ..........................................................................11-7

Objective .............................................................................................................................................11-7

Procedure ..........................................................................................................................................11-8
Features and Block Diagram

LM4F120H5QR SSI Features

Four SSI modules. Each with:
- Freescale SPI, MICROWIRE or TI Synchronous Serial interfaces
- Master or Slave operation
- Programmable bit clock rate and pre-scaler
- Programmable data frame size from 4 to 16-bits
- Separate Tx and Rx FIFOs (8 x16-bits)
- Interrupts and µDMA support

SSI Block Diagram

Signal Pinout (n = 0 to 3) ...

- SSInClk: SSI Module n Clock
- SSInFss: SSI Module n Frame Signal
- SSInRx: SSI Module n Receive
- SSInTx: SSI Module n Transmit

Note that the LM4F120H5QR pins are extensively muxed with other signals. The Pin Mux Utility can ease the programming. See: www.ti.com/stellarispinmuxutility

Interrupts...
Interrupts and µDMA Operation

SSI Interrupts

- Single interrupt per module, cleared automatically
- Interrupt conditions:
  - Transmit FIFO service (when the transmit FIFO is half full or less)
  - Receive FIFO service (when the receive FIFO is half full or more)
  - Receive FIFO time-out
  - Receive FIFO overrun
  - End of transmission
  - Receive DMA transfer complete
  - Transmit DMA transfer complete

Interrupts on these conditions can be enabled individually
Your handler code must check to determine the source of the SSI interrupt and clear the flag(s)

SSI µDMA Operation

- Separate channels for Tx and Rx
- When enabled, the SSI will assert a DMA request on either channel when the Rx or Tx FIFO can transfer data
- For Rx channel: A single transfer request is made when any data is in the Rx FIFO. A burst transfer request is made when 4 or more items is in the Rx FIFO.
- For Tx channel: A single transfer request is made when there is at least one empty location in the Tx FIFO. A burst transfer request is made when 4 or more slots are empty.
Signal Formats

Freescale SPI Signal Formats

- Four wire interface. Full duplex.
- **SSIFss** acts as chip select.
- Inactive state and clock phasing are programmable via the **SPO** and **SPH** bits (SSI_FRF_MOTO_MODE_0-3 parameter).
  - **SPO** = 0: SSIClk low when inactive. **SPO** = 1: high
  - **SPH** = 0: Data is captured on 1st SSIClk transition. **SPH** = 1: 2nd

<table>
<thead>
<tr>
<th>SPO</th>
<th>SPH</th>
<th>Single Transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Single Transfer</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>Single Transfer</td>
</tr>
</tbody>
</table>

TI Synchronous Serial Signal Formats

- Three wire interface
- Devices are always slaves
- **SSIClk** and **SSIFss** are forced low and **SSITx** is tri-stated when the SSI is idle

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Single Transfer</th>
<th>Continuous Transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Microwire Signal Formats

- Four wire interface
- Similar to SPI, except transmission is half-duplex
- Master – Slave message passing technique

Single Transfer

Continuous Transfer
Lab 11: SPI Bus and the Olimex LED BoosterPack

Objective

In this lab you will use the Olimex LED BoosterPack to explore the capabilities and programming of the SPI bus on the SSI peripheral.
**Procedure**

**Hardware**

1. If you want to do this lab, you’re going to need a BoosterPack with a SPI connection. I chose the Olimex 8x8 LED BoosterPack: (https://www.olimex.com/Products/MSP430/Booster/MSP430-LED8x8-BOOSTERPACK/).

   This BoosterPack is also available from Mouser Electronics (http://www.mouser.com/new/olimex/olimexLED8x8/)

   The LED BoosterPack is cheap and fun, but there are two issues with it out of the box. The first is that it has male Molex pins rather than Molex female connectors. You can get two of these (http://www.mouser.com/ProductDetail/FCI/66951-010LF/?qs=sGAEpiMZZMs%252bGHln7q6pmxAVkKtOEC39jD0m1rF2xGE%3d) and solder them directly to the male pins. This way you can import, build and run the “faces” program located at C:\StellarisWare\boards\ek-lm4f120xl-boost-olimex-8x8

   This program is pretty cool but it has one little issue, which brings us back to the second problem with the Olimex BoosterPack. The pin-out on the Olimex BoosterPack does not match with any of the SSI module pin-sets on the Stellaris LaunchPad board (it actually matches an early version of the MSP430 LaunchPad).

   So the author of the “faces” program did what any good engineer would do, they made it work … with a software SPI port (SoftSSI). The programming of SoftSSI is virtually the same as programming the actual hardware, but for the purposes of this lab, that’s not good enough.

2. So we need to connect the pins on the Olimex BoosterPack to the female headers that will mount on top of the LaunchPad board. Any small perf-board will do, but Joe’s Bytes ( http://joesbytes.com/10-ti-msp430-launchpad-mini-proto-board.html ) has a nice proto-board that fits perfectly. I soldered the female headers on one side of the board in one direction and the Olimex BoosterPack on the other side with a 90 degree turn.
3. Comparing the Olimex BoosterPack schematic found at https://www.olimex.com/Products/MSP430/Booster/MSP430-LED8x8-BOOSTERPACK/resources/MSP430-LED-BOOSTERPACK-schematic.pdf to the Stellaris LaunchPad schematic, I came up with the following connections for the proto-board (There are a number of possible solutions here). Bear in mind that the correct way to number the BoosterPack pins is 1 to 10 from the top of the board to the bottom.

<table>
<thead>
<tr>
<th>Olimex Header Pin</th>
<th>Olimex Function</th>
<th>LaunchPad Header Pin</th>
<th>LM4F120H5QR Pin Name</th>
<th>Pin Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1-7</td>
<td>SR_SCK</td>
<td>J2-10</td>
<td>PA2</td>
<td>SSI0CLK</td>
</tr>
<tr>
<td>J1-6</td>
<td>SR_LATCH</td>
<td>J2-9</td>
<td>PA3</td>
<td>SSI0Fss</td>
</tr>
<tr>
<td>J2-7</td>
<td>SR_DATA_IN</td>
<td>J1-8</td>
<td>PA5</td>
<td>SSI0Tx</td>
</tr>
<tr>
<td>J1-2</td>
<td>A_IN</td>
<td>J2-3</td>
<td>PE0</td>
<td>AIN3</td>
</tr>
<tr>
<td>J1-3</td>
<td>BUZ_PIN1</td>
<td>J1-9</td>
<td>PA6</td>
<td>GPIO</td>
</tr>
<tr>
<td>J1-4</td>
<td>BUZ_PIN2</td>
<td>J1-10</td>
<td>PA7</td>
<td>GPIO</td>
</tr>
<tr>
<td>J2-1</td>
<td>Ground</td>
<td>J2-1</td>
<td>Ground</td>
<td>-</td>
</tr>
<tr>
<td>J1-1</td>
<td>Vcc</td>
<td>J1-1</td>
<td>Vcc</td>
<td>-</td>
</tr>
</tbody>
</table>

4. While you’ve got the Olimex BoosterPack schematic out, take a look at the circuit. You’ll see that the board is pretty simple; 16-bits of shift register, a Darlington seven transistor array (for drive strength) plus one more single transistor to make 8 and the 8x8 LED array. In order for the LEDs to light properly, the upper byte of the 16-bit word must be the bit-reversed version of the lower byte. That will be done in software.

Since this lab concerns the SPI port, we’re going to ignore the connections for the mic and buzzer.

**Faces Code**

5. If you have one of the Olimex Booster Packs and have connected the female headers to it, carefully connect it to your LaunchPad board. In Code Composer, import the faces project from C:\StellarisWare\boards\ek-lm4f120x1-boost-olimex-8x8 into your workspace. Build, load and run the project. Poke around in the code if you like, but we’ll go into detail building Lab11 that uses the SSI peripheral instead of the SoftSSI.

When you’re done, close the faces project.

Disconnect your LaunchPad board from the USB port, carefully remove the Olimix BoosterPack and re-connect your LaunchPad.
6. If you have a proto-board modified Olimex BoosterPack, carefully connect it to the LaunchPad with the expansion pins towards the top of the LaunchPad as shown below. You may need to bend the power measurement jumper out of the way slightly:

7. Maximize Code Composer. Import Lab11 with the settings shown below. Make sure the Copy projects into workspace checkbox is not checked and click Finish.
8. Expand the project and open `main.c` for editing. Place the following includes at the top of the file:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_ssi.h"
#include "inc/hw_types.h"
#include "driverlib/ssi.h"
#include "driverlib/gpio.h"
#include "driverlib/pin_map.h"
#include "driverlib/sysctl.h"
```

We’re going to need all the regular include files along with the ones that give us access to the SSI peripheral.

9. Skip a line for spacing and add the next three lines:

```c
#define NUM_SSI_DATA 8
const unsigned char ulDataTx[NUM_SSI_DATA] =
{0x88, 0xF8, 0xF8, 0x88, 0x01, 0x1F, 0x1F, 0x01};
unsigned short g_pusTxBuffer[16];
```

The “third” line is really part of the second one. This array of 8-bit numbers defines which of the LEDs in the array will be on or off in the following fashion, where red is on and the open circle is off. The last line defines our transmit buffer:

```
{A7-0, B7-0, C7-0, D7-0, E7-0, F7-0, G7-0, H7-0}
```

![LED array diagram]
10. Leave a line for spacing and add the following code. This code will take the 8-bit number from the array above and bit-reverse it front to back. Then those 8-bits will be concatenated (in the code that calls this function) with the original number to create a 16-bit number that will be sent over the SPI port.

// Bit-wise reverses a number.
unsigned char
Reverse(unsigned char ucNumber)
{
    unsigned short ucIndex;
    unsigned short ucReversedNumber = 0;
    for(ucIndex=0; ucIndex<8; ucIndex++)
    {
        ucReversedNumber = ucReversedNumber << 1;
        ucReversedNumber |= ((1 << ucIndex) & ucNumber) >> ucIndex;
    }
    return ucReversedNumber;
}

11. Leave a line for spacing and add the template for main() below:

    int main(void)
    {
    }

12. Insert the next two lines as the first ones in main(). We’ll need these variables for temporary data and index purposes.

    unsigned long ulindex;
    unsigned long ulData;

13. Leave a line for spacing and set the clock to 50MHz as we’ve done before:

    SysCtlClockSet(SYSCTL_SYSDIV_4 | SYSCTL_USE_PLL | SYSCTL_OSC_MAIN | SYSCTL_XTAL_16MHZ);

14. Space down a line and add the next two lines. Since SSI0 is on GPIO port A, we’ll need to enable both peripherals:

    SysCtlPeripheralEnable(SYSCTL_PERIPH_SSI0);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOA);

15. Space down a line and add the following four lines. These will configure the muxing and GPIO settings to bring the SSI functions out to the pins. Since the BoosterPack only accepts data, we won’t program the receive pin (pin 4).

    GPIOPinConfigure(GPIO_PA2_SSI0CLK);
    GPIOPinConfigure(GPIO_PA3_SSI0FSS);
    GPIOPinConfigure(GPIO_PA5_SSI0TX);
    GPIOPinTypeSSI(GPIO_PORTA_BASE,GPIO_PIN_5|GPIO_PIN_3|GPIO_PIN_2);
16. Next we need to configure the SPI port on SSI0 for the type of operation that we want. Given that there are two bits (SPH – clock polarity and SPO – idle state), there are four modes (0-3). Leave a line for spacing and add the next two lines after the last. Then double-click on `SSI_FRF_MOTO_MODE_0` and press F3 to see all four definitions in `ssi.h`:

```c
SSIDConfigSetExpClk(SSIO0_BASE, SysCtlClockGet(), SSI_FRF_MOTO_MODE_0, SSI_MODE_MASTER, 10000, 16);
SSIEnable(SSIO0_BASE);
```

The API specifies the SSI module, the clock source (this is hard wired), the mode, master or slave, the bit rate and the data width.

17. The LED array has no latch, so the data must be continuously streamed in order for a static image to appear. We’ll do that with a `while()` loop, so add a lines for spacing and then add the `while()` loop below:

```c
while(1)
{
}
```

18. We’re going to need to step through the data, sending each 16-bit word on at the time. Add the following `for()` construct inside the `while()` loop you just added:

```c
for(ulindex = 0; ulindex < NUM_SSI_DATA; ulindex++)
{
}
```

19. Place the five lines below inside the `for()` construct you just added. Those lines have these functions:

1) Create the 16-bit data word using the `Reverse()` function we added earlier
2) Place the data in the transmit FIFO using a blocking function (a non-blocking version is also available)
3) Wait until the data has been transmitted

```c
ulData = (Reverse(ulDataTx[ulindex]) << 8) + (1 << ulindex);
SSIDataPut(SSIO0_BASE, ulData);
while(SSIBusy(SSIO0_BASE))
{
}
```

Admittedly, this isn’t the most efficient technique. It would be less wasteful of CPU cycles to use the µDMA to perform these transfers, but we haven’t covered the µDMA yet.
Build and Load

20. Build and load the code. If you have errors, compare your main.c to the code below:

```c
#include "inc/hw_memmap.h"
#include "inc/hw_ssi.h"
#include "inc/hw_types.h"
#include "driverlib/ssi.h"
#include "driverlib/gpio.h"
#include "driverlib/pin_map.h"
#include "driverlib/sysctl.h"

#define NUM_SSI_DATA 8
const unsigned char ulDataTx[NUM_SSI_DATA] = 
{0x88, 0xF8, 0xF8, 0x88, 0x01, 0x1F, 0x1F, 0x01};
unsigned short g_pusTxBuffer[16];

// Bit-wise reverses a number.
unsigned char Reverse(unsigned char ucNumber)
{
    unsigned short ucIndex;
    unsigned short ucReversedNumber = 0;
    for(ucIndex=0; ucIndex<8; ucIndex++)
    {
        ucReversedNumber = ucReversedNumber << 1;
        ucReversedNumber |= ((1 << ucIndex) & ucNumber) >> ucIndex;
    }
    return ucReversedNumber;
}

int main(void)
{
    unsigned long ulindex;
    unsigned long ulData;
    SysCtlClockSet(SYSCTL_SYSDIV_4 | SYSCTL_USE_PLL | SYSCTL_OSC_MAIN | SYSCTL_XTAL_16MHZ);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_SSI0);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOA);
    GPIOPinConfigure(GPIO_PA2_SSI0CLK);
    GPIOPinConfigure(GPIO_PA3_SSI0FSS);
    GPIOPinConfigure(GPIO_PA5_SSI0TX);
    GPIOPinTypeSSI(GPIO_PORTA_BASE, GPIO_PIN_5 | GPIO_PIN_3 | GPIO_PIN_2);
    SSIConfigSetExpClk(SSI0_BASE, SysCtlClockGet(), SSI_FRF_MOTO_MODE_0, SSI_MODE_MASTER, 10000, 16);
    SSIEnable(SSI0_BASE);
    while(1)
    {
        for(ulindex = 0; ulindex < NUM_SSI_DATA; ulindex++)
        {
            ulData = (Reverse(ulDataTx[ulindex]) << 8) + (1 << ulindex);
            SSIDataPut(SSI0_BASE, ulData);
            while(SSIBusy(SSI0_BASE))
            {
            }
        }
    }
}
```

If you’re still having problems you can find this code in the Lab11/ccs folder as main.txt.
Run and Test

21. Run the code by clicking the Resume button. You should see “TI” displayed on the LED array. If you like you can play with the data structure to draw something different. Keep it clean.

22. If you have a SPI protocol analyzer, now would be a good time to dust it off and take a look at the serial data stream. These analyzers can save weeks troubleshooting communication problems. The screen captures on the next page were taken with a Saleae Logic8 logic analyzer/communications analyzer made by Saleae LLC (www.saleae.com) Beware of counterfeits!

23. When you’re done, click the Terminate button to return to the CCS Edit perspective.

24. Right-click on Lab11 in the Project Explorer pane and close the project.

25. Disconnect your LaunchPad board from the USB port, carefully remove the Olimex BoosterPack and re-connect your LaunchPad.


You’re done.
Introduction

This chapter will introduce you to the capabilities of the Universal Asynchronous Receiver/Transmitter (UART). The lab uses the LaunchPad board and the Stellaris Virtual Serial Port running over the debug USB port.

Agenda

Introduction to ARM® Cortex™-M4F and Peripherals
Code Composer Studio
Introduction to StellarisWare, Initialization and GPIO
Interrupts and the Timers
ADC12
Hibernation Module
USB
Memory
Floating-Point
BoosterPacks and grLib
Synchronous Serial Interface

UART
µDMA
Chapter Topics

UART .......................................................................................................................................... 12-1
  UART Features and Block Diagram ..................................................................................... 12-3
  Basic Operation ................................................................................................................ 12-4
  UART Interrupts and FIFOs ............................................................................................... 12-5
  UART "stdio" Functions and Other Features ................................................................ 12-6
  Lab 12 .............................................................................................................................. 12-7
  Objective ......................................................................................................................... 12-7
UART Features and Block Diagram

UART Features

- Separate 16x8 bit transmit and receive FIFOs
- Programmable baud rate generator
- Auto generation and stripping of start, stop, and parity bits
- Line break generation and detection
- Programmable serial interface
  - 5, 6, 7, or 8 data bits
  - even, odd, stick, or no parity bits
  - 1 or 2 stop bits
  - baud rate generation, from DC to processor clock/16
- Modem control/flow control
- IrDA and EIA-495 9-bit protocols
- µDMA support

Block Diagram
Basic Operation

- Initialize the UART
  - Enable the UART peripheral, e.g.
    ```c
    SysCtlPeripheralEnable(SYSCTL_PERIPH_UART0);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOA);
    ```
  - Set the Rx/Tx pins as UART pins
    ```c
    GPIOPinConfigure(GPIO_PA0_U0RX);
    GPIOPinConfigure(GPIO_PA1_U0TX);
    GPIOPinTypeUART(GPIO_PORTA_BASE, GPIO_PIN_0 | GPIO_PIN_1);
    ```
  - Configure the UART baud rate, data configuration
    ```c
    ROM_UARTConfigSetExpClk(UART0_BASE, ROM_SysCtlClockGet(), 115200,
    UART_CONFIG_WLEN_8 | UART_CONFIG_STOP_ONE |
    UART_CONFIG_PAR_NONE));
    ```
- Configure other UART features (e.g. interrupts, FIFO)
- Send/receive a character
  - Single register used for transmit/receive
  - Blocking/non-blocking functions in driverlib:
    ```c
    UARTCharPut(UART0_BASE, 'a');
    newchar = UARTCharGet(UART0_BASE);
    UARTCharPutNonBlocking(UART0_BASE, 'a');
    newchar = UARTCharGetNonBlocking(UART0_BASE);
    ```

Interrupts...
UART Interrupts and FIFOs

UART Interrupts

Single interrupt per module, cleared automatically

Interrupt conditions:
- Overrun error
- Break error
- Parity error
- Framing error
- Receive timeout – when FIFO is not empty and no further data is received over a 32-bit period
- Transmit – generated when no data present (if FIFO enabled, see next slide)
- Receive – generated when character is received (if FIFO enabled, see next slide)

Interrupts on these conditions can be enabled individually
Your handler code must check to determine the source of the UART interrupt and clear the flag(s)

FIFOs...

Using the UART FIFOs

Both FIFOs are accessed via the UART Data register (UARTDR)
- After reset, the FIFOs are enabled*, you can disable by resetting the FEN bit in UARTLCRH, e.g.
  `UARTFIFODisable(UART0_BASE);`
- Trigger points for FIFO interrupts can be set at 1/8, 1/4, 1/2, 3/4, 7/8 full, e.g.
  `UARTFIFOLevelSet(UART0_BASE, UART_FIFO_RX4_8, UART_FIFO_TX4_8, UART_FIFO_RX7_8);`

* Note: the datasheet says FIFOs are disabled at reset

stdio Functions...
UART “stdio” Functions and Other Features

UART “stdio” Functions

- StellarisWare “utils” folder contains functions for C stdio console functions:
  
  c:\StellarisWare\utils\uartstdio.h
  c:\StellarisWare\utils\uartstdio.c

- Usage example:
  
  UARTStdioInit(0); //use UART0, 115200
  UARTprintf("Enter text: ");

- See uartstdio.h for other functions

Notes:

- Use the provided interrupt handler UARTStdioIntHandler() code in uartstdio.c
- Buffering is provided if you define UART_BUFFERED symbol
  
  - Receive buffer is 128 bytes
  - Transmit buffer is 1024 bytes

Other UART Features

- Modem control/flow control
- IrDA serial IR (SIR) encoder/decoder
  
  - External infrared transceiver required
  - Supports half-duplex serial SIR interface
  - Minimum of 10-ms delay required between transmit/receive, provided by software
- ISA 7816 smartcard support
  
  - UnTX signal used as a bit clock
  - UnRx signal is half-duplex communication line
  - GPIO pin used for smartcard reset, other signals provided by your system design
- LIN (Local Interconnect Network) support: master or slave
- µDMA support
  
  - Single or burst transfers support
  - UART interrupt handler handles DMA completion interrupt
- EIA-495 9-bit operation
  
  - Multi-drop configuration: one master, multiple slaves
  - Provides “address” bit (in place of parity bit)
  - Slaves only respond to their address

Lab...
Lab 12

Objective

In this lab you will use the LaunchPad board, and the virtual serial port that runs over the debug USB cable.

Lab 12: UART

- Initialize UART and echo characters using polling
- Use interrupts
- Use stdio utility, e.g. UARTprintf()
Procedure

Import Lab12

1. We have already created the Lab12 project for you with a `main.c` file, a startup file, and all the necessary project and build options set. Maximize Code Composer and click Project → Import Existing CCS Eclipse Project. Make the settings shown below and click Finish. Make sure that the “Copy projects into workspace” checkbox is unchecked.

![Import CCS Eclipse Projects dialog]

2. Expand the project by clicking on the + or ↩ next to Lab12 in the Project Explorer pane. Double-click on `main.c` to open it for review. The code looks like the next page:
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/gpio.h"
#include "driverlib/pin_map.h"
#include "driverlib/sysctl.h"
#include "driverlib/uart.h"

int main(void) {
    SysCtlClockSet(SYSCTL_SYSDIV_4 | SYSCTL_USE_PLL | SYSCTL_OSC_MAIN | SYSCTL_XTAL_16MHZ);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_UART0);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOA);
    GPIOPinConfigure(GPIO_PA0_U0RX);
    GPIOPinConfigure(GPIO_PA1_U0TX);
    GPIOPinTypeUART(GPIO_PORTA_BASE, GPIO_PIN_0 | GPIO_PIN_1);
    UARTConfigSetExpClk(UART0_BASE, SysCtlClockGet(), 115200,
        (UART_CONFIG_WLEN_8 | UART_CONFIG_STOP_ONE | UART_CONFIG_PAR_NONE));
    UARTCharPut(UART0_BASE, 'E');
    UARTCharPut(UART0_BASE, 'n');
    UARTCharPut(UART0_BASE, 't');
    UARTCharPut(UART0_BASE, 'e');
    UARTCharPut(UART0_BASE, 'r');
    UARTCharPut(UART0_BASE, ' ');
    UARTCharPut(UART0_BASE, 'T');
    UARTCharPut(UART0_BASE, 'e');
    UARTCharPut(UART0_BASE, 'x');
    UARTCharPut(UART0_BASE, ':');
    UARTCharPut(UART0_BASE, ' ');
    while (1) {
        if (UARTCharsAvail(UART0_BASE)) UARTCharPut(UART0_BASE, UARTCharGet(UART0_BASE));
    }
}

3. In `main()`, notice the initialization sequence for using the UART:
   - Set up the system clock
   - Enable the UART0 and GPIOA peripherals (the UART pins are on GPIO Port A)
   - Configure the pins for the receiver and transmitter using GPIOPinConfigure
   - Initialize the parameters for the UART: 115200, 8-1-N
   - Use simple "UARTCharPut()" calls to create a prompt.
   - An infinite loop. In this loop, if there is a character in the receiver, it is read, and then written to the transmitter. This echos what you type in the terminal window.

**Build, Download, and Run the UART Example Code**

4. Click the Debug button to build and download your program to the LM4F120H5QR memory.

5. We can communicate with the board through the UART. The UART is connected as a virtual serial port through the emulator USB connection. You can find the COM port number for this serial port back in chapter one of this workbook on page 18 or 19.
6. **In WinXP**, open HyperTerminal by clicking Start → Run…, then type `hypertrm` in the Open: box and click OK. Pick any name you like for your connection and click OK. In the next dialog box, change the Connect using: selection to COM##, where ## is the COM port number you noted earlier from Device Manager. Click OK. Make the selections shown below and click OK.

   ![HyperTerminal Settings](image)

   When the terminal window opens click the Resume button in CCS, then type some characters and you should see the characters echoed into the terminal window. Skip to step 8.

7. **In Win7**, double-click on `putty.exe`. Make the settings shown below and then click Open. Your COM port number will be the one you noted earlier in chapter one.

   ![PuTTY Configuration](image)

   When the terminal window opens click the Resume button in CCS, then type some characters and you should see the characters echoed into the terminal window.
**Using UART Interrupts**

Instead of continually polling for characters, we’ll make some modifications to our code to allow the use of interrupts to receive and transmit characters. In the first part of this lab, the only indication we had that our code was running was to open the terminal window to type characters and see them echoed back. In this part of the lab, we’ll add a visual indicator to show that we received and transmitted a character. So we’ll need to add code similar to previous labs to blink the LED inside the interrupt handler.

8. First, let’s add the code in `main()` to enable the UART interrupts we want to handle. Click on the Terminate button to return to the CCS Edit perspective. We need to add two additional header files at the top of the file:

```c
#include "inc/hw_ints.h"
#include "driverlib/interrupt.h"
```

9. Now we need to add the code to enable processor interrupts, then enable the UART interrupt, and then select which individual UART interrupts to enable. We will select receiver interrupts (RX) and receiver timeout interrupts (RT). The receiver interrupt is generated when a single character has been received (when FIFO is disabled) or when the specified FIFO level has been reached (when FIFO is enabled). The receiver timeout interrupt is generated when a character has been received, and a second character has not been received within a 32-bit period. Add the following code just below the `UARTConfigSetExpClk()` function call:

```c
IntMasterEnable();
IntEnable(INT_UART0);
UARTIntEnable(UART0_BASE, UART_INT_RX | UART_INT_RT);
```

10. We also need to initialize the GPIO peripheral and pin for the LED. Just before the function `UARTConfigSetExpClk()` is called, add these two lines:

```c
SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_2);
```

11. Finally, we can create an empty `while(1)` loop at the end of main by commenting out the line of code that’s already there:

```c
while (1) {
    if (UARTCharsAvail(UART0_BASE)) UARTCharPut(UART0_BASE,UARTCharGet(UART0_BASE));
}
```

12. Save the changes you made to `main.c` (but leave it open for making additional edits).
13. Now we need to write the UART interrupt handler. The interrupt handler needs to read the UART interrupt status register to know which specific interrupt event(s) just occurred. This value is then used to clear the interrupt status bits (we only enabled RX and RT interrupts, so those are the only possible sources for the interrupt). The next step is to receive and transmit all the characters that have been received. After each character is “echoed” to the terminal, the LED is blinked for about 1 millisecond. Insert this code below the include statements and above main():

```c
void UARTIntHandler(void)
{
    unsigned long ulStatus;

    ulStatus = UARTIntStatus(UART0_BASE, true); //get interrupt status
    UARTIntClear(UART0_BASE, ulStatus); //clear the asserted interrupts

    while(UARTCharsAvail(UART0_BASE)) //loop while there are chars
    {
        UARTCharPutNonBlocking(UART0_BASE, UARTCharGetNonBlocking(UART0_BASE));
        //echo character
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, GPIO_PIN_2); //blink LED
        SysCtlDelay(SysCtlClockGet() / (1000 * 3)); //delay ~1 msec
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, 0); //turn off LED
    }
}
```

14. We're almost done. We've added all the code we need. The final step is to insert the address of the UART interrupt handler into the interrupt vector table. To do this, open up the `startup_ccs.c` file. Just below the prototype for `_c_int00(void)`, add the UART interrupt handler prototype:

```c
extern void UARTIntHandler(void);
```

15. On about line 68, you'll find the interrupt vector table entry for "UART0 Rx and Tx". It's just below the entry for "GPIO Port E". The default interrupt handler is named IntDefaultHandler. All we need to do is replace this name with UARTIntHandler so the line looks like:

```c
UARTIntHandler,                      // UART0 Rx and Tx
```
16. Save your work. Your main.c code should look like this.

```c
#include "inc/hw_ints.h"
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/gpio.h"
#include "driverlib/interrupt.h"
#include "driverlib/pin_map.h"
#include "driverlib/sysctl.h"
#include "driverlib/uart.h"

void UARTIntHandler(void)
{
    unsigned long ulStatus;

    ulStatus = UARTIntStatus(UART0_BASE, true); //get interrupt status
    UARTIntClear(UART0_BASE, ulStatus); //clear the asserted interrupts

    while(UARTCharsAvail(UART0_BASE)) //loop while there are chars
    {
        UARTCharPutNonBlocking(UART0_BASE, UARTCharGetNonBlocking(UART0_BASE)); //echo character
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, GPIO_PIN_2); //blink LED
        SysCtlDelay(SysCtlClockGet() / (1000 * 3)); //delay ~1 msec
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, 0); //turn off LED
    }
}

int main(void) {

    SysCtlClockSet(SYSCTL_SYSDIV_4 | SYSCTL_USE_PLL | SYSCTL_OSC_MAIN | SYSCTL_XTAL_16MHZ);

    SysCtlPeripheralEnable(SYSCTL_PERIPH_UART0);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOA);

    GPIOPinConfigure(GPIO_PA0_U0RX);
    GPIOPinConfigure(GPIO_PA1_U0TX);
    GPIOPinTypeUART(GPIO_PORTA_BASE, GPIO_PIN_0 | GPIO_PIN_1);

    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF); //enable GPIO port for LED
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_2); //enable pin for LED PF2

    UARTConfigSetExpClk(UART0_BASE, SysCtlClockGet(), 115200,
        (UART_CONFIG_WLEN_8 | UART_CONFIG_STOP_ONE | UART_CONFIG_PAR_NONE));

    IntMasterEnable(); //enable processor interrupts
    IntEnable(INT_UART0); //enable the UART interrupt
    UARTIntEnable(UART0_BASE, UART_INT_RX | UART_INT_RT); //only enable RX and TX interrupts

    UARTCharPut(UART0_BASE, 'E');
    UARTCharPut(UART0_BASE, 'n');
    UARTCharPut(UART0_BASE, 't');
    UARTCharPut(UART0_BASE, 'e');
    UARTCharPut(UART0_BASE, 'r');
    UARTCharPut(UART0_BASE, ' ');
    UARTCharPut(UART0_BASE, 'T');
    UARTCharPut(UART0_BASE, 'e');
    UARTCharPut(UART0_BASE, 'x');
    UARTCharPut(UART0_BASE, 't');
    UARTCharPut(UART0_BASE, ':');
    UARTCharPut(UART0_BASE, '.');

    while (1) //let interrupt handler do the UART echo function
    {
        if (UARTCharsAvail(UART0_BASE)) UARTCharPut(UART0_BASE, UARTCharGet(UART0_BASE));
    }
}
```
17. Click the Debug button to build and download your program to the LM4F120H5QR memory.
18. If you've closed it, open Hyperterminal or puTTY, and configure it as before.
19. Click the Resume button. Type some characters and you should see the characters echoed into the terminal window. Note the LED.
Add Formatting, Enable FIFOs, use UARTprintf

20. In these final steps, we’ll add some formatting to make our terminal window a little better behaved. When a “CR” carriage return character is received (Enter key), we can detect that and also echo a “LF” line feed character. CR is character 13 decimal, LF is 10 decimal. To do this we can’t simply echo the character in the interrupt handler. We need to read the character into a variable, echo it, then test to see if it was “CR” and issue the “LF”. Click the Terminate button to return to the CCS Edit perspective. In main.c, look in UARTIntHandler, and replace the single line that calls UARTCharPutNonBlocking() with these lines of code:

```c
received_character = UARTCharGet(UART0_BASE);
UARTCharPutNonBlocking(UART0_BASE, received_character); //echo character
if (received_character == 13) UARTCharPutNonBlocking(UART0_BASE, 10);
```

21. The variable `received_character` must be defined as well. Just below the variable declaration for `ulStatus`, insert this line:

```c
unsigned char received_character;
```

22. To enable the FIFOs, add these lines in main() just after the call to UARTConfigSetExpClk():

```c
UARTFIFOLevelSet(UART0_BASE, UART_FIFO_TX4_8, UART_FIFO_RX4_8); // FIFO 8 chars
UARTFIFOEnable(UART0_BASE); //enable FIFOs
```

23. The final step is to experiment with UARTprintf(). There are some stdio console functions defined in the StellarisWare/utils folder. To create the “Enter Text:” prompt we can use a simple function call to UARTprintf(). We can also clean up the formatting within the terminal window using ANSI escape sequences. We’ll use two of these, one to erase the screen, the other to return the cursor to the (0,0) upper left corner of the screen. For more information on ANSI escape sequences, go to http://ascii-table.com/. We need a header file, so add the following line:

```c
#include "utils/uartstdio.h"
```

24. We can replace the simple prompt created in the previous code. Remove all 12 calls to UARTCharPut(). Then add these two lines of code in their place:

```c
UARTStdioInit(0); //tells uartstdio functions to use UART0
UARTprintf("\033[2J\033[HEnter Text: "); //erase screen, cursor at (0,0)
```

**Note:** When using UARTStdio functions, please see the the uartstdio.c file to understand how the buffers work, whether or not FIFOs are enabled, and especially notice that there is a UART interrupt handler provided there that works differently than the one we’re using in this example. The two function calls we used here seem to work o.k. but other functions may not work as documented unless you define the proper symbols, e.g. UART_BUFFERED, and provide the proper interrupt vector

25. Save your work. Your code should look like this.
```
#include "inc/hw_ints.h"
#include "inc/hw_memmap.h"
#include "inc/hw_types.h"
#include "driverlib/gpio.h"
#include "driverlib/interrupt.h"
#include "driverlib/pin_map.h"
#include "driverlib/sysctl.h"
#include "driverlib/uart.h"
#include "utils/uartstdio.h"

void UARTIntHandler(void)
{
    unsigned long ulStatus;
    unsigned char received_character;
    ulStatus = UARTIntStatus(UART0_BASE, true); // get interrupt status
    UARTIntClear(UART0_BASE, ulStatus); // clear the asserted interrupts
    while(UARTCharsAvail(UART0_BASE)) // loop while there are characters in the receive FIFO
    {
        received_character = UARTCharGet(UART0_BASE);
        UARTCharPutNonBlocking(UART0_BASE, received_character); // echo character
        if (received_character == 13) UARTCharPutNonBlocking(UART0_BASE, 10); // if CR received, issue LF as well
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, GPIO_PIN_2); // blink LED
        SysCtlDelay(SysCtlClockGet() / (1000 * 3)); // delay ~1 msec
        GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, 0); // turn off LED
    }
}

int main(void) {
    SysCtlClockSet(SYSCTL_SYSDIV_4 | SYSCTL_USE_PLL | SYSCTL_OSC_MAIN | SYSCTL_XTAL_16MHZ);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_UART0);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOA);
    GPIOPinConfigure(GPIO_PA0_U0RX);
    GPIOPinConfigure(GPIO_PA1_U0TX);
    GPIOPinTypeUART(GPIO_PORTA_BASE, GPIO_PIN_0 | GPIO_PIN_1);
    SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF); // enable GPIO port for LED
    GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_2); // enable pin for LED PF2
    UARTConfigSetExpClk(UART0_BASE, SysCtlClockGet(), 115200, (UART_CONFIG_WLEN_8 | UART_CONFIG_STOP_ONE | UART_CONFIG_PAR_NONE));
    UARTFIFOLevelSet(UART0_BASE, UART_FIFO_TX4_8, UART_FIFO_RX4_8); // set FIFO level to 8 characters
    UARTFIFOEnable(UART0_BASE); // enable FIFOs
    IntMasterEnable(); // enable processor interrupts
    IntEnable(INT_UART0); // enable the UART interrupt
    UARTIntEnable(UART0_BASE, UART_INT_RX | UART_INT_RT); // enable Receiver interrupts
    UARTstdioInit(0); // tells uartstdio functions to use UART0
    UARTprintf("\033[2J\033[HEnter Text: "); // erase screen, put cursor at home position (0,0), prompt
    while (1) // let interrupt handler do the UART echo function
    {
        if (UARTCharsAvail(UART0_BASE)) UARTCharPut(UART0_BASE, UARTCharGet(UART0_BASE));
    }
}
```
26. Before we can compile/build this example, we need to add the `uartstdio.c` file from the `utils` folder into our project. Click on Project → Add files…. Then navigate to `c:\StellarisWare\utils` and select `uartstdio.c`. Then click Open.

When you are asked how to import the file, make the selections below and click OK.
27. You can create folders within your project to organize the added files and make things easier to understand. Right-click on Lab12 and select New -> Folder. Name the folder utils and click Finish. You can then drag uartstdio.c to the utils folder in your Project Explorer.

28. Click the Debug button to build and download your program to the LM4F120H5QR memory.

29. If you've closed it, open Hyperterminal or puTTY, and set it up as before.

30. Click the Resume button. You should now see the prompt to enter some text at the top left corner of the terminal window. Type some characters and you should see the characters echoed into the terminal window. When you press the “Enter” key (carriage return), you should now see the line feed character issues as well.

31. At this point you may be wondering why you don’t see any effects of turning on the FIFOs. It appears that the characters are still being received and transmitted one at a time. In fact, we’re still getting RT (receiver timeout) interrupts because we’re just entering characters from the terminal very slowly, compared to a continuous stream of characters. If you want to experiment with the FIFO, you could try a couple of additional things. First, don’t enable RT interrupts, only enable RX interrupts. If you have the FIFO level set to 8 characters as we did in our code, you will need to enter 8 characters before they are all echoed back to you. The interrupt occurs after at least 8 characters have been received in the FIFO. You could also experiment with setting the FIFO levels to 2 characters, 4 characters, 12 characters, 14 characters. Have fun.

32. Close puTTY or HyperTerminal. Click the Terminate button to return to the CCS Edit perspective. Close the Lab12 project and minimize Code Composer Studio.

You’re done.
Introduction

This chapter will introduce you to the micro DMA (µDMA) peripheral on Stellaris devices. In the lab we’ll experiment with the µDMA transfers in memory and to/from the UART.

Agenda

Introduction to ARM® Cortex™-M4F and Peripherals
Code Composer Studio
Introduction to StellarisWare, Initialization and GPIO
Interrupts and the Timers
ADC12
Hibernation Module
USB
Memory
Floating-Point
Booster Packs and grLib
Synchronous Serial Interface
UART
µDMA
Chapter Topics

µDMA........................................................................................................................................................13-1

 Chapter Topics........................................................................................................................................13-2
 Features and Transfer Types ....................................................................................................................13-3
 Block Diagram and Channel Assignment ...............................................................................................13-4
 Channel Configuration ..........................................................................................................................13-5
 Lab 12: µDMA.......................................................................................................................................13-7
 Objective............................................................................................................................................13-7
 Procedure...............................................................................................................................................13-8
Features and Transfer Types

µDMA Features

- 32 channels
- SRAM to SRAM, SRAM to peripheral and peripheral to SRAM transfers (no Flash or ROM transfers are possible)
- Basic, Auto (transfer completes even if request is removed), Ping-Pong and Scatter-gather (via a task list)
- Two priority levels
- 8, 16 and 32-bit data transfer sizes
- Transfer sizes of 1 to 1024 elements (in binary steps)
- CPU bus accesses outrank DMA controller
- Source and destination address increment sizes: size of element, half-word, word, no increment
- Interrupt on transfer completion (per channel)
- Hardware and software triggers
- Single and Burst requests
- Each channel can specify a minimum # of transfers before relinquishing to a higher priority transfer. Known as “Burst” or “Arbitration”

Transfer Types

Basic
- Single to Single
- Single to Array
- Array to Single
- Array to Array

Auto
- Same as Basic but the transfer completes even if the request is removed

Ping-Pong
- Single to Array (and vice-versa). Normally used to stream data from a peripheral to memory. When the PING array is full the µDMA switches to the PONG array, freeing the PING array for use by the program.

Scatter-Gather
- Many Singles to an Array (and vice-versa). May be used to read elements from a data stream or move objects in a graphics memory frame.
µDMA Block Diagram

µDMA Channels
- Each channel has 5 possible assignments made in the DMACHMAPn register

<table>
<thead>
<tr>
<th>Channel</th>
<th>Peripheral</th>
<th>Type</th>
<th>Channel</th>
<th>Peripheral</th>
<th>Type</th>
<th>Channel</th>
<th>Peripheral</th>
<th>Type</th>
<th>Channel</th>
<th>Peripheral</th>
<th>Type</th>
<th>Channel</th>
<th>Peripheral</th>
<th>Type</th>
<th>Channel</th>
<th>Peripheral</th>
<th>Type</th>
<th>Channel</th>
<th>Peripheral</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>GPIO</td>
<td>B</td>
<td>4</td>
<td>GPIO</td>
<td>B</td>
<td>8</td>
<td>GPIO</td>
<td>B</td>
<td>12</td>
<td>GPIO</td>
<td>B</td>
<td>16</td>
<td>GPIO</td>
<td>B</td>
<td>20</td>
<td>GPIO</td>
<td>B</td>
<td>24</td>
<td>GPIO</td>
<td>B</td>
</tr>
<tr>
<td>1</td>
<td>GPIO</td>
<td>B</td>
<td>5</td>
<td>GPIO</td>
<td>B</td>
<td>9</td>
<td>GPIO</td>
<td>B</td>
<td>13</td>
<td>GPIO</td>
<td>B</td>
<td>17</td>
<td>GPIO</td>
<td>B</td>
<td>21</td>
<td>GPIO</td>
<td>B</td>
<td>25</td>
<td>GPIO</td>
<td>B</td>
</tr>
<tr>
<td>2</td>
<td>GPIO</td>
<td>B</td>
<td>6</td>
<td>GPIO</td>
<td>B</td>
<td>10</td>
<td>GPIO</td>
<td>B</td>
<td>14</td>
<td>GPIO</td>
<td>B</td>
<td>18</td>
<td>GPIO</td>
<td>B</td>
<td>22</td>
<td>GPIO</td>
<td>B</td>
<td>26</td>
<td>GPIO</td>
<td>B</td>
</tr>
<tr>
<td>3</td>
<td>GPIO</td>
<td>B</td>
<td>7</td>
<td>GPIO</td>
<td>B</td>
<td>11</td>
<td>GPIO</td>
<td>B</td>
<td>15</td>
<td>GPIO</td>
<td>B</td>
<td>19</td>
<td>GPIO</td>
<td>B</td>
<td>23</td>
<td>GPIO</td>
<td>B</td>
<td>27</td>
<td>GPIO</td>
<td>B</td>
</tr>
</tbody>
</table>

S = Single
B = Burst
SB = Both

Configuration...
Channel Configuration

- Channel control is done via a set of control structures in a table.
- The table must be located on a 1024-byte boundary.
- Each channel can have one or two control structures; a primary and an alternate.
- The primary structure is for BASIC and AUTO transfers. Alternate is for Ping-Pong and Scatter-gather.

### Control Structure Memory Map

<table>
<thead>
<tr>
<th>Offset</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0</td>
<td>0, Primary</td>
</tr>
<tr>
<td>0x10</td>
<td>1, Primary</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>0x1F9</td>
<td>31, Primary</td>
</tr>
<tr>
<td>0x200</td>
<td>0, Alternate</td>
</tr>
<tr>
<td>0x210</td>
<td>1, Alternate</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>0x3F3</td>
<td>31, Alternate</td>
</tr>
</tbody>
</table>

### Channel Control Structure

<table>
<thead>
<tr>
<th>Offset</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x000</td>
<td>Source End Pointer</td>
</tr>
<tr>
<td>0x004</td>
<td>Destination End Pointer</td>
</tr>
<tr>
<td>0x008</td>
<td>Control Word</td>
</tr>
<tr>
<td>0x00C</td>
<td>Unused</td>
</tr>
</tbody>
</table>

**Control word contains:**
- Source and Dest data sizes
- Source and Dest addr increment size
- # of transfers before bus arbitration
- Total elements to transfer
- Useburst flag
- Transfer mode
Lab 13: µDMA

Objective

In this lab you will experiment with the µDMA, transferring arrays of data in memory and then transferring data to and from the UART.

Lab 13: Transferring Data with the µDMA

- Perform an array to array memory transfer
- Transfer data to and from the UART

USB Emulation Connection

Wrap-up ...
Procedure

Import Lab13

1. We have already created the Lab13 project for you with main.c, a startup file and all necessary project and build options set. Maximize Code Composer and click Project → Import Existing CCS Eclipse Project. Make the settings shown below and click Finish. Make sure that the “Copy projects into workspace” checkbox is unchecked.
Browse the Code

2. In order to save some time, we’re going to browse this existing code rather than enter it line by line. Open main.c in the editor pane and we’ll get started. If you accidentally make a change, this code is also in main1.txt in the Lab13\ccs folder.

This code is actually a stripped-down version of the uDMA_demo example in C:\StellarisWare\boards\ek-lm4f120xl. To make things a little simpler the UART portion of the code was removed.

At the top of the code you’ll find all the normal includes, especially udma.h since we’ll be using that peripheral.

3. Just under includes are the definitions for the source and destination buffers, two error counter variables and a counter to track the number of transfers.

```c
#define MEM_BUFFER_SIZE 1024
static unsigned long g_u1SrcBuf[MEM_BUFFER_SIZE];
static unsigned long g_u1DstBuf[MEM_BUFFER_SIZE];
static unsigned long g_uluDMAErrCount = 0;
static unsigned long g_ulBadISR = 0;
static unsigned long g_ulMemXferCount = 0;
```

4. Below that, the µDMA control table is defined. Remember that the table must be aligned to a 1024-byte boundary. The #pragma will do that for us. If you are using a different IDE, this construct may be different. The table probably doesn’t need to be 1K in length, but that’s fine for this example.

```c
#pragma DATA_ALIGN(ucControlTable, 1024)
unsigned char ucControlTable[1024];
```

5. Below the control table definition is the library error handler that we’ve covered earlier. Next is the µDMA error handler code. If the µDMA controller encounters a bus or memory protection error as it attempts to perform a data transfer, it disables the µDMA channel that caused the error and generates an interrupt on the µDMA error interrupt vector. The handler here will clear the error and increment the error count.

```c
void uDMAErrorHandler(void)
{
    unsigned long ulStatus;
    ulStatus = ROM_uDMAErrorStatusGet();

    if(ulStatus)
    {
        ROM_uDMAErrorStatusClear();
        g_uluDMAErrCount++;
    }
}
```
6. Below the error handler is the µDMA interrupt handler. The interrupt that runs this handler is triggered by the completion of the programmed transfer. The code first checks to see if the µDMA channel is in stop mode. If it is, the transfer count is incremented, the µDMA is set up for another transfer and the next transfer is triggered. If this interrupt was triggered in error, the bad ISR variable will be incremented.

The last two lines inside the if() trigger the second and every subsequent µDMA request.

```c
void uDMAIntHandler(void)
{
    unsigned long ulMode;

    ulMode = ROM_uDMAChannelModeGet(UDMA_CHANNEL_SW);
    if(ulMode == UDMA_MODE_STOP)
    {
        g_ulMemXferCount++;
        ROM_uDMAChannelTransferSet(UDMA_CHANNEL_SW, UDMA_MODE_AUTO,
                                   g_ulSrcBuf, g_ulDstBuf, MEM_BUFFER_SIZE);

        ROM_uDMAChannelEnable(UDMA_CHANNEL_SW);
        ROM_uDMAChannelRequest(UDMA_CHANNEL_SW);
    }
    else
    {
        g_ulBadISR++;
    }
}
```
7. Next is the `InitSWTransfer()` function. This code initializes the µDMA software channel to perform a memory to memory transfer. We’ll be triggering these transfers from software, so we’ll use the software µDMA channel (`UDMA_CHANNEL_SW`).

The `for()` construct at the top initializes the source array with a simple pattern.

The next line enables the µDMA interrupt to the NVIC.

The next line disables the listed attributes of the software µDMA channel so that it’s in a known state.

The `ROM_uDMAChannelControlSet()` API sets up the control parameters for the software channel µDMA control structure. Notice that we’ll be using the primary (not the alternate set) and that the element size and increment sizes are 32-bits. The arbitration count is 8.

The `ROM_uDMAChannelTransferSet()` API sets up the transfer parameters for the software channel µDMA control structure. Again, this is for the primary set, auto mode (continue transfer until completion even if request is removed … common for software requests), the source and destination buffer addresses and the size of the transfer.

Finally, the code enables the software channel and makes the first µDMA request.

```c
void InitSWTransfer(void)
{
    unsigned int uIdx;

    for(uIdx = 0; uIdx < MEM_BUFFER_SIZE; uIdx++)
        g_ulSrcBuf[uIdx] = uIdx;

    ROM_IntEnable(INT_UDMA);

    ROM_uDMAChannelControlSetAttributeDisable(UDMA_CHANNEL_SW,
                                             UDMA_ATTR_USEBURST | UDMA_ATTR_ALTSELECT |
                                             (UDMA_ATTR_HIGH_PRIORITY |
                                             UDMA_ATTR_REQMASK));

    ROM_uDMAChannelControlSet(UDMA_CHANNEL_SW | UDMA_PRI_SELECT,
                              UDMA_SIZE_32 | UDMA_SRC_INC_32 | UDMA_DST_INC_32 |
                              UDMA_ARB_8);

    ROM_uDMAChannelTransferSet(UDMA_CHANNEL_SW | UDMA_PRI_SELECT,
                               UDMA_MODE_AUTO, g_ulSrcBuf, g_ulDstBuf,
                               MEM_BUFFER_SIZE);

    ROM_uDMAChannelEnable(UDMA_CHANNEL_SW);
    ROM_uDMAChannelRequest(UDMA_CHANNEL_SW);
}
```
8. Lastly, we’ll look at the code in `main()`.

- Lazy stacking allows floating point to be used inside interrupt handlers, but uses additional stack space. This isn’t strictly needed since we aren’t doing any floating-point operations in the handler.
- Set up the clock to 50MHz.
- Enable the µDMA peripheral.
- `ROM_SysCtlPeripheralSleepEnable()` enables the clock to reach this peripheral while the CPU is sleeping. This isn’t strictly required here, but if you forget it and put the CPU to sleep, it will be horrible to track down the problem.
- Then enable the µDMA error interrupt and then the µDMA itself.
- Make sure the control channel base address is set to the one we created.
- Call the `InitSWTransfer()` function and start the first transfer, then have the CPU wait in the while(1) loop. In your actual code this would be where you’d either sleep or do something else with those CPU cycles.

```c
int main(void)
{
    ROM_FPULazyStackingEnable();

    ROM_SysCtlClockSet(SYSCTL_SYSDIV_4 | SYSCTL_USE_PLL | SYSCTL_OSC_MAIN | SYSCTL_XTAL_16MHZ);

    ROM_SysCtlPeripheralClockGating(true);

    ROM_SysCtlPeripheralEnable(SYSCTL_PERIPH_UDMA);
    ROM_SysCtlPeripheralSleepEnable(SYSCTL_PERIPH_UDMA);

    ROM_IntEnable(INT_UDMAERR);
    ROM_uDMAEnable();

    ROM_uDMAControlBaseSet(ucControlTable);
    InitSWTransfer();

    while(1)
    {
    }
}
```
Build, Download and Run the Code

9. Click the Debug button to build and download the code to the LM4F120H5QR flash memory.

10. On the CCS menu bar click View → Memory Browser. Move/resize the window if you have to. Enter g_ulSrcBuf in the box below the Memory Browser tab and click the Go button. Click the New Tab button, enter g_ulDstBuf in the box and click Go again. Note that both arrays are clear. Click on the g_ulSrcBuf tab to view the source array.

11. Set a breakpoint inside the InitSWTransfer() function on the line containing ROM_IntEnable(INT_UDMA); (about line 98). This will let us see the contents of the source array before any transfers begin.

12. Click the Resume button to run to the breakpoint. In the Memory Browser, note the initialized values in the source array. Check the destination array to make sure it’s still clear.

13. Remove the breakpoint you just set and set another one inside the uDMAIntHandler function on the line containing ROM_uDMAChannelTransferSet() . This breakpoint will occur after the transfer is completed and the transfer count has been incremented, but before the next transfer has been initiated.

14. Add a watch expression on g_ulMemXferCount, switch the Memory Browser to the destination tab and click the Resume button. You’ll see the destination buffer update with the previous contents of the source buffer and the transfer count variable will now be 1. You can click Resume a few times and watch the transfer count increment, but since the source buffer never changes, the destination buffer will look the same after each transfer.

15. Delete the breakpoint you just added. Add watch expressions on g_ulBadIsr and g_uLuDMAErrCount. Click Resume. After a few moments, click the Suspend button. We saw over 200,000 transfers and 0 errors.

16. Remove all of the watch expressions by right-clicking in the Expressions pane and selecting Remove All → Yes. Close the Memory Browser pane.

17. Click the Terminate button to return to the CCS Edit perspective.
Streaming Data To and From the UART using a Ping-Pong Buffer

In real-world applications, incoming or outgoing data doesn’t usually stop. If you are receiving data from an ADC or sending/receiving data to/from a UART, the best way to make sure the data always has a place to go to or from is to use a Ping-Pong buffer. Take a filtering application like the one shown below:

Here the DMA on the left is responsible for bringing data from the ADC into memory. When the PING IN buffer is full, the DMA signals the CPU (with an interrupt) and switches its destination to the PONG IN buffer (and vice versa). The CPU filters the frame of data from the PING IN buffer, sends the result to the PING OUT buffer and triggers the DMA on the right to send it to the DAC (and vice versa). This is a straight-forward Input – Process – Output technique. When properly synchronized and timed, all three processes happen simultaneously and there is no chance for a “skip” or “miss” of even a single bit a data, as long as the CPU is capable of processing the buffer of data in the same amount of time that it takes to fill or empty the buffer from/to the outside world.

This example will be a little simpler. We’ll have a single transmit buffer, since the data in it won’t change. The transmit DMA will send that buffer to the UART transmit register continuously. The UART will be configured in loopback mode so that data will be streaming back in continuously. The receive DMA will stream the data received from the UART data receive register into a Ping-Pong buffer that we can observe.

What makes this DMA programming interesting is that the primary and alternate modes must be used in order for the DMA to switch Ping-Pong buffers automatically. Also, the DMA transfers that point to the UART must not increment, otherwise they would write data into the wrong location. At the same time, the DMA must increment through the Ping and Pong buffer to fill them.
18. Delete all the code in main.c. Double-click on main2.txt in your Project Explorer pane to open it for editing. Copy the contents of main2.txt into your now empty main.c. Close main2.txt and save your work.

19. In order for this code to build and run, we’ll need to make a couple of changes to the interrupt vectors used in startup_ccs.c. Open startup_ccs.c for editing.

20. It’s very easy to make an error in the next three steps. Cut and paste if you can.

Find the two lines near the top of the file shown below:

```c
extern void uDMAErrorHandler(void);
extern void uDMAIntHandler(void);
```

and change them to read:

```c
extern void uDMAErrorHandler(void);
extern void UART1IntHandler(void);
```

21. Around line 131, find the uDMAIntHandler entry for the uDMA Software Transfer vector and change it to IntDefaultHandler.

22. Around line 91, find the IntDefaultHandler entry for the UART1 Rx and Tx vector and change it to UART1IntHandler. Save your work and close startup_ccs.c. Follow these last four steps in reverse if you want to go back to the memory to memory transfer example.

**Browse the Code**

23. Starting at the top, notice the additional includes to handle the UART. Just below them are the definitions for the single Tx and two Rx Ping and Pong buffers. Then you’ll find the uDMA error count and transfer count variables.

24. Next is the allocation for the uDMA control table. This table is read by the uDMA peripheral hardware and must be aligned on a 1024-byte boundary.

25. Below the table allocation is the familiar library error routine and the same uDMA error handler from the first part of this lab.
26. The heart of this code is the UART interrupt handler. This ISR is run when the receive ping (primary) or pong (alternate) buffer is full or when the transmit buffer is empty. Note the ulMode = lines that determine which event triggered the interrupt.

In the receive buffers the mode is verified to be stopped and the proper transfer count is incremented. You’ll see in the initialization that both the primary and alternate parameters are already set up. When the Ping side of the transfer causes an interrupt, the uDMA is already processing the Pong side, so the TransferSet API resets the parameters for the flowing Ping transfer. Note that the source is the UART data register.

The transmit transfer is a basic transfer and needs to be re-enabled each time it completes. Note that the destination is the same UART data register.

```c
void UART1IntHandler(void)
{
    unsigned long ulStatus;
    unsigned long ulMode;

    ulStatus = ROM_UARTIntStatus(UART1_BASE, 1);
    ROM_UARTIntClear(UART1_BASE, ulStatus);
    ulMode = ROM_uDMAChannelModeGet(UDMA_CHANNEL_UART1RX | UDMA_PRI_SELECT);

    if(ulMode == UDMA_MODE_STOP)
    {
        g_ulRxPingCount++;
        ROM_uDMAChannelTransferSet(UDMA_CHANNEL_UART1RX | UDMA_PRI_SELECT,
                                  UDMA_MODE_PINGPONG,
                                  (void *)(UART1_BASE + UART_O_DR),
                                  g_ucRxPing, sizeof(g_ucRxPing));
    }
    ulMode = ROM_uDMAChannelModeGet(UDMA_CHANNEL_UART1RX | UDMA_ALT_SELECT);

    if(ulMode == UDMA_MODE_STOP)
    {
        g_ulRxPongCount++;
        ROM_uDMAChannelTransferSet(UDMA_CHANNEL_UART1RX | UDMA_ALT_SELECT,
                                  UDMA_MODE_PINGPONG,
                                  (void *)(UART1_BASE + UART_O_DR),
                                  g_ucRxPong, sizeof(g_ucRxPong));
    }

    if(!ROM_uDMAChannelIsEnabled(UDMA_CHANNEL_UART1TX))
    {
        ROM_uDMAChannelTransferSet(UDMA_CHANNEL_UART1TX | UDMA_PRI_SELECT,
                                  UDMA_MODE_BASIC, g_ucTxBuf,
                                  (void *)(UART1_BASE + UART_O_DR),
                                  sizeof(g_ucTxBuf));
        ROM_uDMAChannelEnable(UDMA_CHANNEL_UART1TX);
    }
}
```
27. The µDMA and UART must be initialized and the next function, InitUART1Transfer() does that.

The for() loop at the beginning initializes the transmit buffer with some count data.

The next two lines enable UART1 and make sure that the clock to the peripheral will still be available even if the CPU is sleeping. This last step isn’t strictly needed, but many programs utilizing the DMA do sleep and if you forget this step, it will not be easy to track down.

The next six lines configure the UART clock, the FIFO utilization, enable it, enable it to use the DMA, set loopback mode and enable the interrupt.

Next up are the µDMA control and transfer programming steps.

ROM_uDMAChannelAttributeDisable() turns off all the indicated parameters to assure the starting point.

The next two ROM_uDMAChannelControlSet() lines set up the control parameters for the Ping (primary) and Pong (alternate) sets. Note that the transfer element size is 8-bits, the source increment is none (since it should be pointing to the UART data register all the time) and the destination increment is 8-bits.

The next two ROM_uDMAChannelTransferSet() lines program the transfer parameters for both the Ping (primary) and Pong (alternate) sets. Note that the mode is PINGPONG, the source is the UART data register and the destination is the appropriate Ping or Pong buffer.

The next four lines set up the control and transfer parameters for the transmit channel. Note that the destination is the UART data register and the source is the single transmit buffer. The element transfer size is 8-bits, the source increment is 8-bits and the destination increment is none.

In all of these setting the priority has been left as HIGH. It doesn’t make sense to prioritize the transmit over the receive or vice versa.

The final two lines enable both µDMA transfers.
```c
void InitUART1Transfer(void)
{
    unsigned int uIdx;

    for(uIdx = 0; uIdx < UART_TXBUF_SIZE; uIdx++)
    {
        g_ucTxBuf[uIdx] = uIdx;
    }

    ROM_SysCtlPeripheralEnable(SYSCTL_PERIPH_UART1);
    ROM_SysCtlPeripheralSleepEnable(SYSCTL_PERIPH_UART1);

    ROM_UARTConfigSetExpClk(UART1_BASE, ROM_SysCtlClockGet(), 115200,
                               UART_CONFIG_WLEN_8 | UART_CONFIG_STOP_ONE |
                               UART_CONFIG_PAR_NONE);

    ROM_UARTFIFOLevelSet(UART1_BASE, UART_FIFO_TX4_8, UART_FIFO_RX4_8);

    ROM_UARTEnable(UART1_BASE);
    ROM_UARTDMAEnable(UART1_BASE, UART_DMA_RX | UART_DMA_TX);

    HWREG(UART1_BASE + UART_O_CTL) |= UART_CTL_LBE;

    ROM_IntEnable(INT_UART1);

    ROM_uDMAChannelAttributeDisable(UDMA_CHANNEL_UART1RX,
                                     UDMA_ATTR_ALTSELECT | UDMA_ATTR_USEBURST |
                                     UDMA_ATTR_HIGH_PRIORITY |
                                     UDMA_ATTR_REQMASK);

    ROM_uDMAChannelControlSet(UDMA_CHANNEL_UART1RX | UDMA_PRI_SELECT,
                               UDMA_SIZE_8 | UDMA_SRC_INC_NONE | UDMA_DST_INC_8 |
                               UDMA_ARB_4);

    ROM_uDMAChannelControlSet(UDMA_CHANNEL_UART1RX | UDMA_ALT_SELECT,
                               UDMA_SIZE_8 | UDMA_SRC_INC_NONE | UDMA_DST_INC_8 |
                               UDMA_ARB_4);

    ROM_uDMAChannelTransferSet(UDMA_CHANNEL_UART1RX | UDMA_PRI_SELECT,
                                UDMA_MODE_PINGPONG,
                                (void *)(UART1_BASE + UART_O_DR),
                                g_ucRxPing, sizeof(g_ucRxPing));

    ROM_uDMAChannelTransferSet(UDMA_CHANNEL_UART1RX | UDMA_ALT_SELECT,
                                UDMA_MODE_PINGPONG,
                                (void *)(UART1_BASE + UART_O_DR),
                                g_ucRxPong, sizeof(g_ucRxPong));

    ROM_uDMAChannelAttributeDisable(UDMA_CHANNEL_UART1TX,
                                     UDMA_ATTR_ALTSELECT |
                                     UDMA_ATTR_HIGH_PRIORITY |
                                     UDMA_ATTR_REQMASK);

    ROM_uDMAChannelAttributeEnable(UDMA_CHANNEL_UART1TX, UDMA_ATTR_USEBURST);

    ROM_uDMAChannelControlSet(UDMA_CHANNEL_UART1TX | UDMA_PRI_SELECT,
                               UDMA_SIZE_8 | UDMA_SRC_INC_8 | UDMA_DST_INC_NONE |
                               UDMA_ARB_4);

    ROM_uDMAChannelTransferSet(UDMA_CHANNEL_UART1TX | UDMA_PRI_SELECT,
                                UDMA_MODE_BASIC, g_ucTxBuf,
                                (void *)(UART1_BASE + UART_O_DR),
                                sizeof(g_ucTxBuf));

    ROM_uDMAChannelEnable(UDMA_CHANNEL_UART1RX);
    ROM_uDMAChannelEnable(UDMA_CHANNEL_UART1TX);

    return;
}
```
28. Finally we’re in main().

Starting at the top we have the lazy stacking enable, which probably isn’t necessary since we’re not using the PFU in the handlers.

The clock is set up to 50MHz and the peripherals are allowed to be clocked during sleep mode.

GPIO port F is enabled and set up for the LEDs. We’ll only be using the blue LED.

The next five lines set up the hardware for the UART on port A pins 0 and 1.

The five lines afterwards enable the uDMA clock, allow it to operate during sleep modes, enable the error interrupt, enable the uDMA for operation and sets the base address for the uDMA control table.

Then the initialization function is called for the transfers.

The while(1) loop simply blinks the blue LED while the transfers are happening to let us know the code is alive.

```c
int main(void)
{
  volatile unsigned long ulLoop;

  ROM_FPULazyStackingEnable();

  ROM_SysCtlClockSet(SYSCTL_SYSDIV_4 | SYSCTL_USE_PLL | SYSCTL_OSC_MAIN |
                      SYSCTL_XTAL_16MHZ);

  ROM_SysCtlPeripheralClockGating(true);

  ROM_SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOF);
  ROM_GPIOPinTypeGPIOOutput(GPIO_PORTF_BASE, GPIO_PIN_2);

  ROM_SysCtlPeripheralEnable(SYSCTL_PERIPH_GPIOA);
  ROM_GPIOPinTypeGPIOOutput(GPIO_PORTA_BASE, GPIO_PIN_0 | GPIO_PIN_1);

  ROM_SysCtlPeripheralEnable(SYSCTL_PERIPH_UART0);
  ROM_SysCtlPeripheralSleepEnable(SYSCTL_PERIPH_UART0);
  ROM_GPIOPinConfigure(GPIO_PA0_U0RX);
  ROM_GPIOPinConfigure(GPIO_PA1_U0TX);

  ROM_SysCtlPeripheralEnable(SYSCTL_PERIPH_UDMA);
  ROM_SysCtlPeripheralSleepEnable(SYSCTL_PERIPH_UDMA);
  ROM_IntEnable(INT_UDMAERR);
  ROM_uDMAEnable();
  ROM_uDMAControlBaseSet(ucControlTable);

  InitUART1Transfer();

  while(1)
  {
    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, GPIO_PIN_2);
    SysCtlDelay(SysCtlClockGet() / 20 / 3);
    GPIOPinWrite(GPIO_PORTF_BASE, GPIO_PIN_2, 0);
    SysCtlDelay(SysCtlClockGet() / 20 / 3);
  }
}
```
Build, Load and Run

29. Click the Debug button to build and load the program.

30. In order to determine of the program is operating properly, we need to see the buffers. One the CCS menu bar, click View → Memory Browser. Enter g_ucRxPing in the box below the Memory Browser tab and click the Go button. The RxPing, RxPong and Tx buffers are all close together, so you should be able to see them in the same window. Resize if necessary.

31. Notice that the Tx buffer is clear. Set a breakpoint in the InitUART1Transfer() function on the line containing ROM_SysCtlPeripheralEnable(SYSCTL_PERIPH_UART1);. This is right after the Tx buffer is initialized with data.

32. Click the Resume button to run to the breakpoint. Note in the Memory Browser that the Tx buffer is now filled with data.

33. Remove the breakpoint and set another in UART1IntHandler() on the line containing ulStatus = . This breakpoint will trip when the first (Pong) transfer completes.

34. Click the Resume button to run to the breakpoint. Note in the Memory Browser that the RxPing buffer is now filled with data. Click Resume again and the RxPong buffer will fill.

35. Add a watch expressions on g_ulRxPingCount and g_ulRxPingCount found in UART1IntHandler(). Add another watch expression on g_uluDMAErrCount found in uDMAErrorHandler(). Change the properties of the breakpoint so that its Action is Refresh All Windows.

36. Click Resume. The transfer counters should track and the error count should be zero. You’ll also notice that the LED on the LaunchPad stops blinking. Since the CPU is stopping at the breakpoint and transferring data to the PC, the next uDMA interrupt occurs before any code can run in the while(1) loop. Consider that when using this technique to debug.

The Memory browser isn’t very interesting since the Tx buffer never changes. Let’s fix that.

37. Halt the code and find the Tx buffer portion of the UART1IntHandler. Add the line highlighted below. This will increment the first location in the Tx buffer (and yes, I know that it’s cast as a character):

```c
if(!ROM_uDMAChannelIsEnabled(UDMA_CHANNEL_UART1TX))
{
    g_ucTxBuf[0]++;
    ROM_uDMAChannelTransferSet(UDMA_CHANNEL_UART1TX | UDMA_PRI_SELECT,
        UDMA_MODE_BASIC, g_ucTxBuf,
        (void *)(UART1_BASE + UART_O_DR),
        sizeof(g_ucTxBuf));

    ROM_uDMAChannelEnable(UDMA_CHANNEL_UART1TX);
}
```
38. Build, load and Run. You may need to click the Go button in the Memory Browser again. The first location in all three buffers should be incrementing.

39. When you’re done, click the Terminate button to return to the CCS Edit perspective. Now that the CCS windows aren’t being updated, the blue LED will start blinking again.

40. Right-click on Lab13 in the Project Explorer pane and close the project.

41. Close Code Composer Studio.

You’re done.
Manual Driver Installation

If you have problems with the Windows drivers and need to install them manually, the steps for Windows XP and 7 are here. Windows 8 should mirror the Windows 7 steps.

**Windows XP Driver Installation**

1. To see which drivers are installed on your host computer, check the hardware properties using the Windows Device Manager. Do the following:

   A. Click on the Windows Start button. Right-click on My Computer and select Properties from the drop-down menu.

   B. In the System Properties window, click the Hardware tab.

   C. Click the Device Manager button.

   The Device Manager window displays a list of hardware devices installed on your computer and allows you to set the properties for each device. When the evaluation board is connected to the computer for the first time, the computer detects the onboard ICDI interface and the Stellaris® LM4F120H5QR microcontroller.

   Drivers that are not yet installed display a yellow exclamation mark in the Device Manager window.

   Using the included USB cable, connect the USB emulation connector on your evaluation board (marked DEBUG) to a free USB port on your PC. A PC’s USB port is capable of sourcing up to 500 mA for each attached device, which is sufficient for the evaluation board. If connecting the board through a USB hub, it must be a powered hub.
Windows will start the Found New Hardware Wizard as shown below. Select “No, not this time” and then click “Next”.

The next dialog will ask where the drivers can be found. Select “Install from a list or specific location” and then click “Next”.

![Found New Hardware Wizard](image)
Direct the wizard to the drivers that you downloaded earlier as shown below. Then click “Next”.

![Found New Hardware Wizard]

When the following Windows Logo Testing box appears, click “Continue Anyway”.

![Hardware Installation]
When the wizard completes, click “Finish”.

Repeat this process for the other two drivers (the Windows Logo testing box may not appear again).
Note that the drivers now appear under the “Ports” and “Stellaris In-Circuit Debug Interface” headings.

If you have driver difficulties later, you can try the “Update driver…” process (right-click on each driver). If that fails, you can delete all three drivers and re-install them. The drivers will only appear in the Device Manager when the board is connected to the USB port.

Write down the COM port number that Windows assigned for the Stellaris Virtual Serial Port here: _______

Close your Device Manager window(s).

Skip the Windows 7 installation step and continue with the quickstart application in step Error! Reference source not found..
Windows 7 Driver Installation

2. To see which drivers are installed on your host computer, check the hardware properties using the Windows Device Manager. Do the following:

   A. Click on the Windows Start button. Right-click on Computer and select Properties from the drop-down menu.

   B. Click on Device Manager on the left of the dialog.

The Device Manager window displays a list of hardware devices installed on your computer and allows you to set the properties for each device. When the evaluation board is connected to the computer for the first time, the computer detects the onboard ICDI interface and the Stellaris® LM4F120H5QR microcontroller.

Drivers that are not yet installed display a yellow exclamation mark in the Device Manager window.

Using the included USB cable, connect the USB emulation connector on your evaluation board (marked DEBUG) to a free USB port on your PC. A PC’s USB port is capable of sourcing up to 500 mA for each attached device, which is sufficient for the evaluation board. If connecting the board through a USB hub, it must be a powered hub.
After a moment, all three drivers should appear under the “Other devices” heading as shown below:
Right-click on the top instance of “In-Circuit Debug Interface” and then click on “Update Driver Software…” in the drop-down menu that appears.
Click “Browse my computer for driver software” in the window that appears.

Direct the wizard to the drivers that you downloaded earlier as shown below. Then click “Next”.

![Driver Software Window](image1.png)

![Driver Software Window](image2.png)
When the Windows Security window appears, click “Install this driver software anyway”

When the completion window appears, click “Close”. Note that your serial port number may be different than shown below.

Repeat this process for the other two drivers.
Note that the drivers now appear under the “Ports” and “Stellaris In-Circuit Debug Interface” headings.

If you have driver difficulties later, you can try the “Update Driver Software…” process (right-click on each driver). If that fails, you can delete all three drivers and re-install them. The drivers will only appear in the Device Manager when the board is connected to the USB port.

Write down the COM port number that Windows assigned for the Stellaris Virtual Serial Port here: ______

Close your Device Manager window(s)
J1 and J2 provide compatibility with Booster Packs designed for MSP430 Launchpad.

J3 and J4 sit 100 mils inside J1 and J2 to provide extended functions specific to this board. See the board user manual for complete table of pin mux functions.
H24 and H25 installed as a single 1x2 header on 0.1" center with jumper.

R26, 0Ω

H10, H13, H11, H12

R28, 10k

C7, 1.0uF

C12, 1.0uF

C14, 1.0uF

R30, 0Ω

C18, 0.01uF

D4

R27, 330Ω

C22, 2.2uF

Y2, 16MHz

C32, 10pF

C31, 10pF

R31, 1M